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Before using the product … 

 

For your safety and effective operation, please read the safety instructions thoroughly before using the product. 

 

► Safety Instructions should always be observed in order to prevent accident or risk with the safe and 

proper use the product. 

 

► Instructions are divided into “Warning” and “Caution”, and the meaning of the terms is as follows. 

 

WARNING indicates a potentially hazardous situation which, if not avoided, could 

result in death or serious injury 

 

CAUTION indicates a potentially hazardous situation which, if not avoided, may 

result in minor or moderate injury. It may also be used to alert against unsafe 

practices 

 

► The marks displayed on the product and in the user’s manual have the following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 

 

► The user’s manual even after read shall be kept available and accessible to any user of the product. 

Warning 

Caution 
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Safety Instructions for design process 
 
 
 
 
 
 
 
 
 
 
 

 Please install a protection circuit on the exterior of PLC so that the  
whole system may operate safely regardless of failures from  
external power or PLC. Any abnormal output or operation from PLC may cause serious problems 
to safety in whole system.  
- Install protection units on the exterior of PLC like an interlock circuit that deals with opposite 

operations such as emergency stop, protection circuit, and forward/reverse rotation or install an 
interlock circuit that deals with high/low limit under its position controls. 

- If any system error (watch-dog timer error, module installation error, etc.) is detected during 
CPU operation in PLC, all output signals are designed to be turned off and stopped for safety. 
However, there are cases when output signals remain active due to device failures in Relay and 
TR which can’t be detected. Thus, you are recommended to install an addition circuit to monitor 
the output status for those critical outputs which may cause significant problems.  

 
 Never overload more than rated current of output module nor  

allow to have a short circuit. Over current for a long period time may 
cause a fire . 

 

 Never let the external power of the output circuit to be on earlier  
than PLC power, which may cause accidents from abnormal output or 
operation. 

 

 Please install interlock circuits in the sequence program for safe operations in the system 
when exchange data with PLC or modify operation modes using a computer or other 
external equipments Read specific instructions thoroughly when conducting control operations 
with PLC.  

Warning 
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Safety Instructions for design process 
 
 
 
 
 
 
 
 
 
 

 
Safety Instructions on installation process 

 I/O signal or communication line shall be wired at least 100mm 
 away from a high-voltage cable or power line. Fail to follow this instruction may cause 

malfunctions from noise 
 

Caution 
    

 Use PLC only in the environment specified in PLC manual or general standard of data 
sheet. If not, electric shock, fire, abnormal operation of the product may be caused. 

 

 Before install or remove the module, be sure PLC power is off. If not, electric shock or damage 
on the product may be caused. 

 

 Be sure that every module is securely attached after adding a module or an extension 
connector. If the product is installed loosely or incorrectly, abnormal operation, error or dropping 
may be caused. In addition, contact failures under poor cable installation will be causing 
malfunctions as well. 

 

 Be sure that screws get tighten securely under vibrating environments. Fail to do so will put 
the product under direct vibrations which will cause electric shock, fire and abnormal operation. 

 

 Do not come in contact with conducting parts in each module, which may cause electric 
shock, malfunctions or abnormal operation. 

Caution 
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Safety Instructions for wiring process 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Prior to wiring works, make sure that every power is turned off. If not, electric shock or damage 
on the product may be caused. 

 
 After wiring process is done, make sure that terminal covers are installed properly before its 

use. Fail to install the cover may cause electric shocks. 

Warning 

 Check rated voltages and terminal arrangements in each product prior to its wiring process. 
Applying incorrect voltages other than rated voltages and misarrangement among terminals may 
cause fire or malfunctions. 

 

 Secure terminal screws tightly applying with specified torque. If the screws get loose, short circuit, 
fire or abnormal operation may be caused. Securing screws too tightly will cause damages to the 
module or malfunctions, short circuit, and dropping. 

* 
 Be sure to earth to the ground using Class 3 wires for FG terminals which is exclusively used 

for PLC. If the terminals not grounded correctly, abnormal operation or electric shock may be caused. 
 

 Don’t let any foreign materials such as wiring waste inside the module while wiring, which may 
cause fire, damage on the product or abnormal operation. 

 

 Make sure that pressed terminals get tighten following the specified torque. External 
connector type shall be pressed or soldered using proper equipments.  

 

Caution 
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Safety Instructions for test-operation and maintenance 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

 Do not make modifications or disassemble each module. Fire, electric shock or abnormal 
operation may occur. 

 
  Prior to installing or disassembling the module, let all the external power off including PLC 

power. If not, electric shock or abnormal operation may occur. 
 
 Keep any wireless equipment such as walkie-talkie or cell phones at least 30cm away from 

PLC. If not, abnormal operation may be caused. 
 
 When making a modification on programs or using run to modify functions under PLC 

operations, read and comprehend all contents in the manual fully. Mismanagement will cause 
damages to products and accidents. 

 
 Avoid any physical impact to the battery and prevent it from dropping as well. Damages to 

battery may cause leakage from its fluid. When battery was dropped or exposed under strong 
impact, never reuse the battery again. Moreover skilled workers are needed when exchanging 
batteries.  

Caution 
    

 Don’t touch the terminal when powered. Electric shock or abnormal operation may occur. 
 
 Prior to cleaning or tightening the terminal screws, let all the external power off including 

PLC power. If not, electric shock or abnormal operation may occur. 
 
 Don’t let the battery recharged, disassembled, heated, short or soldered. Heat, explosion or 

      

Warning 
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Safety Instructions for waste disposal 
 ̀

 
 

 
 
 
 
 

  
 
 
 

 Product or battery waste shall be processed as industrial waste. The waste may discharge toxic 
materials or explode itself. 

Caution 
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Thank you for purchasing PLC of LS ELECTRIC Co., Ltd. 
Before use, make sure to carefully read and understand the User’s Manual about the functions, performances, installation and 
programming of the product you purchased in order for correct use and importantly, let the end user and maintenance 
administrator to be provided with the User’s Manual.  
 
The User’s Manual describes the product. If necessary, you may refer to the following description and order accordingly. In 
addition, you may connect our website (http://www.lselectric.co.kr/) and download the information as a PDF file.  
 

Relevant User’s Manuals  

Title Description 

XG5000 User’s Manual 
XG5000 software user manual describing online function such as programming, 
print, monitoring, debugging by using XGK, XGB CPU 

XG5000 User’s Manual 
(for XGI, XGR) 

XG5000 software user manual describing online function such as programming, 
print, monitoring, debugging by using XGI, XGR CPU 

XGK/XGB Instructions & 
Programming User’s 
Manual 

User’s manual for programming to explain how to use instructions that are used 
PLC system with XGK, XGB CPU. 

XGI/XGR Instructions & 
Programming User’s 
Manual 

User’s manual for programming to explain how to use instructions that are used 
PLC system with XGI, XGR CPU. 

XGK CPU User’s Manual 
(XGK-CPUU/CPUH/ 
CPUA/CPUS/CPUE) 

XGK-CPUU/CPUH/CPUA/CPUS/CPUE user manual describing about XGK 
CPU module, power module, base, IO module, specification of extension cable 
and system configuration, EMC standard 

XGI CPU User’s Manual 
(XGI-CPUU/D,CPUU, 
CPUH,CPUS,CPUE) 

XGI-CPUU/D,CPUU,CPUH,CPUS,CPUE user manual describing about XGI 
CPU module, power module, base, IO module, specification of extension cable 
and system configuration, EMC standard 

XGR redundant series 
User’s Manual 

XGR- CPUH/F, CPUH/T user manual describing about XGR CPU module, 
power module, extension drive, base, IO module, specification of extension cable 
and system configuration, EMC standard 

 
Current user manual of XGL-C22A, C22B, CH2A, CH2B, C42A, C42B is written based on the following version.  

 
Related OS version list 
 

Product name OS version 

XGK-CPUU, CPUH, CPUA, CPUS, CPUE V4.5 

XGI-CPUU/D, CPUU, CPUH, CPUS, CPUE V3.9 

XGR-CPUH/F, CPUH/T, CPUH/S V2.6 

XG5000 V4.07 

 
 

http://www.lselectric.co.kr/
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Chapter 1 Overview 
 

1.1 Overview 
 

This user's manual provides a description of contents related to the Computer Link interface 
module (Cnet I/F module) used in the XGK/I/R PLC system. You can connect to other company's 
PLC or general-purpose computer, exchange data or control the PLC remotely by using the Cnet 
I/F module. The Cnet I/F module includes six products including XGL-C22A, XGL-CH2A, XGL-C42A, 
XGL-C22B, XGL-CH2B and XGL-C42B. 
 
 
Refer to the following user manuals according to the applied system when using this product. 
 

• XG5000 user manual 

• XGK instructions and programming user manual 

• XGK CPU module user manual  

• XGI/XGR instructions and programming user manual 

• XGI CPU module user manual  

• XGR CPU module user manual 
 
 

Be sure to check the following items when applying the Cnet I/F module to the system. 
 

• Does the XG5000 version you are using fit for the product type? 

Classification XG5000 version 

A Type (XGL-C22A, CH2A, C42A) V4.0 or higher 

B Type (XGL-C22B, CH2B, C42B) V4.07 or higher 

 

• Is a correct O/S version applied according to the product type? 

Classification (a) OS Version 

A Type (XGL-C22A, CH2A, C42A) V2.3 or higher 

B Type (XGL-C22B, CH2B, C42B) V5.0 or higher 

 
 
 
 

Notes  

• The XG5000 version applied for writing this user manual is V4.25. If the version of the XG5000 
you use is different, the menus or the method to write a parameter may be different. 
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1.2 Features 

 
The Cnet I/F module is the serial communication module that supports the RS-232C and RS-

422(485) protocols, and it has the following features.  
 

(1) Since you can specify the communication speed and communication mode directly using the XG5000, 
you can connect to other companies' devices easily. 

(2) Various products equipped with RS-232C and RS-422(485) ports according to each usage are 
provided.  

(3) Each channel is configured independently, so they operate separately, and the protocol data created 
by the user is managed by the CPU module. So, even if the communication module is replaced, you 
can use the product immediately by installing it on the base. 

(4) You can read and write a variable using the dedicated protocol. 
(5) By using RS-422/485, you can connect up to 32 communication modules using the multi-drop method. 
(6) It is equipped with the modem communication function, so it can control a PLC which is far away. 
(7) Various communication speeds can be set. 

• RS-232C : 300bps ~ 115,200bps, • RS-422/485 : 300bps ~ 115,200bps  
(8) 1-to-1, 1-to-N and N-to-1 communications (if the RS-422 channel is used) are available. 
(9) The full-duplex communication and the half-duplex communication methods are supported. 
(10) It provides the self-diagnosis function as well as the loop-back diagnosis function, so you can check 

for failure easily. 
(11) It provides dedicated communication (user defined communication and XGT client/server 

communication), and Modbus client/server functions. 
(12) Remote connection is possible when XGT Cnet I / F module is communicating with each other. Note 1) 
(13) It provides a client mode (LS bus) for dedicated communication for LS ELECTRIC Inverter. Note 2) 
(14) Smart server automatically recognizes the protocol (LS ELECTRIC dedicated protocol, Modbus RTU/ 

ASCII) and operates. Note 2) 
(15) It provides the repeater mode, so you can convert the RS-232C to RS-422/485 or use it as the 

isolated repeater. Note 2) 
(16) It has a built-in terminating resistance, so the terminating resistance can be set from the basic 

parameter. Note 2) 
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  Notes  

Note 1) The remote connection between the Cnet I/F modules can be used only when the OS 
version of the Cnet I/F module is V2.5 or higher. Matters related to remote connection are 
as follows. 
(1) This function is supported only when the RS-232C or RS-422 communication methods 

are used. However, in case of the RS-485 communication method, remote connection 
is available only when P2P enable (✓) is deselected from the XG5000 online menu. 

(2) The remote connection is supported regardless of operation mode of the Cnet I/F 
module. 

(3) Remote connection during communication is affected by the transmission and reception 
cycle and the amount of data. If the transmission and reception cycle is short or the 
amount of data is excessive, disconnection may occur. 

Note 2) This function is supported only for B-type products (XGL-C22B, CH2B, C42B).  
 



 

 
Chapter 1 Overview 

 

1-4 

 

 

 

1.3 Product configuration 
 

1.3.1 Product type 
 

The type of Cnet I/F module is as follows. 

Model name Specifications Note 

XGL-C22A/C22B RS-232C, two ports 

Twist pair shield cable XGL-CH2A/CH2B RS-232C one port, RS-422 one port 

XGL-C42A/C42B RS-422, two ports 

 
 

1.3. 2 Number of units that can be installed for each CPU 
 

Up to 24 Cnet I/F modules can be installed regardless of the main base and the extension 
base. However, it is recommended to install the module on the main base in order to gain 
maximum product performance. The following table shows the number of products according 
to the service that each CPU module can use. Refer to this table at the time of configuring the 
system. 

 

Classification 
XGK XGI XGR 

CPUE 
CPUS 

CPUSN 
CPUA 

CPUH 
CPUHN 

CPUU 
CPUUN 

CPUE CPUS CPUH CPUU/D 
CPUU 

CPUUN 
CPUH/F CPUH/S CPUH/T 

High Speed 
link,  

The Cnet I/F module does not use this function. 

P2P service  Maximum number of modules to be used: 8 modules 

Dedicated 
service  

Maximum number of modules to be used: 24 modules 
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1.4 Checklist before using the product 
 

It is necessary to prepare a number of items in advance in order to use the Cnet I/F module. 
Check the following items for correct use of the product. 

 

1.4.1 Preparation in advance 
 

(1) (1) Please download the XG5000 from LS Industrial Systems website below. 
Website address: http://www.ls-electric.com/ 

(2) Prepare the cable necessary for connecting the XG5000 and the CPU module. The model name of 
the cable is as follows.  

 • For USB: USB-301A,• For RS-232C: K1C-050A 
 

1.4.2 XG5000 Installation 
 

The XG5000 is the software tool that is necessary for using all communication modules, including 
the Cnet I/F module. 

The following figure shows the default screen of the XG5000. 
 

 
 

  

http://www.ls-electric.m/
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1.4.3 Checking the product version 
 

Be sure to check the version of the relevant product before using the Cnet I/F module. 
 

(1) Method to check the version using XG5000 
This is the method to connect to the CPU module and read the product information of the Cnet I/F 
module. The checking sequence is as follows. 
(a) Run XG5000. 
(b) Connect to the CPU module by selecting [Online]→[Connect] 
(c) When you select [Online]→[Communication module setting and Diagnosis]→[System Diagnosis] 

after connecting to the CPU module, the following screen will be appears. 

 

(d) When you double click the Cnet I/F module you wish to check the product information from the 
above figure, the [Communication module information] screen will be appears as follows. 

(e) Check the product version shown at the bottom right side of this screen. 
 

 
 

(2) Method to check the version using the product label 
The label is attached to the external case of the Cnet I/F module. In this label, the model name and 

version information of the product are stated. If XG5000 cannot be used, check the version information 
by reading the product label.  
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Chapter 2 Product Specifications 
 

2.1 General Specifications 
 

The general specifications of the XGT series are as follows. 
 

No Item Specifications 
Relevant 

specifications 

1 
Ambient 

temperature 
0℃∼+55℃  

2 
Storage 

temperature 
-25℃∼+70℃  

3 
Ambient 
humidity 

5∼ 95%RH (Non-condensing)  

4 
Storage 
humidity 

5∼ 95%RH (Non-condensing)  

5 
Vibration 

resistance  

In case of occasional vibration  

Frequency Acceleration Amplitude Times 

IEC 61131-2 

5≤f< 8.4 ㎐ - 3.5mm 

10 times for 
each direction of 
X, Y and Z 

8.4≤f≤150 ㎐ 9.8 ㎨(1G) - 

In case of continuous vibration 

Frequency Acceleration Amplitude 

5≤f< 8.4 ㎐ - 1.75mm 

8.4≤f≤150 ㎐ 4.9 ㎨(0.5G) - 

6 
Vibration 

resistance 

 * Maximum shock acceleration: 147 ㎨ (15G) 

 * Duration: 11ms 
 * Pulse waveform: Half-sine (3 times for each direction of X, Y and Z) 

IEC 61131-2 

7 
Shock 

resistance  

Square wave impulse noise 
AC:±1,500V 
DC:±900V 

Test standard of LS 
ELECTRIC 

Electrostatic discharge 4kV (Contact discharge) 
IEC 61131-2, 
IEC 61000-4-2 

Radiated electromagnetic field noise 80 ~ 1000MHz, 10 V/m 
IEC 61131-2, 
IEC 61000-4-3 

Fast transient/ 
Burst Noise 

Classification 
Power 
module 

Digital/Analog Input/Output, 
Communication Interface IEC 61131-2, 

IEC 61000-4-4 
Voltage 2kV 1kV 

8 
Operating 

atmosphere 
Free from corrosive gases and excessive dust  

9 Altitude Up to 2,000m  

10 
Pollution 

degree 
Less than equal to 2  

11 Cooling Air cooling  

 

Notes  
  

(1) IEC(International Electro-technical Commission): An international nongovernmental organization which 

promotes internationally cooperated standardization in electric/electronic field, publishes international 

standards and manages applicable estimation system related with. 

(2) Pollution degree: It is an index indicating the degree of pollution of the service environment that 

determines the insulation performance of a device, and pollution degree 2 indicates the state in which 

only non-conductive pollution occurs. However, temporary conduction occurs in this state due to dew 

formation. 

 
  



 

 
Chapter 2 Product Specifications 

 

2-2 

 

 

 

 

2.2 Performance Specification 
 

Item 
Specifications 

XGL-C22A/C22B XGL-CH2A/CH2B XGL-C42A/C42B 

Serial 
communicat
ion channel 

RS-232C 
(D-Sub 9P) 

2 channels 1 channels 

- The RS-232C standard specifications apply. 

Line configuration 1:1 

RS-422/485 
(5 pin connector) - 

1 channels 2 channels 

The RS-422/485 standard specifications apply. 

Line configuration 1:1,  1:n,  n:1 

Modem connection function 
Connect an external modem to the module and carry 
out long distance communication with an external 
device through the public telephone network. 

- 

Operation 
mode 

(Define 
separate 

operation for 
each port) 

P2P XGT client, Modbus ASCII/RTU client, user definition communication 

Server XGT server, Modbus ASCII/RTU server 

Data 
type 

Start bit 1 

Data bit 7 or 8 

Stop bit 1 or 2 

Parity Even/Odd/None 

Synchronization type Asynchronous type 

Error detection 
BYTE SUM, WORD SUM, BYTE XOR, DLE AB, DLE SIEMENS,LSIS CRC, CRC 
16, BYTE SUM 2’S COMP, BYTE SUM 1’S COMP 7BIT SUM, 7BIT XOR, CRC 16 
IBM, CRC 16 CCITT 

Transmission speed 
Possible to select among 300/600/1,200/1,800/2,400/3,600/4,800/7,200/9,600 
/19,200/38,400/57,600/64,000/76,800/115,200 bps  

Station No. setting 
Setting range: 0 to 3 
Maximum number of stations including clients: 32 

Transmission distance(m) 

RS-232C : Up to 15 (can be extended if a modem is 
used) 

- 

- RS-422/485: Up to 1,200 

Diagnostics function 

 Check operation according to LED status. 
 XG5000 Diagnosis Service: Frame monitor, service status, loopback test, 

PLC history. 

Dimensions (mm) 98(H) X 27(W) X 90(D) 

Power consumption (mA) 
C22A C22B CH2A CH2B C42A C42B 

310 420 310 480 300 520 

Weight(g) 121 119 116 
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2.3 Name and Usage of each part 
 

(1) Front view of the product 
 

                  
[A type Cnet I/F module]                [B type Cnet I/F module] 

 
 

(2) Name and usage of each part 

 Name Usage 

① Indicator LED Refer to Paragraph (3) below. 

② Communication Connector 
RS-232C or RS-422/485 connector for serial communication with the 
opposing device 

    
 

(3) Usage of LED 
Name of 

LED 
Usage LED status Contents 

RUN 
Indicates the operation status of 
the Cnet I/F module. 

ON Cnet is operating normally. 

Off Cnet is not operating normally. 

I/F 
Indicates the communication 
status with the CPU. 

ON 
If the communication with the CPU module is 
not normal 

Off 
An error has occurred while initializing the 
communication module. 

Flickering Cnet is operating normally. 

TX 
Indicates that the frame is being 
transmitted 

ON While transmitting the frame 

Off 
When the frame transmission has been 
completed 

RX 
Indicates that the frame is being 
received 

ON While receiving the frame 

Off 
When the frame reception has been 
completed 

ERR Indicates a frame error 
ON An frame error has occurred. 

Off If the frame is normal 

TER 
Indicates the setting of 
terminating resistance of RS-
422/485 communication port 

ON 
If the terminating resistance is set (XGL-
CH2B/C42B) 

Off 
If the terminating resistance is canceled 
(XGL-CH2B/C42B) 
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2.4 Cable Specifications 
 

When the RS-422 or RS-485 channel is used, the twist pair cable for RS-422 should be used by 
considering the communication distance and speed. The following table shows the cable specifications 
recommended by LS ELECTRIC. In case of using any other cables, be sure to apply a cable that meets 
the characteristics shown in the following table. 

 
(a) Item name: Low capacitance LAN interface cable 
(b) Type: LIREV-AMESB 
(c) Specification: 2P X 22AWG(D/0.254 TA) 
(d) Manufacturer: LS Cable & System.  

 

Electrical 
characteristics 

Test item Unit Characteristics Test condition 

Conductor resistance /km 59 Room temperature 

Withstand voltage(DC) V/1min 
Withstand 500V for 1 

minute. 
In the air 

Insulation resistance M/km 1,000  15.6℃ 

Capacitance pF/M Less than equal to 45 1kHz 

Characteristic impedance  120  12 10MHz 

 

Exterior 
characteristics 

Item Solid 

Conduct
or 

Number of core 
wires 

Pairs 2 

Specifications AWG 22 

Configuration NO./mm 1/0.643 

External 
diameter 

mm 0.643 

Insulator 

Thickness mm 0.59 

External 
diameter 

mm 1.94 

[Specifications of twisted pair cable] 
 

 

Braided 

 

Ground line 

 

AL/MYLER TAPE 

Conductor 

 

Insulator 

 

Sheath  
 

[Structure drawing] 
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2.5 Terminating resistance 
 

When the RS-422 or RS-485 channel of the A type Cnet I/F module (XGL-CH2A, C42A) is used, the 
terminating resistance should be connected to the outside. In case of long-range communication, signal 
distortion occurs due to the reflected wave of the cable, and the terminating resistance prevents it.  

In case the cable recommended in Paragraph 2.4 is used, connect the 1/2W, 120Ω resistance to both 
ends of the line. In case a different cable is used, connect the 1/2W resistance that has the same value 
as the characteristic impedance of the applied cable to both ends of the line. 

* Specifications of the terminating resistance in case the recommended cable is used: 1/2W, 120Ω, 5% 
error 

 
(1) How to connect the terminating resistance in case the RS-422 is connected 

 
 

 
(2) How to connect the terminating resistance in case the RS-485 is connected 

 

 
 
 
 

Notes  

• The B type Cnet I/F module (XGL-CH2B, C42B) has a built-in terminating resistance, so the termination can 
be set from the [Standard Settings-Cnet] menu of the XG5000 (V4.07 or higher). 
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Chapter 3 Performance Specifications 
 

3.1 Operation Mode 
 

The operation mode of the Cnet I/F module is decided according to the contents of parameter setting 
in the XG5000. Each communication port operates independently and the supported operation mode is 
as follows. 

  

3.1.1 Server Mode 

 
It operates as the server in the network, and either the XGT server or the Modbus server can be selected. 

 
(1) XGT server: It supports the LS ELECTRIC 's dedicated communication protocol and it operates 

according to the client's request. 

(2) Modbus server: It supports the Modbus protocol, and the RTU/ASCII type can be selected. 

(3) Setting for mapping the start address of the Modbus protocol to the XGT memory area is necessary. 

(4) The XG5000 service (remote 1-stage, 2-stage connection) function is supported at the same time. 

(5) This is the mode that analyzes the smart server: XGT protocol and Modbus (RTU/ASCII) protocol 

automatically and operates as the relevant server (B type Cnet I/F module: XGL-C22B, CH2B, C42B). 

 

3.1.2 P2P Client Mode 

 

(1) It operates as the client in the network. 
(2) Support dedicated communication protocol , Modbus protocol and LS inverter dedicated 

communication(LS BUS client). 

(3) It is possible to set up to 64 communication blocks for each communication channel of the Cnet I/F 

module and define each block to operate independently. 
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3.2 Operation by channel 
 

Since each communication port operates independently, it can carry out transmission and reception 
simultaneously. Therefore, it is possible to set the transmission specifications separately for RS-232C 
and RS-422 channel and start and stop the operation for each channel.  
 

The data flow of each channel is as shown in the figure below. 
 

 

 

RS-422 Channel 

PLC CPU 

TX 

RX 

RX 

TX 

RS-232C Channel 

RS-422 Cable 

RS-232C Cable 

 
 

 
 
 

Notes  

[1] While in operation, mode change is not available. If you change the mode, download the default 
communication parameter to the CPU module and reset the communication module. 

(2) The B type Cnet I/F module (XGL-CH2B, C42B) supports the isolated repeater mode. 
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3.3 Additional Functions 

 

3.3.1 Repeater Mode 

 
The repeater mode is the function to transmit data received from each channel to another channel.  

 
(1) The repeater mode is only supported in the B type Cnet I/F module (XGL-CH2B, XGL-C42B). 

(2) The repeater mode does not support auto speed. 

(3) When the repeater mode is enabled, communication service will not be provided, and the same 

communication setting (speed, data/stop/parity bit) will apply to channels 1 and 2. The modem type 

is fixed to the null modem. 

(4) The mode cannot be changed during operation. If you change the mode, download the default 

communication parameter to the CPU module and reset the communication module. 

 

3.3.2 Loop Back Diagnosis 

 

The loop-back diagnosis is the function to check internally whether the channel operates normally 

or not without connecting the communication channel to an external device, and it can be used when 

carrying out the diagnosis service.  

For detailed information, refer to the [12.1 XG5000 Diagnosis function] item. 
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3.4 Serial Connection Method 
 

3.4.1 RS-232C Connection 
 

The RS-232C channel communicates with an external device using the 9-pin connector. The 
specifications of the RS-232C interface are as follows. 

 

Pin No. Signal name 
Direction of signal 
(Cnet ↔ External 

device) 
Contents 

1 DCD(CD)  
Notifies to Cnet that the external device has detected 
a carrier. 

2 RXD(RD)  Notifies to Cnet that the external device has received 
data. 

3 TXD(SD)  Notifies to Cnet that the external device has 
transmitted data. 

4 DTR(ER)  Notifies to the external device that Cnet is ready to 
communicate. 

5 SG  Grounding for signal 

6 DSR(DR)  
Notifies to Cnet that the external device is ready to 
communicate. 

7 RTS(RS)  Cnet requests the external device to transmit data. 

8 CTS(CS)  
Notifies to Cnet that the external device can transmit 
data. 

9 RI(CI)  Notifies to Cnet that the external device was called. 

 
The RS-232C channel can communicate with an external device directly or communicate with 

an external device which is remote using the modem. When connecting a modem, use XG5000 to 
set the RS-232C communication method to ‘modem', and when not using a modem, set it to ’null 
modem'. 

 
 

(1) How to connect the RS-232C connector when connecting the modem 
 
The Cnet I/F module can be used for long-range communication by connecting the modem as shown 

in the figure below. 
 

Cnet (9-pin) 

Pin No. and direction of signal 

Modem side (25-
pin) 

Pin No. 
Signal 
Name  

Signal 
Name 

Pin No. 

1 DCD  DCD 8 

2 RXD RXD 3 

3 TXD TXD 2 

4 DTR DTR 20 

5 SG SG 7 

6 DSR DSR 6 

7 RTS RTS 4 

8 CTS CTS 5 

9 R1*Note 1) RI 22 

 
 

[Note 1] No. 9 RI signal is not used in the Cnet I/F module. 
  



 

 
Chapter 3 Performance Specifications 

 

3-5 

 

 

 

 
(2) How to connect the RS-232C connector if the null modem mode is used 

 
If the null modem mode is used, connect in three lines as follows (no handshake). 

 

Cnet (9-pin) 

Pin No. and direction of signal 

Computer/commun
ication device 

Pin No. 
Signal 
Name 

Signal Name 

1 DCD  
 

DCD 

2 RXD RXD 

3 TXD TXD 

4 DTR DTR 

5 SG SG 

6 DSR DSR 

7 RTS RTS 

8 CTS CTS 

9 RI RI 
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3.4.2 RS-422 / 485 Connection 
 

 The RS-422 channel communicates with an external device using the 5-pin connector for the 
A type module and the 6-pin connector for the B type module. The specifications of the RS-422 
interface are as follows. 

 

Pin No. 
Signal 
Name 

Direction of signal 
(Cnet<-->External device) 

Contents 

1 TX+  Transmitted data (+) 

2 TX-  Transmitted data (-) 

3 RX+  Received data (+) 

4 RX-  Received data (-) 

5 SG  Signal grounding 

6 PE  Frame grounding (XGL-
CH2B/C42B) 

 
 

(1) The RS-422 channel may connect to an external device using the RS-422 or RS-485 (multi drop) 

method. In case the RS-422 method is used, connect as shown in the figure below. 

 

A type Cnet (5 pin ) 
B type Cnet (6 pin) Direction of signal 

(Cnet<--->External device) 
External communication 

device 
Pin No. Signal Name 

1 TX+  RX+ 

2 TX- RX- 

3 RX+ TX+ 

4 RX- TX- 

5 SG SG 

6(B type) PE PE 

 
 

(2) If the RS-422 channel is used as multi drop, set’ RS-485’ for the communication type for each channel 

from the [Standard Settings - Cnet] window of the XG5000 and connect as shown in the figure below. 

 

A type Cnet (5 pin ) 
B type Cnet (6 pin) Direction of signal 

(Cnet<--->External device) 

External 
communication 

device Pin No. Signal Name 

1 TX+  RX+ 

2 TX- RX- 

3 RX+ TX+ 

4 RX- TX- 

5 SG SG 

6(B type) PE PE 

 
 

In case of communicating in the multi drop method as shown in the figure above, TX+ and 
RX+ should be connected and RX- and TX- should be connected. Therefore, the transmission 
and reception lines are shared by the Cnet I/F module and the external device, data will be 
exchanged-duplex communication method. 
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Chapter 4 Installation and Test Operation 
 

4.1 Installation Environment 
 

High quality level of the Cnet I/F module has been secured in order for it to be used in various 
environments. However, the following contents should be observed in order to guarantee the reliability 
and stability of this product. 
 

(1) Environmental conditions 
(a) Install it in a waterproof and vibration proof control panel. 
(b) Install it in a place free from continuous impact or vibration. 
(c) Install it in a place with no direct sunlight. 
(d) Install it in a place where the ambient temperature does not change rapidly. 
(e) Install it in a place where the range of ambient temperatures does not exceed between 0 and 

50C. 
 

(2) Installation work 
(a) In case of processing the screw hole or wiring, do not allow wiring waste to enter the product. 
(b) Install it in a place where it can be operated easily. 
(c) Do not install it inside of the same panel as a high voltage device. 
(d) Install it more than 100mm away from a device which is placed in front of the PLC and more 

than 50mm away from a device which is placed on the left or right side of the PLC. 
(e) Ground to a low surrounding noise environment. 
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4.2 Caution in handling 
 

A description of matters requiring caution when handling the product is provided. 
 

(1) Do not drop or impact the product. 

(2) Do not open the product case or disassemble the product arbitrarily. 

(3) When wiring, make sure that wiring waste does not enter the product. 

(4) Do not install or separate the module while the power is on. 

(5) Use the prescribed cable for wiring and observe the specifications of transmission distance. 

(6) Wire the communication cable at least 100mm away from the high voltage line ensuring the power line 

is not affected by surge or induction noise. 
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4.3 Product Operation Method 
 

A description of contents to be executed for operating the product is provided. Operate and set the 
product according to the following procedure to ensure correct product operation. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes  

• Station number of Cnet I/F module is set by software. Set the station address using the XG5000 
and carry out the basic setting necessary for Cnet communication. 

  

Start 

Check the function and specifications you wish to 
apply. 

Install the module on the relevant base slot. 

Connect the module and the opposing device 
using a cable. → Wire and apply terminating 
resistance. 

Turn on the power and check the LED status of 
the Cnet I/F module. (RUN:On, I/F: Flickering)   

Connect the XG5000 and the CPU module using 
a cable. 

Carry out the basic setting in the XG5000. 

(communication type, communication speed, 
data format, modem type, station No., operation 
mode) 

Set the P2P parameter. 

(channel, P2P function, starting condition, data 

size/area/type, destination station No.)  

Execute the XGT server 

communication. 

Execute the Modbus RTU server. 

Execute the Modbus ASCII server. 

Execute the P2P communication. 

Operation 
mode 

Download the parameter and carry out link 

enable. 

Download the parameter and carry out link 
enable. 
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4.4 Contents of parameters for each communication mode 
 

Parameters that should be set in XG5000 according to the communication mode are as follows. 
 

4.4.1 Standard setting parameters 
 

Parameter 
Sub 

menu 
Setting item 

Setting range and 
contents 

Setting availability 
Note 

Client Server 

Standard 
settings 

Conne
ction 

setting 

Communication 
type 

RS-232C 
RS-422 
RS-485 

Possible Possible  

Communication 
speed(bps) 

300 ~ 115,200 Possible Possible  

Terminating resistor Enable/disable Possible Possible *Note 6) 

STATION NO. 

XGT 
communication: 
0~31 
Modbus: 0~255 

Possible Possible 

When setting the 
client, the station 
number is 
meaningless. 

Operat
ion 

mode 

Use P2P 

Select one mode 

Possible -  

XGT server - Possible  

Modbus ASCII 
server 

- Possible  

Modbus RTU server - Possible  

Smart server - Possible *Note 6) 

Repea
ter 

mode 
- Enable/disable - - 

Stop all services 
when the repeater 
mode is set *Note 6) 

Advanced 
Settings 

Conne
ction 

setting 

Data bit 7, 8 Possible Possible 

When 
communicating 
Modbus ASCII 
mode, the number 
of data bits is 7. 

Stop bit 1, 2 Possible Possible *Note 5) 

Parity bit 
NONE,ODD,EVE
N  

Possible Possible  

Parity receive error 
*Note4) 

Enable/Disable Possible Possible  

Modem type 

Null modem 
Dedicated line 
modem 
Dial up modem 

Possible Possible  

Modem initialization - Possible Possible 
It can be set only 
in case of dial-up 
modem. 

Setting 
of time 

Response waiting 
time 

0~50 (x 100ms) Possible - *Note 1) 

Delay time 0~255 (x 10ms) Possible Possible *Note 2) 

Inter-character 
waiting time 

0~255 (x 10ms) Possible Possible *Note 3) 
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Notes  

 
Note 1) Response waiting time: It means the time to receive the response frame after transmitting 
a frame. 

(1) It can be set when P2P is set for the operation mode. 
(2) Response waiting time  

= Basic response waiting time + (response waiting time setting value x 100ms) + Inter-
character waiting time 

(3) Basic response waiting time for each communication speed 
(a) 9,600~115,200bps: 100ms 
(b) 7,200~2,400bps: 200ms 
(c) 1,800~1,200bps: 400ms 
(d) 600bps: 800ms 
(e) 300bps: 1,200ms 

 
Note 2) Delay time: It refers to the time set by the user when he/she wishes to delay the time to 

transmit a frame. 
(1) Client operation setting: It can be set if the communication type is RS-422/485. 
(2) Server operation setting: You can set the service to transmit a frame after the time set by 

the user frame has passed (It can be used in the B type Cnet I/F module).   
 

Note 3) Inter-character waiting time: It indicates the time interval between characters received 
within the set time from one frame, and it can be set regardless of 
operation mode. 

 
Note 4) Parity receive error: When [Enable] is selected, data can be received even if an error 

occurs in the received parity bit. 
       This function can be used for Cnet V3.1 or later and XG5000 V4.0 or later. 
 
Note 5) Stop bit This bit indicates that the single packet ends. Check the set stop bit when data 

is received. If the stop bit of the received data is smaller than the set stop bit the data 
can not be received normally. In order to receive data normally, the stop bit should be 
configured identically. 

 
Note 6) Terminating resistance, repeater mode, smart server 

:This function is provided by the B type Cnet I/F module (XGL-C22B, CH2B, C42B).  
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4.4.2 P2P Setting Parameters 

Parameter Sub menu Setting item 
Setting range and 

contents 

Possibility of settings(client) 

XGT 
Modbus 
ASCII 

Modbus 
RTU 

Inverter 
dedicated  

User 
frame 

definition  

P2P 

Commun
ication 
module 
setting 

Base 0~7 Possible Possible Possible Possible Possible 

Slot 0~11 Possible Possible Possible Possible Possible 

P2P 
channel 

P2P driver 

User frame 
definition  

- - - 
- 

Possible 

XGT client Possible - - - - 

Modbus ASCII 
client 

- Possible - 
- 

- 

Modbus RTU client - - Possible - - 

LS bus client*Note 5) - - - Possible - 

P2P 
block 

Channel 1, 2 Possible Possible Possible Possible Possible 

P2P function 

READ Possible Possible Possible Possible - 

WRITE Possible Possible Possible Possible - 

SEND - - - - Possible 

RECEIVE - - - - Possible 

Starting 
condition*Note1) 

- Possible Possible Possible Possible Possible 

Command 
type 

single Possible Possible Possible - - 

Continuous Possible Possible Possible Possible - 

Data type 

Bit Possible Possible Possible - - 

WORD Possible Possible Possible Possible - 

1 Byte Possible - - - - 

2 Byte Possible - - - - 

4 Byte Possible - - - - 

8 Byte Possible - - - - 

No. of 
variables*Note2) 

1~4 Possible Possible Possible 
- 

- 

Data size 
*Note2) 

In accordance with 
the protocol 

Possible Possible Possible Possible - 

Destination 
station 
number 

0~63 Possible Possible Possible 
Possible 

- 

Frame 
Select in case of 
user frame 
definition  

- - - 
- 

Possible 

Setting*Note 3) - Possible Possible Possible Possible Possible 

User 
frame 

definition 
Adds Group 

Group name - - - -  

Type of 
frame 

Send - - - - Possible 

Receive - - - - Possible 

Frame 
*Note 4) 

Edit group Group name - - - - Possible 

Delete group - - - - - Possible 

Add frame 

Head - - - - Possible 

Tail - - - - Possible 

Body - - - - Possible 
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Notes  

Note 1) Starting condition in user-defined frame communication is selectable only when the P2P function is 
SEND. 

Note 2) The number of variables and data size can be set only in the case of continuous mode in XGT 
client and Modbus ASCII/RTU client. 

  Note 3) Settings in user-defined frame communication can be established only when the fixed size 
parameter or variable size parameter is selected. 

Note 4) Frame settings can be entered after the frame type and group name of the user frame definition 
are set. 

Note 5) LS Bus client is a function provided by the B type Cnet I/F module. 
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4.5 I/O Assignment and Device Information 
 

4.5.1 I/O Assignment 
 

(1) When the XGK CPU is used 
(a) Basic system configuration method 

The features of Basic system consisted by connecting the main base and expanded base 
by a cable are as follows. There is a restriction in the number of stages in the extension base 
according to the type of CPU module. And the either the fixed type or the variable type can be 
selected from the basic parameter and assigned to the I/O number. 

Classification XGK-CPUE 
XGK-CPUS 

XGK-CPUSN 
XGK-CPUA 

XGK-CPUH 
XGK-CPUHN 

XGK-CPUU 
XGK-CPUUN 

Maximum number of 
extension stages 

1 stages 3 stages 3 stages 7 stages 7 stages 

Maximum No. of I/O 
modules installation 

24 module 48 module 48 module 96 module 96 module 

Maximum I/O score 1,536 points 3,072 points 3,072 points 6,144 points 6,144 points 

Maximum extension 
distance 

15m 

 
(b) Assignment of I/O number (fixed type) 

1) The fixed type is the method to assign 64 points to each slot in the base regardless of other 
conditions. 

2) The I/O number for 16 slots is assigned to one base. In other word, the start number of No. 1 
base is P00640. 

3) The case of assigning the I/O number in the system that uses the 12-slot base is as follows. 
 

Slot No. 0 1 2 3 4 5 6 7 8 9 10 11 

PWR CPU 
Input 
16 

Input 
16 

Input 
32 

Input 
64 

Output 
16 

Output 
32 

Output 
32 

Output 
64 

Input 
32 

Output 
16 

Output 
32 

Output 
32 

  
P000 

~ 
P03F 

P040 
~ 

P07F 

P080 
~ 

P11F 

P120 
~ 

P15F 

P160 
~ 

P19F 

P200 
~ 

P23F 

P240 
~ 

P27F 

P280 
~ 

P31F 

P320 
~ 

P35F 

P360 
~ 

P39F 

P400 
~ 

P43F 

P440 
~ 

P47F 

 
(c) Assignment of I/O number (variable-type) 

1) The variable type is the method to assign the score according to the module installed on the 
base slot. 

2) When a module installed as the I/O parameter is specified, the score will be assigned. 
3) For a slot which is not specified as the I/O parameter, the score corresponding to the module 

which is actually installed will be assigned automatically (16 points are assigned to the 8-point 
module.). 

4) For an empty slot which is not specified as the I/O parameter, 16 points will be assigned. 
5) The reserved assignment using the I/O parameter is also available. At this time, only the score is 

assigned regardless of module type. 
6) For a slot where the special module or communication module is installed, 16 points will be 

assigned. 
7) The case of assigning the I/O number in the system that uses the 12-slot base is as follows. 

 

Slot No. 0 1 2 3 4 5 6 7 8 9 10 11 

PWR CPU 
Input 
16 

Input 
16 

Input 
32 

Input 
64 

Output 
16 

Output 
32 

Output 
32 

Output 
64 

Input 
32 

Output 
16 

Output 
32 

Output 
32 

  

P000 

~ 

P00F 

P010 

~ 

P01F 

P020 

~ 

P03F 

P040 

~ 

P07F 

P080 

~ 

P08F 

P090 

~ 

P10F 

P110 

~ 

P12F 

P130 

~ 

P16F 

P170 

~ 

P18F 

P190 

~ 

P19F 

P200 

~ 

P21F 

P220 

~ 

P23F 
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(2) When XGI CPU is used 

(a) Basic system configuration method 

Classification 
XGI-CPUU / CPUH / CPUU/D/ 

CPUUN 
XGI-CPUS XGI-CPUE 

Maximum number 
of extension 
stages 

7 stages 3 stages 1 stages 

Maximum No. of 
I/O modules 
installation 

96 module 48 module 24 module 

Maximum I/O score 

• In case the 16-point module 

is installed: 1,536 points 

• In case the 32-point module 

is installed: 3,072 points 

• In case the 64-point module 

is installed: 6,144 points 

• In case the 16-point module is 

installed: 768 points 

• In case the 32-point module is 

installed: 1,536 points 

• In case the 64-point module is 

installed: 3,072 points 

• In case the 16-point module is 

installed: 384 points 

• In case the 32-point module is 

installed: 768 points 

• In case the 64-point module is 

installed: 1,536 points 

Maximum extension 
distance 

15m 

 

• I/O number is constantly allocated to 64 points per slot of the base. 

• 64 points are assigned to each slot in the base regardless of module installation or 

module type. 

• There is no restriction in the installation position of special module and the number of 

modules to be used. 

•A fixed I/O number is not assigned to the special module digital I/O module. 

• The special module is controlled by dedicated function block, and memory is assigned 

automatically. 

• The case of assigning the I/O number in the system that uses the 12-slot base is as 

follows. 

  Slot No.  0   1   2   3    4   5   6   7    8   9   10  11 

P
o

w
e
r 

C
P

U
 

In
p

u
t 1

6
 

In
p

u
t 1

6
 

In
p

u
t 3

2
 

In
p

u
t 6

4
 

O
u

tp
u

t 1
6
 

O
u

tp
u

t 3
2
 

O
u

tp
u

t 3
2
 

O
u

tp
u

t 6
4
 

 In
p

u
t 3

2
 

O
u

tp
u

t 1
6
 

O
u

tp
u

t 3
2
 

O
u

tp
u

t 3
2
 

 

 

 

 

 

 

 

Notes  

(1) Main base number is fixed to '0', but the extension base number varies by the switch that sets the 

base number. 

(2) The operation will start only when the type of module set as the I/O parameter and the type of 

actually installed module are the same. 

 
  

%QX 0.11.0 ~ 31 

%QX 0.10.0 ~ 31 

%QX 0.9.0 ~ 15 

%IX 0.8.0 ~ 31 

Base number 0 
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(3) When XGR CPU is used 

(a) Basic system configuration method 

Classification Description 

Configuration of 
main base 

• Install two basic bases in the same configuration in duplicate. 

Maximum extension 
base 

• Up to 31 extension bases can be installed. 

Maximum No. of I/O 
modules installation 

• Up to 372 I/O modules can be installed on the extension base.  

Maximum I/O score 

• If the 16-point module is installed: 5,952 points 

• If the 32-point module is installed: 11,904 points 

• If the 64-point module is installed: 23,808 points 

Maximum extension 
distance 

• Between bases  

- Optical: 2 ㎞  

- Electric:100 m   

• Maximum distance 

- Optical: 64 ㎞ (In case 31 extension bases are configured)  

- Electric: 3.2 ㎞ (In case 31 extension bases are configured) case 31 extension bases are 

configured) 

Assignment of I/O 
number in the 

extension base 

• The starting I/O number of each base is decided by the base number set for the extension 
driver module (Set 1~31). 

• In the base, 64 points are assigned constantly to each slot for the I/O number. 
64 points are assigned to each slot regardless of module installation status or module 

type. 

• Unlike digital I/O module, the special module does not use input/output number for 
control. 

U device and the dedicated function block are used. 

• The case of assigning the I/O number in the system that uses the 12-slot base is as 
follows. 

 

Main base I/O 
number 

• Only the communication module is installed on the main base, so it is unrelated to I/O 
number. 

• The main base is base number 0 which is positioned in front of I/O number.  

 

Notes  

(1) Dual main base number is fixed to '0', but the extension base number varies by the switch that 
sets the base number. 

(2) Dual CPU module can be installed only on the main base. 
(3) Dual CPU module occupies 2 slots. 
(4) The operation will start only when the type of module set as the I/O parameter and the type of 

actually installed module are the same. 
(5) In case of remote connection using the Cnet I/F module, the station number of extension driver 

that can be connected is limited to 1~31. 
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4.5.2 Device Information 

(1) Standard settings 

Comm
unicati
on type 

Communi
cation 
speed 

Data 
bit 

Stop 
bit 

Parity 
bit 

Modem 
type 

Modem 
initialization 

Statio
n No. 

Respon
se 

waiting 
time 

Delay 
time 

Inter-
character 
waiting 

time 

RS-
232C 

300 ~ 
115,200 

7~8 1~2 
NONE~

ODD 

Null modem Disable(space) 0~31 0~50 0~255 0~255 

Dedicated 
modem 

Disable(space) 0~31 0~50 0~255 0~255 

Dial modem Enable 0~31 0~50 0~255 0~255 

RS-
485 

300 ~ 
115,200 

7~8 1~2 
NONE~

ODD 

Null modem Disable(space) 0~31 0~50 0~255 0~255 

Dedicated 
modem 

Disable(space) 0~31 0~50 0~255 0~255 

Dial modem Disable(space) 0~31 0~50 0~255 0~255 

RS-
422 

300 ~ 
115,200 

7~8 1~2 
NONE~

ODD 

Null modem Disable(space) 0~31 0~50 0~255 0~255 

Dedicated 
modem 

Disable(space) 0~31 0~50 0~255 0~255 

Dial modem Disable(space) 0~31 0~50 0~255 0~255 

 
(2) Modbus setting 

Channel 

 Modbus  

Setting  Item 

Default value per CPU 

Usage 
status 

XGK XGI XGR 

Channel 
1 

Use P2P Disable - - - - 

XGT server Disable - - - - 

Modbus 
ASCII 
server 

Enable 

Bit read area start address: P00000 %IX0.0.0 %IX0.0.0 

Bit write area start address: P01000 %QX0.0.0 %QX0.0.0 

Word read area start address: P0200 %MW0 %MW0 

Word write area start address: P0300 %MW100 %MW100 

Modbus 
RTU server 

Enable 

Bit read area start address: P00000 %IX0.0.0 %IX0.0.0 

Bit write area start address: P01000 %QX0.0.0 %QX0.0.0 

Word read area start address: P0200 %MW0 %MW0 

Word write area start address: P0300 %MW100 %MW100 

Channel 
2 

Use P2P Disable - - - - 

XGT server Disable - - - - 

Modbus 
ASCII 
server 

Enable 

Bit read area start address: P04000 %IX0.0.0 %IX0.0.0 

Bit write area start address: P05000 %QX0.0.0 %QX0.0.0 

Word read area start address: P0600 %MW0 %MW0 

Word write area start address: P0700 %MW100 %MW100 

Modbus 
RTU server 

Enable 

Bit read area start address: P04000 %IX0.0.0 %IX0.0.0 

Bit write area start address: P05000 %QX0.0.0 %QX0.0.0 

Word read area start address: P0600 %MW0 %MW0 

Word write area start address: P0700 %MW100 %MW100 

 
 

(3) P2P channel setting 

Channel Operation mode P2P driver TCP/UDP Client/server 
Port of 

destination 
station 

IP address of 
destination 

station 

1 XGT server - - - - - 

2 Use P2P 

XGT client - - - - 

User frame definition - - - - 

LS bus client 
(B type Cnet I/F Module) 

- - - - 

Modbus ASCII client     

Modbus RTU client - - - - 
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(4) P2P block setting 

Operation 
mode 

P2P 
driver 

P2P 
function 

Condition 
flag 

Command 
type 

Data type 
No. of 

variables 
Data 
size 

Destination 
station 
number 

Read area Save area Address 

XGT 
server 

- - - - - - - - - - - 

Use P2P 

XGT 
client 

Read 

XGT  
device 

single BIT 1 ~ 4 
Disable 
(space) 

0~32 

XGT device 

XGT device 

N device 
calculation 

method 

single 
1/2/4/8 (XGK) 
B/W/D/L (XGI) 

1 ~ 4 

Continuous 
1/2/4/8 (XGK) 
B/W/D/L (XGI) 

Disable 
(1) 

1 ~ 120 

Write 

single BIT 1 ~ 4 
Disable 
(space) single 

1/2/4/8 (XGK) 
B/W/D/L (XGI) 

1 ~ 4 

Continuous 
1/2/4/8 (XGK) 
B/W/D/L (XGI) 

Disable 
(1) 

1 ~ 120 

Modbus 
ASCII 
client 

Read 

single BIT Disable 
(space) 

00000~19999 

single WORD 30000~49999 

Continuous BIT 1 ~ 976 00000~19999 

Continuous WORD 1 ~ 61 30000~49999 

Write 

single BIT Disable 
(space) 

XGT device 

00000~09999 

single WORD 40000~49999 

Continuous BIT 1~944 00000~09999 

Continuous WORD 1~59 40000~49999 

Modbus  
RTU 
client 

Read 

single BIT Disable 
(space) 

00000~19999 

XGT device 
single WORD 30000~49999 

Continuous BIT 1~ 2000 00000~19999 

Continuous WORD 1~ 125 30000~49999 

Write 

single BIT Disable 
(space) 

XGT device 

00000~09999 

single WORD 40000~49999 

Continuous BIT 1~1968 00000~09999 

Continuous WORD 1~123 40000~49999 

User 
frame 

definition 

SEND 
Transmission 

body - - 1~ 1024 
XGT device 

variable-sized 
variable 

- 

RECEIVE - 
Receive 

body 
- - - - 

Memory 
specification 

LS bus 
client 

Read 

XGT 
device 

Continuous WORD 1 1 ~ 8 0~255 

Inverter 
address value 

XGT device 

Write XGT device 
Inverter 
address 

value 
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(5) User frame definition setting 

Group Frame Segment Note 

Send 1 

HEAD 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

TAIL 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

BCC - 

BODY 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

Variable-sized variable Up to 4 variables are available. 

Send 1 

HEAD 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

TAIL 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

BCC - 

BODY 

Numerical constant Up to 10 bytes 12345678901234567890 

String constant 
1234567890 
(Internally registered as 3132..30) 

Fix-sized variable Up to 4 variables are available. 

Variable-sized variable 
Only one variable-sized variable can be set. Therefore, a segment 
cannot be added at the back of the variable-sized variable. 

There is no restriction in the number of group, frame 
and segment, and there is restriction only in the 
maximum data size (0x4B00). 

 - 
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4.5.3 Available device areas for each CPU type 
 

CPU type Area Range Size(word) Note 

XGK 

(based on  

CPUE) 

P P0~P2047 2,048 Possible to read, write and monitor 

M M0~M2047 2,048 Possible to read, write and monitor 

K K0~K2047 2,048 Possible to read, write and monitor 

F F0~F2047 2,048 
Possible to read and monitor (write: possible 
from 1025 words) 

T T0~T2047 2,048 Possible to read, write and monitor 

C C0~2047 2,048 Possible to read, write and monitor 

L L0~L11263 11,264 Possible to read, write and monitor 

N N0~N21503 21,504 Possible to read, write and monitor 

D D0~D19999 20,000 Possible to read, write and monitor 

R R0~R32767 32,768 Possible to read, write and monitor 

ZR ZR0~ZR65535 65,536 
Possible to read, write and monitor (Provided 
only for XGK-CPUH) 

XGK 
(based on  
CPUH) 

I IW0.0.0~IW127.15.3 8,192 Possible to read, write and monitor 

Q QW0.0.0~QW127.15.3 8,192 Possible to read, write and monitor 

M MW0~MW131071 131,072 Possible to read, write and monitor 

R RW0~RW32767 32,768 Possible to read, write and monitor 

W WW0~WW65535 65,536 Possible to read, write and monitor 

XGR 

I IW0.0.0~IW127.15.3 8,192 Possible to read, write and monitor 

Q QW0.0.0~QW127.15.3 8,192 Possible to read, write and monitor 

M MW0~MW131071 131,072 Possible to read, write and monitor 

R RW0~RW32767 32,768 Possible to read, write and monitor 

W WW0~WW65535 65,536 Possible to read, write and monitor 

Common U U0~U4095 4,096 Possible to monitor 

 

Notes  
 

(1) ZR device is provided only in XGK-CPUH. 

(2) W” should be used in order to use ZR device for XGT communication frame as XGK CPU.  

Example) When requesting the word size from ZR0,“% WW000” should be requested. 

(3) The bit monitoring address in the U device is a hexadecimal (Hex) value and the monitoring area in the 

word area is a decimal value. 
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Chapter 5 System Configuration 

 

Up to 24 Cnet I/F modules including the main base and the extension base can be installed regardless of the 

CPU module. Among these modules, up to 8 modules can be used for the P2P service, and all 24 modules 

can be used in the server mode. You can establish various systems according to the usage by using the Cnet 

I/F module. In this chapter, an explanation of applicable systems using various cases is provided. And the 

explanation of a system that cannot be established using the Cnet I/F module is provided additionally for your 

reference. 

 

5.1 Applicable System Configuration 

 

5.1.1 Configuration Case 1 

 
(1) This system connects the HMI (PC) and the PLC in one to one through the RS-232C or RS-422 

channel without the modem. 

(2) The HMI (PC) operates as the client station and the Cnet I/F module operates as the server station 

that responds to the request of the HMI (PC). 

(3) Since the modem is not used, the communication distance is up to 15m in the case where the RS-

232C channel is used, and up to 500m in the case where the RS-422 channel is used. 

(4) The operation mode of the Cnet I/F module should be set according to the communication method of 

the HMI(PC). 
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5.1.2 Configuration Case 2 

 
(1) This system connects the PC (HMI) and the PLC in one to one through the dedicated line modem. 

(2) The PC (HMI) operates as the client station and the Cnet I/F module operates as the server station 

that responds to the request of the PC (HMI). 

(3) Since the connection is made through the modem, long distance communication is available only 

when the dedicated line modem is set for the RS-232C channel. 

(4) The Operation mode of the Cnet I/F module should be set according to the communication method of 

the PC(HMI). 
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5.1.3 Configuration Case 3 

 
(1) This system connects the PC(HMI) and the PLC through the modem and PLCs communicate to each 

other through the Cnet I/F module. 

(2) PC and Cnet #1 station are connected using the modem through the RS-232C channel. 

(3) Cnet #1 station ~ N station carry out the communication between Cnet I/F modules through the RS-

422 channel. 

(4) PC operates as the client station of the Cnet #1 station RS-232C channel.  

(5) The Cnet I/F module can connect to up to 32 stations (RS-422/485 communication). 

(6) Set Cnet #1 station as the client. 

(7) The dedicated line modem or dial-up modem can be used. 

 

 

 

 

Type 
Module setting 

RS-232C RS-422 Station No 

PLC Cnet #1 
station 

XGT server 
P2P 

1 
XGT client 

Cnet #2 ~ #32 
station 

Disable XGT server 2~32 

[Module setting table for each station] 
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5.1.4 Configuration Case 4 

 
(1) HMI(PC) and PLC carry out the null-modem communication using the RS-232C channel and PLC is 

the system that connects Smart I/O through the RS-422 channel. 

(2) HMI(PC) operates as the client station and the Cnet I/F module operates as the server station. At this 

time, the module is set as RS-232C XGT server. 

(3) The RS-422 channel of Cnet I/F module operates in P2P mode. 

(4) Data is transmitted to GSL-TR4A(Smart I/O transistor output 32 points for Modbus) through the RS-

422 channel of the Cnet I/F module. 

(5) Data transmitted to GSL-TR4A can be read with HMI(PC). 

 

 

 

 

Type 
Module setting 

RS-232C RS-422 Station No 

PLC Cnet #1 
station 

XGT server P2P 1 

[Module setting table for each station] 
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5.1.5 Configuration Case 5 

 
(1) This is the system that communicates using the wireless modem in an application field where an 

object which carries out a rectilinear motion is handled.  

(2) HMI and PLC can carry out the dedicated mode communication or P2P communication. 

(3) Cnet I/F module can carry out RS-232C/RS-422 communication with the optical modem. 

(4) The XGT server/client communication is carried out between Cnet I/F modules. 

(5) A moving object connected to the Cnet I/F module communicates with the Cnet I/F module in each 

floor through the optical modem while moving up and down. 

(6) Main application field: Parking tower, etc. 
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5.1.6 Configuration Case 6 

 
(1) This is the system that communicates using the wireless modem in an application field where a 

rotating object is handled. 

(2) Wireless modem and PLC carry out the RS-232C communication. 

(3) Cnet I/F modules carry out the dedicated server/client communication. 

(4) The RS-232C channel of the Cnet I/F module uses the dedicated modem mode. 

 

 

 

 

Type 
Module setting 

RS-232C RS-422 Station No 

XGL-CH2A 
Dedicated mode 

Disable 1,2 Station 
User mode 

[Setting content between communication modules] 
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5.1.7 Configuration Case 7 

 
(1) This is the TM/TC communication system that carries out long distance communication with the client 

PLC remotely using the dedicated line modem. 

(2) The RS-232C channel is set for the dedicated line modem mode and dedicated modem 

communication is carried out. 

(3) Cnet I/F modules carry out the dedicated server/client communication. 

(4) Up to 8 Cnet I/F modules can be installed on the PLC of the TM server. 
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5.2 System configuration that cannot be applied 

 

5.2. 1 Dial-up modem communication between Cnet I/F modules (conditional) 

 
(1) The Cnet I/F module has the function to answer the phone but it does not have the dialing function. 

(2) Therefore, the Cnet I/F modules cannot communicate with each other using the dial-up modem. 

However, communication is available through the flow control according to the program by using 

UDATA.(refer to section 10.5) 
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5.2. 2 XG5000 Connection Using the RS-422 channel of Cnet I/F module 

 
(1) The XG5000 service of the Cnet I/F module is supported only for the RS-232C channel. Therefore, 

XG5000 cannot be connected using the RS-422 channel. 

(2) The remote connection of the XG5000 has no function to set the station address of the Cnet. 

(3) In the following figure, only Cnet #1 station can connect to XG5000. 
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Chapter 6 Communication Parameter 
 

6.1 Overview 
 

The communication parameters can be classified into the default setting parameters and the P2P 
setting parameter. 

 

6.1.1 Standard Setting Parameters 
 
This is the part where the media information, H/W information and basic protocol information of the 
Cnet I/F module are set. 

Parameter Sub menu Setting item 
Setting range and 

contents 

Setting availability 
Note 

Client Server 

Standard 
settings 

Connection 
setting 

Communication 
type 

RS-232C 
RS-422 
RS-485 

Possible Possible  

Communication 
speed(bps) 

300 ~ 115,200 Possible Possible  

Terminating 
resistor 

Enable/disable Possible Possible  

STATION NO 

XGT communication 
: 0~31 
Modbus communication 
: 0~255  

Possible Possible 

When setting the 
client, the station 
number is 
meaningless. 

Operation 
mode 

Use P2P 

Select one mode 

Possible -  

XGT server - Possible  

Modbus ASCII  
server 

- Possible  

Modbus RTU  
server 

- Possible  

Smart server - Possible  

Repeater 
mode 

- Enable/disable - - 
Stop all services 
when the repeater 
mode is set 

Advanced 
Settings 

Connection 
setting 

Data bit 7, 8 Possible Possible 

When 
communicating 
Modbus ASCII 
mode, the number 
of data bits is 7. 

Stop bit 1, 2 Possible Possible  

Parity bit NONE,ODD,EVEN  Possible Possible  

Parity receive  
error  

Enable/Disable Possible Possible  

Modem type 
Null modem 
Dedicated line modem 
Dial up modem 

Possible Possible  

Modem 
initialization 

- Possible Possible 
It can be set only in 
case of dial-up 
modem. 

Setting of 
time 

Response 
waiting time 

0~50 (x 100ms) Possible -  

Delay time 0~255 (x 10ms) Possible Possible  

Inter-character 
waiting time 

0~255 (x 10ms) Possible Possible  
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(1) P2P service 
(a) This service allows the Cnet I/F module to act as a client on the network. 
(b) If a event occurs, it is possible to read or write the memory of the destination station (It can operate 

as the XGT client and the Modbus client.). 
(c) It is used for communicating with another company's equipment that does not support XGT or 

Modbus protocol or transmitting and receiving a frame desired by the user. 
(d) Up to 64 P2P blocks that operate independently can be defined for each channel. 

 
(2) Dedicated service(XGT server, Modbus ASCII server, Modbus RTU server) 

(a) This service allows PC and peripheral devices to read and write information and data without the 
creation of a separate program in the PLC. 

(b) The operation as the XGT server that supports the XGT protocol and the Modbus server that 
supports the Modbus RTU/ASCII protocol is possible. 
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6.1.2 P2P Setting Parameters 
 

This is the part for setting the communication frame. 

Parameter Sub menu 
Setting 

item 
Setting range and 

contents 
Contents 

P2P 

Communication 
Module setting 

Base 0~7(0~31:XGR) 
Set the module installation position 

Slot 0~11 

P2P channel P2P driver 

User frame definition 

Set the communication method 

XGT client 

Modbus ASCII client 

Modbus RTU client 

LS bus client 

P2P block 

Channel 1, 2 Set the communication port 

P2P 
function 

READ 
Set data transmission and reception 
(SEND and RECEIVE are used in the user 
frame definition.) 

WRITE 

SEND 

RECEIVE 

Start 
condition 

- 

Set frame operation condition 
(When communicating user frame definition, 
the starting condition can be selected only 
when the P2P function is SEND.) 

Command 
type 

single 
Set data transmission method 

Continuous 

Data type 

BIT 

Set the data unit of the frame 

WORD 

1 BYTE 

2 BYTE 

4 BYTE 

8 BYTE 

No. of  
variables 

1~4 Set the number of data in the frame 

Data size 
In accordance with the 
protocol 

Set the data size in the frame 

Destination 
station 

- Set in case the destination station is necessary 

Destination 
station 
number 

0~63 Set the station address of the destination station 

Frame 
Select in case of user 
frame definition 
communication 

Set the name of the bodies in the case of user 
frame definition communication 

Setting - 

In the case of user frame definition 
communication,’ Contents of variable setting' 
item can be entered only when the fixed-sized 
variable or variable-sized variable for the frame 
body is selected. 

User frame 
definition 

Adds 
Group 

Group name Set the name of frame group 

Type of 
frame 

Send Set transmission-related frame 

Receive Set reception-related frame 

Frame 

Edit group Group name 

Frame setting can be entered after setting the 
group name and frame type of the user frame 
definition. 

Delete 
group 

- 

Add frame 

HEAD 

TAIL 

BODY 
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6.1.3 Transmission Specifications 
In order to use the Cnet I/F module correctly, the various specifications including the communication 

speed and data format on the [Basic setting] item of the registered Cnet I/F module should be set. 
Basic setting value is saved to the CPU module of the PLC, and this value is maintained continuously 
even if the power is turned off; it will not change until it is written again. 

 
(1) Communication type 

You need to check the type of Cnet I/F module you wish to apply and set the basic parameters 
for each channel accurately. If the communication type set as the parameter is different from the 
communication type of the actually installed product, the CPU module recognizes the 
communication type of the installed product, so the system will not operate normally. 

 
(2) Parity bit 

There are three parity bits that can be set for the Cnet I/F module, and the content of each 
parity bit is as shown in the following table. If you select[Allow] for the parity reception error, you 
can receive data even if an error occurs in the reception parity bit. 
 

Parity Contents Note 

None Parity bit is not used.  

Even 
Transmits 0 to the parity bit if the number of 1 in one byte is an 
even number 

 

Odd 
Transmits 0 to the parity bit if the number of 1 in one byte is an 
odd number 

 

 
 

(3) Operation mode 
The operation mode of each channel is specified separately, so the operation is carried out 

independently for each channel. Each channel operates as the server or the client. 
 

 The type of operation mode that can be selected for each channel is as follows. 

Driver type Contents Note 

P2P 
The relevant port operates as the client and carries out 
the communication through P2P parameter setting. 

Refer to P2P 
setting 

XGT server 
It supports the XGT dedicated communication and 
operates as the XGT server. 

For dedicated 
service 

Modbus ASCII 
server 

Operates as the Modbus ASCII server. 

Modbus RTU 
server 

Operates as the Modbus RTU server. 

Smart server 
After analyzes the protocol automatically, act as 
XGT/Modbus ASCII/Modbus RTU server. 

 
When the XGT server or Modbus server is selected as the operation mode, the dedicated 

service, as well as the loader service,  
will be supported at the same time. 

 
(a) XGT server 

It only supports memory read/write of the dedicated service. 
 

(b) Modbus ASCII/RTU server 
1) It is selected when it consists of the Modbus protocol, and the Cnet I/F module should operate 

as the server. 
2) The value for mapping the memory area and XGT memory area defined in Modbus should be 

entered in the [Modbus setting] window. 
3) For memory mapping, refer to‘9.4 Modbus server’. 
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6.2 Module Register Method 
 

 In order to use the Cnet I/F module, the communication parameter should be set using XG5000, and 
the system setting can be carried out only when the relevant module is registered to the XG5000. The 
method to register the Cnet I/F module is as follows according to online and offline status. 
 

 

6.2. 1 Registering in Offline Status 
 
The method to set the module and communication parameter while not connected to the PLC is as 
follows. 

 

(1) Execute XG5000, select [Project] → [New project] or click the icon (  ). 
(2) Enter the project name you wish to save on [Project name], select the CPU module to use, and click 

[OK].  

 
 

(3) In the Project window, select [Undefined Network], click the right mouse button and select [Add 
item]→[Communication module]. When the following window appears, click [Add module] and select 
the module type, base number and slot number. 
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6.2. 2 Registering in Online Status 

 
The method to set the module and communication parameter while connected to the PLC is as follows. 

 
(1) As explained in 6.2.1, click [New project] and specify the project name, file location and CPU type. 

 

  
 

(2) If the connection to the PLC is not made properly, check the connection status and select 

[Online]→[Connection setting] or click the icon(  ) and select the connection method. The 
connection method includes the method to use the RS-232C cable, the method to use the USB cable, 
and the method to use Ethernet and modem. For the connection step, select Local in case of 
connecting to PLC directly, or select Remote 1-stage or Remote 2-stage in case of connecting using 
the remote method. For the remote connection method, refer to 7.3. 
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(3) When the connection is made normally, select [Online]→[System Diagnostics]→[I/O information] 

during the CPU module is in stop mode. 
 

 
 

(4) Click the [I/O Sync] button. 
 

 

 
 
 

(5) Check the contents shown in the Message window, and if there is no problem click[Yes]. 
 

 
  



 

 
Chapter 6 Communication Parameter 

 

6-8 

 

 

 

 

6.2.3 Reading Parameter value saved on PLC 
 

The method to read the basic setting value of communication module and P2P setting value saved on 
PLC is as follows. 
 

(1) Select [Project] → [Open from PLC]. 
 

 
 

(2) Set [Type] and [Depth] and click [Connect] or [OK]. 
(3) Now, you can check the basic setting value and P2P setting value saved on PLC. 
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6.3 Transmission Specifications Setting Method 
 
In order to operate the Cnet I/F module properly, the communication parameter should be set 

according to the applied specifications. It can be explained as follows by considering XGL-
CH2A(RS232 1port, RS422 1port) installed on No. 0 base and No. 0 slot 0 as an example. 

 
(1) Channel setting 

(a) Channel 1: RS-232C, 9,600 bps, 8/1/None, null modem, XGT server, station 1 
(b) Channel 2: RS-422, 38,400 bps, 8/1/Odd, null modem, use P2P, station 2 

 
(2) Execution sequence 

(a)  Read I/O Information 
Select [Online]→[Connect], click [I/O Sync] in [Online]→[System Diagnostics]→[I/O information] 
window and read the information of the module currently installed on the base. 

(b) Standard settings 
When you double click XGL-CH2A installed on No. 0 module, the [Standard setting] window will 
appear. Select the [Connection setting] item as follows. 
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(3) Write parameter 

1) Select [Online] → [Write] or click the icon ( ). 
2) Check (✓)the module whose basic setting is completed and click the [OK] button. 

 

 
 

(b) Check operation 
1) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or 

click the icon ( ). 
2) Click a communication module you wish to diagnose from the [System Diagnostics] window and 

click the right mouse button. 
3) When the following screen appears, click [Frame Monitor] or [Status by Service] to check the 

operation status. 
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6.4 Parameter Setting Method by Service 
 

6.4.1 Dedicated Service 
 

The dedicated service is function of Cnet I/F module to read or write PLC information or data 
using PC or an external device without a separate program in PLC. When this function is used, 
the Cnet I/F module operates as the server, and when PC or an external device requests for 
read/write memory, it responds. In order to use the dedicated service, you need to select a 
channel you wish to use as the server between channel 1 and channel 2. This operation mode 
supports the XGT server and the Modbus server, and the Modbus server supports both the RTU 
and ASCII types. Since each channel of the Cnet I/F module operates independently, it can be 
set as a different server respectively. For the method to check and diagnose the operation of 
dedicated service, refer to Chapter 12. 

 
(1) XGT server 

All frames used in the XGT server should not exceed 256 bytes, and a character used in all 
frames is configured in ASCII code. In case of using in multi drop method, the service can connect 
to up to 32 stations (including the client). Be careful not to use the same number again for setting 
the station address. The communication speed, stop bit, parity bit and data bit of all Cnet I/F 
modules connected to the network should be the same. The XGT server only supports XGT 
dedicated protocol memory read and write functions. 

 
(2) Modbus Server 

This function is used when the destination device you wish to communicate with operates as 
the Modbus client. It supports both RTU mode and ASCII mode of Modbus and can be defined in 
the operation mode of the [Standard settings] window. 

 

.  
[Standard settings window of Modbus server] 
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The Modbus commands and the maximum number of response data supported by the Modbus 
RTU/ASCII driver are as shown below the following table. The opposing client device is used within 
the range shown in this table. For example, Read bit can be requested for up to 2000 bits, and Write 
bit can be requested for up to 1968 bits (When the Modbus RTU is used). 

Hex Usage Available area Address 
Maximum response 

data 

01 Read bit individually/continuously Output bit 0XXXX 2000 Coils 

02 Read bit individually/continuously Input bit 1XXXX 2000 Coils 

03 Read word individually/continuously Output word 4XXXX 125 Registers 

04 Read word individually/continuously Input word 3XXXX 125 Registers 

05 Write bit individually Output bit 0XXXX 1 Coil 

06 Write word individually Output word 4XXXX 1 Register 

0F Write bit continuously Output bit 0XXXX  1968 Coils 

10 Write word continuously Output word 4XXXX 120 Registers 

[Modbus command code] 
 

The area corresponding to the command code shown in the table above should be set to the 
XGT PLC memory. When you select the Modbus ASCII server or Modbus RTU server as the 
operation mode from the [Basic setting] window, the [Modbus setting] button will be enabled. When 
you click this button, the [Modbus setting] window will be displayed as shown in the figure below. 
Set the start address from this window. 

 

 
[Modbus server memory setting] 

 
The contents of each setting item are as follows. 

Item Contents Note 

Start address of read bit 
area 

Address of XGT that corresponds to the bit 
input area 

Bit address 

Start address of write bit 
area 

Address of XGT that corresponds to the bit 
output area 

Bit address 

Start address of read word 
area 

Address of XGT that corresponds to the 
word input area 

Word 
address 

Start address of write word 
area 

Address of XGT that corresponds to the 
word output area 

Word 
address 

[Meaning of Modbus area] 
 

(a) The address value set for each item is the start address of the relevant area.  
(b) The above figure shows that the start address of the read bit area is assigned, starting from the 0th 

bit of M0000 word and the start area of the write word area is assigned, starting from M300. 
(c) The input value of the start address should be in a valid range, such as M and P.  
(d) Since the Modbus address is 1 ~ 9999 (decimal number), the size of bit I/O area will be 9999/8 

=1249.875 (in other words, 1249, bytes should be an integer) bytes. 
(e) The size of word I/O area is 9999*2 = 19998 bytes. 
(f) If the CPU is XGK series, the read/write bit address is word+bit. 
(g) Example in case the 1st bit of the second word in the read area is the start address: 0x10020 
(h) If the CPU is XGI series, the read/write bit address is bit. 
(i) Example in case the 10th bit in the read area is the start address: 0x10009 
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6.4.2 P2P Service 
 

The P2P service is the function to operate the Cnet I/F module as the client. In GLOFA series 
and MASTER-K series, the parameters were set using the command block, but in XGT series, 
the parameters can be set simply from the [P2P parameter setting] window. The P2P 
commands that can be used in the Cnet I/F module are four commands including Read, Write, 
Send and Receive.  Among these commands, Send and Receive are used for writing a frame 
using [User frame definition], and Read and Write are used in case of operating as [XGT 
dedicated client] or [Modbus RTU/ASCII client]. 

Registering and editing the P2P service can be done in XG5000 and up to 8 P2P parameters 
can be set. Each P2P parameter consists of up to 64 P2P blocks. The below figure is an 
example of setting parameters in the [P2P parameter setting ] window of the XG5000. 
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(1) P2P parameter configuration 

In order to use the P2P service, each parameter should be set in the P2P parameter window. The 
P2P parameter consists of three pieces of information as shown below. 

 

 
 

 
(a) P2P channel 

1) Define a communication protocol for carrying out the P2P service. 
2) Supported protocols: XGT client, Modbus ASCII client, Modbus RTU client, LS bus client, user 

frame definition communication  
3) Set the parameter for each channel independently. (It applies only when ’Use P2P’ is selected 

for the operation mode in the [Standard settings] window) 
 

(b) P2P block 
        Set 64 P2P blocks that operate independently 
 

(c) User frame definition 
Register a parameter for the user frame definition communication. 
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(2) P2P channel setting 

The Cnet I/F module provides two communication channels that operate independently, and the 
to the driver type for carrying out the P2P service can be defined for each channel. However, in 
order for the P2P channel to operate as the client,’ Use P2P‘ should be selected for the operation 
mode in the [Standard setting] window. The P2P channel setting according to the operation mode 
is as follows. 

 
 

Operation mode P2P channel setting 

  
 

 The drivers that can be selected when’ Use P2P‘ is selected for the operation mode are as follows. 
 

Driver Usage 

User frame definition 
It is used when it sends/receives the desired user frame 
definition. 

XGT client It is used for reading or writing XGT CPU memory. 

LS bus client It is used for the dedicated communication with the LS inverter 

Modbus ASCII client 
It is used for operating as the Modbus client and used as the 
ASCII mode. 

Modbus RTU client 
It is used for operating as the Modbus client and used as the 
RTU mode. 

 
When the XGT or Modbus is selected for the P2P driver, the user frame definition cannot be used. 
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(3) P2P block setting 

When the P2P block of the relevant parameter is selected in the [P2P Channel setting] window, 
the [P2P block setting] window will be displayed. The block setting window for all protocols is as 
shown in the figure below, and a different area which is enabled according to the protocol selected 
from P2P channel is displayed. 

 

P2P driver P2P block setting 
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6.5 Operation Start 
 

The operation mode of the Cnet I/F module can be divided into the P2P service and the server function. 
The method to use each mode is as follows. 

 

6.5.1 When Operating as the server 
 

(1) Connection setting 

(a) Select [Online] → [Connection Settings] or click the icon (  ). 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Read I/O Information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 

 
(3) Standard settings 

(a) In the Project window, open the [Standard setting] window by double clicking the relevant Cnet I/F 
module, and set the communication type, communication speed, modem type, data bit, stop bit and 
station address from the connection setting menu. 

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only when 

P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 

 
* When using as a Modbus ASCII server, the data bit is 7. 

  



 

 
Chapter 6 Communication Parameter 

 

6-18 

 

 

 

       
 

(4) Selecting the operation mode 
(a) Select the operation mode of using server. 
(b) The Cnet I/F module supports the XGT server, Modbus ASCII server and Modbus RTU server. 

 
(5) Write parameter 

(a) Select [Online] → [Write] or click the icon ( ). 
(b) Check (✓) the module with the default settings and click [OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 
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(6) Check operation 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click the communication module whose status you want to diagnose and press the right mouse 

button.  
(c) When the following screen appears, click [Frame Monitor] or [Status by Diagnosis] to check the 

operation status. 
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6.5.2 When operating as a P2P service(client) 
 

(1) Standard settings 
(a) 6.6.1 The contents of (1)~(3) in section 1 are the same.  
* Set 7 for the data bit in case of operating as the Modbus ASCII client. 
(b) Select’ Use P2P' for the operation mode. 

 

 
 

(2) P2P channel setting 
(a) In the [P2P Channel setting] window, double click P2P channel and select the protocol for each 

channel. 
(b) The user frame definition, XGT client, LS bus client, Modbus RTU client and Modbus ASCII client 

are supported for the P2P driver. 
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(3) P2P block setting 
(a) Depending on the type of client selected in the channel setting, the P2P block setting value will be 

activated differently. 
(b) Write the content of the enabled cell according to the protocol type. 

* The user frame definition can be used only when the frame is written in the user frame 
definition. 

 

 
 

(4) Write parameter 

(a) Select [Online] → [Write] or click the icon ( ). 
(b) Check (✓) the module after completing settings and click [OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each the module. 

 

 
 

(5) Link enable 
(a) Select [Online] → [Communication module settings and Diagnosis] → [Enable Link/Services] or 

click the icon ( ) 
(b) Check (✓) the configured P2P and click [Write]. 
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1) Link enable through a flag 

   The following is the method to enable the link using a flag. In order to use this function, the 
software version of XG5000 and CPU module should satisfy the following condition. 

Item name Version 

XG5000 V3.61 or higher  

XGR CPU V1.91 or higher 

XGI CPU V3.4 or higher 

XGK CPU V3.7 or higher 

 
2) List of flags related to link enable 

a) XGR  

Flag Data type Device Contents 

_HS_ENABLE_STATE ARRAY[0..11] OF BOOL %FX19040 HS enable/disable current 
status 

_HS_REQ ARRAY[0..11] OF BOOL %FX31520 HS enable/disable request 

_HS_REQ_NUM ARRAY[0..11] OF BOOL %FX31536 Setting enable/disable for 
high speed link 

_P2P_ENABLE_STATE ARRAY[0..7] OF BOOL %FX19072 P2P enable/disable current 
status 

_P2P_REQ ARRAY[0..7] OF BOOL %FX31552 P2P enable/disable request 

_P2P_REQ_NUM ARRAY[0..7] OF BOOL %FX31568 Setting P2P enable/disable 

 
b) XGI 

Flag Data type Device Contents 
_HS_ENABLE_STATE ARRAY[0..11] OF BOOL %FX15840 HS enable/disable current 

status 

_HS_REQ ARRAY[0..11] OF BOOL %FX16480 HS enable/disable request 

_HS_REQ_NUM ARRAY[0..11] OF BOOL 
%FX16496 

Setting enable/disable for 
high speed link 

_P2P_ENABLE_STATE ARRAY[0..7] OF BOOL 
%FX15872 

P2P enable/disable current 
status 

_P2P_REQ ARRAY[0..7] OF BOOL %FX16512 P2P enable/disable request 

_P2P_REQ_NUM ARRAY[0..7] OF BOOL %FX16528 Setting P2P enable/disable 

   
c) XGK 

Flag Data type Device Contents 

_HS1_ENABLE_STATE BIT F09600 
Current enable/disable status of high speed link 
NO. 1 

_HS2_ENABLE_STATE BIT F09601 
Current enable/disable status of high speed link 
NO. 2 

_HS3_ENABLE_STATE BIT F09602 
Current enable/disable status of high speed link 
NO. 3 

_HS4_ENABLE_STATE BIT F09603 
Current enable/disable status of high speed link 
NO. 4 

_HS5_ENABLE_STATE BIT F09604 
Current enable/disable status of high speed link 
NO. 5 

_HS6_ENABLE_STATE BIT F09605 
Current enable/disable status of high speed link 
NO. 6 

_HS7_ENABLE_STATE BIT F09606 
Current enable/disable status of high speed link 
NO. 7 

_HS8_ENABLE_STATE BIT F09607 
Current enable/disable status of high speed link 
NO. 8 

_HS9_ENABLE_STATE BIT F09608 
Current enable/disable status of high speed link 
NO. 9 

_HS10_ENABLE_STATE BIT F09609 
Current enable/disable status of high speed link 
NO. 10 

_HS11_ENABLE_STATE BIT F0960A 
Current enable/disable status of high speed link 
NO. 11 

_HS12_ENABLE_STATE BIT F0960B 
Current enable/disable status of high speed link 
NO. 12 

_HS1_REQ BIT F10300 
Request enable/disable for high speed link No. 
1 
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Flag Data type Device Contents 

_HS2_REQ BIT F10301 
Request enable/disable for high speed link No. 
2 

_HS3_REQ BIT F10302 
Request enable/disable for high speed link No. 
3 

_HS4_REQ BIT F10303 
Request enable/disable for high speed link No. 
4 

_HS5_REQ BIT F10304 
Request enable/disable for high speed link No. 
5 

_HS6_REQ BIT F10305 
Request enable/disable for high speed link No. 
6 

_HS7_REQ BIT F10306 
Request enable/disable for high speed link No. 
7 

_HS8_REQ BIT F10307 
Request enable/disable for high speed link No. 
8 

_HS9_REQ BIT F10308 
Request enable/disable for high speed link No. 
9 

_HS10_REQ BIT F10309 
Request enable/disable for high speed link No. 
10 

_HS11_REQ BIT F1030A 
Request enable/disable for high speed link No. 
11 

_HS12_REQ BIT F1030B 
Request enable/disable for high speed link No. 
12 

_HS1_REQ_NUM BIT F10310 Set enable/disable for high speed link No. 1 

_HS2_REQ_NUM BIT F10311 Set enable/disable for high speed link No. 2 

_HS3_REQ_NUM BIT F10312 Set enable/disable for high speed link No. 3 

_HS4_REQ_NUM BIT F10313 Set enable/disable for high speed link No. 4 

_HS5_REQ_NUM BIT F10314 Set enable/disable for high speed link No. 5 

_HS6_REQ_NUM BIT F10315 Set enable/disable for high speed link No. 6 

_HS7_REQ_NUM BIT F10316 Set enable/disable for high speed link No. 7 

_HS8_REQ_NUM BIT F10317 Set enable/disable for high speed link No. 8 

_HS9_REQ_NUM BIT F10318 Set enable/disable for high speed link No. 9 

_HS10_REQ_NUM BIT F10319 Set enable/disable for high speed link No. 10 

_HS11_REQ_NUM BIT F1031A Set enable/disable for high speed link No. 11 

_HS12_REQ_NUM BIT F1031B Set enable/disable for high speed link No. 12 

_P2P1_ENABLE_STATE BIT F09620 P2P1 enable/disable current status 

_P2P2_ENABLE_STATE BIT F09621 P2P2 enable/disable current status 

_P2P3_ENABLE_STATE BIT F09622 P2P3 enable/disable current status 

_P2P4_ENABLE_STATE BIT F09623 P2P4 enable/disable current status 

_P2P5_ENABLE_STATE BIT F09624 P2P5 enable/disable current status 

_P2P6_ENABLE_STATE BIT F09625 P2P6 enable/disable current status 

_P2P7_ENABLE_STATE BIT F09626 P2P7 enable/disable current status 

_P2P8_ENABLE_STATE BIT F09627 P2P8 enable/disable current status 

_P2P1_REQ BIT F10320 Request enable/disable for P2P No. 1 

_P2P2_REQ BIT F10321 Request enable/disable for P2P No. 2 

_P2P3_REQ BIT F10322 Request enable/disable for P2P No. 3 

_P2P4_REQ BIT F10323 Request enable/disable for P2P No. 4 

_P2P5_REQ BIT F10324 Request enable/disable for P2P No. 5 

_P2P6_REQ BIT F10325 Request enable/disable for P2P No. 6 

_P2P7_REQ BIT F10326 Request enable/disable for P2P No. 7 

_P2P8_REQ BIT F10327 Request enable/disable for P2P No. 8 

_P2P1_REQ_NUM BIT F10330 Set enable/disable for P2P No. 1 

_P2P2_REQ_NUM BIT F10331 Set enable/disable for P2P No. 2      

_P2P3_REQ_NUM BIT F10332 Set enable/disable for P2P No. 3 

_P2P4_REQ_NUM BIT F10333 Set enable/disable for P2P No. 4 

_P2P5_REQ_NUM BIT F10334 Set enable/disable for P2P No. 5 

_P2P6_REQ_NUM BIT F10335 Set enable/disable for P2P No. 6 

_P2P7_REQ_NUM BIT F10336 Set enable/disable for P2P No. 7 

_P2P8_REQ_NUM BIT F10337 Set enable/disable for P2P No. 8 

   
3) Link enable method 

Set On for high speed link/P2P enable/disable setting flag → high speed link/P2P 
enable/disable request flag On 
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4) Link disable method 
Set Off for high speed link/P2P enable/disable setting flag → high speed link/P2P 
enable/disable request flag On 

5) The enable/disable status of the relevant link can be monitored through current Enable/disable 
status flag. 
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(6) Check operation 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click a communication module whose status you wish to diagnose and click the right mouse 

button.  
(c) When the following screen appears, click [Frame Monitor] or [Status by Service] to check the 

operation status. 
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6.6 XG5000 Diagnosis Function 
 

6.6.1 Type of Diagnosis Function 
 
Check the system and network status using the diagnosis function of the XG5000. Main 
items that can be diagnosed are as follows. 

⚫ CPU status 
⚫ Communication Module Information 
⚫ Frame monitor 
⚫ Loopback test 
⚫ Status By Service 
⚫ Media information(Cnet O/S V5.0 or higher) 

 
 

(1) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click the 

icon ( ). 
(2) Click a module whose status you wish to diagnose and click the right mouse button. 
(3) When the following screen appears, click [Loopback test] or [Status by Service] to check the operation 

status. 
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6.6.2 Checking CPU Status 
 

(1) CPU module information 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or 

click the icon ( ). 
(b) Click the CPU module and click the right mouse button. 
(c) When you click [CPU module information], the screen where you can check the status of 

CPU module will be displayed as follows. 
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6.6.3 Communication Module Information 
 

(1) Communication Module Information 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click the Cnet I/F module and click the right mouse button. 
(c) When you click [Communication module information], the screen where you can check the status of 

communication module will be displayed as follows. 
 

 
 

(2) Contents for each communication module information item 
 

Item Content 

Standard 
information 

Base No. 
Indicate the base information of the communication 
module currently being diagnosed. 

Slot No. 
Indicate the slot number of the communication module 
currently being diagnosed. 

Module type 
Type of communication module which is being 
diagnosed 

Link information 
Station No 

Station address of the relevant channel used in the 
dedicated service and P2P 

Selection of option Communication type(RS-232C, RS-422) information 

Hardware/softwa
re information 

Hardware version Hardware version of communication module 

Hardware status 
Whether the hardware of the communication module is 
normal or not 

Software version O/S version of communication module 

RUN 
mode/additional 
information 

RUN mode 
Display service information carried out among 
dedicated service and P2P 

Additi
onal 
infor
matio
n 

P2P Display enable or disable  

Dedicated 
service 

Display the type of driver operating as the server 

PADT Display whether remote 1-stage or 2-stage connection 

System parameter setting information 

Information for confirming whether basic communication 
parameters have been downloaded or not. 
Indicates standard communication parameter error 
information 
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6.6.4 Frame Monitor 
 

Check whether a frame transmitted or received through Cnet I/F module is normal or not by using 
the frame monitor of XG5000. 

 
(1) Frame monitor 

(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b)  Click the Cnet I/F module and click the right mouse button. 
(c) When you click [Frame monitor], the screen where you can monitor the communication status will 

be displayed as follows. 
 

 
 

(2) Detailed contents of frame monitor 
Item Contents 

Standard 
information 

Base No. 
Indicate the base information of the communication module currently 
being diagnosed. 

Slot No. 
Indicate the slot number of the communication module currently 
being diagnosed. 

Media information 

Communication type Communication type of the channel which is being monitored 

Communication 
speed 

Communication speed of the channel which is being monitored 

Select view 

View as HEX Displays frame data in Hex value 

View as ASCII Displays frame data in ASCII value 

View IFG during 
reception (connect) 

If the reception frame has been received in multiple parts, displays 
the time interval between frames in 0.1ms and view on one line. 

View IFG during 
reception (Split) 

If the reception frame has been received in multiple parts, displays 
the time interval between frames in 0.1ms and view as the split frame 
unit. 

Monitor options Channel selection Select a channel you wish to Monitoring 

Frame monitor 
window 

Type Indicates the transmitted and received frames 

Process result 

Indicates the protocol type 
1) XGT server 
2) XGT client 
3) Modbus server 
4) Modbus client 
5) User frame definition 
6) Unknown: Frame that cannot be processed 

Size Length of monitored frame 

Time Indicates the time of transmission/reception 

Frame data Indicates the data of transmitted/received frame 

File save Save the frame monitoring contents to an Excel file format 

Start Start frame monitoring 

Stop Stop monitoring  
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6.6.5 Loopback Test 
 

(1) Prior preparation 
(a) Be sure to set the server operation mode for the relevant module. 
(b) Disable the P2P link enable of the relevant module (uncheck). 
(c) Wire according to each communication port as shown in the figure below. 

1) RS-232C communication: Connect No. 2 and No. 3 pin of the port.  
2) RS-422 communication: connect the TX+ and RX+ pins and the TX- and RX- pins of the port.  

 
<XGL-CH2B> 

 
(2) Test method 

(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click the Cnet I/F module and click the right mouse button. 
(c) When you click [Loop-back test], the following screen will be displayed. Select a channel you wish 

to test and click [Redo]. 
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6.6.6 Status by Service 
 

(1) Dedicated service 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click Cnet I/F module and click the right mouse button. 
(c) Click [Status by service], and when the following screen is displayed, select [Dedicated service]. 
(d) Click [Multiple Reading] and check Status by Service. 

 

 
 

(2) P2P service 
(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click Cnet I/F module and click the right mouse button. 
(c) Click [Status by service], and when the following screen is displayed, select [P2P service]. 
(d) Click [Multiple Reading] and check the status of each service. 
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(3) Detailed contents of each service 

Classification Item Contents 

Dedicated 
service 

Standard 
information 

Base No. 
Base position of the relevant module that uses the 
dedicated service 

Slot No. 
Slot position of the relevant module that uses the dedicated 
service 

Module types Type of communication module which is being used 

Dedicated service information Indicates the type of driver used for each channel 

Detailed 
information 
window 

Port number Displaying the channel number 

Service count Displays the number of dedicated service communication 

Error count 
Displays the number of errors that occurred during 
dedicated service communication 

Status 
Indicates the communication status of the dedicated 
service 

P2P service 

Standard 
information 

Base No. 
Base position of the relevant module that uses the 
dedicated service 

Slot No. 
Slot position of the relevant module that uses the dedicated 
service 

Module type Type of communication module which is being used 

P2P 
service 
information 

Status of P2P 
parameter 
existence 

Indicates whether the P2P parameter has been 
downloaded or not 

Driver type 
P2P driver setting information for each port 
XGT/Modbus/user frame definition available 

Detailed 
information 

Block No. 
Available range 0 ~ 63 Displays only a registered block that 
is operating 

Port number Displaying the channel number 

Status 
Indicates the information regarding the service execution 
status by block 

Service count 
Indicates the number of executions for each block from the 
time when the P2P service is executed 

Error count Displays the number of errors occurring during service 

Multiple 
reading/ 
Refresh 

Continuous reading Checks P2P service status information every 1 second 

Refresh 
Checks the P2P service status information at the selected 
time 

 
(4) Error according to the status code by service 

It is used for identifying the communication status of the Cnet I/F module. 

Dedicated service P2P service 

Status Contents Status Contents 

0 Normal communication 0 Normal communication 

1 
Receive frame header error (there is no 
ACK/NAK) 

4 
Max. station setting error(When set more than 
31 stations have been set) 

2 Receive frame tail error.(there is no tail) 5 Time out 

3 Reception frame BCC error FFFE 
1. Modbus address error 
2. If a command other than 2.Read/Write is 

used 

9 
Station number of RX frame is different 
with self-station number (Self station 
number = 0) 

- 

0A If no response is received from CPU 

0B 
RX frame size exceeds the Modbus 
max. frame size  

0C 
If the received frame is not Modbus 
ASCII/Modbus RTU 

0D 
In case of HEX conversion error in 
Modbus 
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6.6.7 Media Information 
 

It is used to determine whether communication is normal or not by providing the media status and 
service status statistics of the Cnet I/F module. This function is provided by the B type Cnet I/F module. 
 

(a) Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis] or click 

the icon ( ). 
(b) Click Cnet I/F module and click the right mouse button. 
(c) When you click [Media information], the following screen will be displayed. 

 
 

 
 
 

 Detailed contents of media information field 

Classification Item Contents 

Media status 
information 

Send Transmission count per channel 

Receive Reception count per channel 

Undefined frame 
reception 

Undefined frame reception count per channel 

Char time out count Received split frame count per channel  

Parity Error Parity error count per channel 

Break Error Break error count per channel 

Overrun Error Overrun error count per channel 

Framing Error Framing error count per channel 

Service 
status 
information 

Send Transmission count per communication service 

Receive Reception count per communication service 

FCS Error 
Frame check sequence (FCS) error count per 
communication service 

Time Out Response time out count per communication service client 
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Chapter 7 XGT Communication 
 

7.1 Overview of XGT Protocol  
 

The XGT protocol is a Cnet I/F module dedicated protocol developed by LS ELECTRIC. By 
using this protocol, you can connect to the PLC, read or write data, register a monitor variable 
and carry out monitoring, and connect to a PLC a long distance away remotely, and read or write 
in the program. You can also check whether communication status is normal or not by monitoring 
actual protocols exchanged with the opposing device using the frame monitoring of the XG5000. 
The XGT protocol is classified into the XGT client that requests read/write data to the opposing 
device and the XGT server that processes the contents requested by the XGT client. 

 
(1)  Read and write data 

This is the function to connect to a PLC, read or write data and carry out monitoring. 
 

(2) Read and write a file 
This is the function to read or write a program or a parameter saved on a PLC a long distance 

away while connecting using remote 1-stage or 2-stage using the Cnet I/F module. 
 

(3) Frame monitor 
The frame monitoring of the XG5000 is the function to check an actual frame which the XGT 

client and server exchange with the opposing device. By using this function, you can analyze 
data and check if an error exists, so a problem that occurs during communication can be solved. 

 
(4)  XGT client/server 

The XGT client carries out the task to request read/write data to the opposing device. And, the 
XGT server carries out the task to analyze data sent by the XGT client, and when a frame that 
meets the XGT protocol specifications is received, the XGT server processes the command 
requested, along with the ACK response, and if a frame that does not meet the specifications is 
received, the XGT server transmits the NAK response, including the error code to the XGT client. 

 
(5) Functions provided by the Cnet I/F module when the XGT protocol is used. 

(a) Operate as an independent channel of RS-232C, RS-422 and RS-485. 
(b) Write device individually/continuously. 
(c) Read device individually/continuously. 
(d) Register a variable to monitor. 
(e) Execute monitor. 
(f) 1:1 connection (own link) system configuration. (Cnet I/F module: RS-232C) 
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7.2 Frame Structure 
 

7.2.1 Frame Structure 
 

The frame of the XGT protocol is classified into the frame where the XGT client requests read/write 
data and the frame where the XGT server responds to such a request. 

 

 
(1) Command frame sequence 

When the client transmits a request frame to the server, the server analyzes the received frame. 
As a result, if the frame conforms to the protocol rule, the server transmits the ACK response 
frame, and if not, the server transmits the NAK frame with the error code attached. 

 
 

(2) Basic frame structure of XGT protocol 
(a) Request frame (Equipment which operates as the XGT client) 

Head 
Destination 

station 
number 

Command 
Command 

type 
Data area Tail (EOT) 

Frame 
check(BCC) 

 
(b) Response frame (Equipment which operates as the XGT server) 

1) ACK response frame (received frame according to the XGT protocol rule) 

Head(ACK) 
Self-

station 
Command 

Command 
type 

Data area or null 
code 

Tail (ETX) 
Frame 

check(BCC) 

2) NAK response frame (received frame against the XGT protocol rule) 

Head(NAK) 
Self-

station 
Command 

Command 
type 

Error code 
(ASCII type 4 

byte) 
Tail (ETX) 

Frame 
check(BCC) 
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(3) Characteristics of frame  
(a) In case of numeric data of all frames, a Hex value is expressed in ASCII code, unless specified 

otherwise. 
(b) Items expressed as a Hex value are as follows. 

1) Station No 
2) Command type in case the command type is a number (indicates the data type) when the main 

command is R(r) and W(w) 
3) Whole items that indicate the size of all data in the structured data area 
4) Command registration number for monitor registration and execution command 
5) Whole content of data 

(c) In the case of hexadecimal data, ‘h’ is attached to the number as in h01, h12345, h34, h12 and 
h89AB, etc. to indicate that this data is hexadecimal. 

(d) Up to 256 bytes can be used for the frame. 
(e) The contents of a control code used are as follows. 

Code Hex Name Contents of control 

ENQ 05 Enquire Start code of request frame 

ACK 06 Acknowledge Start code of the ACK response frame 

NAK 15 Not Acknowledge Start code of the NAK response frame 

EOT 04 End of Text End ASCII code of request frame 

ETX 03 End Text End ASCII code of response frame 

 
(f)  If the command is lowercase, the BCC value is added to the frame check, and if it is uppercase, 

the BCC value is not added. 
Example) Read device command R(r) 

- In case of lowercase r: Add BCC   
- In case of uppercase R: BCC is not added.  
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7.2.2 XGT Communication Commands 
 

(1) Type of command 
The types of commands used in the dedicated communication are as follows. 

Classification 
 

Item 

Command 

Contents of process Main command Command type 

ASCII Hex ASCII Hex 

Read 
device 

Read 
individually 

r(R) h72(h52) SS h5353 Read bit and word-type variable directly 

Read 
continuously 

r(R) h72(h52) SB h5342 
Read direct variables of word type in block 
unit*Note 1) 

Device     
write 

Write 
individually 

w(W) h77(h57) SS h5353 
Write data on bit and word-type direct 
variable 

Write 
continuously 

w(W) h77(h57) SB h5342 
Write direct variables of word type in block 
unit*Note 2) 

 

Classification 
 
Item 

Command 

Contents of process Main command Registration number  

Example 
of frame 

Hex 
Registration 

number 
Hex 

Register monitor 
variable 

x(X) h78(h58) 00~09 h3030~3039 Register a variable to Monitoring  

Execute monitor y(Y) h79(h59) 00~09 h3030~3039 Execute monitor of a registered variable 

 
(2) Data type 

Data type 
Example of 

displayed frame  
Example of usage  

Bit X(58h) 
%PX000,%MX000,%LX000,%KX000,%CX000,%TX000,%FX000, 
%IX0.0.0,%QX0.0.0 ,%UX00.00.0, etc 

Byte B(42h) 
%PB000,%MB000,%LB000,%KB000,%CB000,%TB000,%FB000, 
%IB0.0.0,%QB0.0.0,etc 

WORD W(57h) 
%PW000,%MW000,%LW000,%KW000,%CW000,%TW000,%FW000, 
%DW000,%IW0.0.0,%QW0.0.0,%MW0,%RW0,%WW0,%UW00.00,etc 

Double 
word*Note 3) 

D(44h) 
%PD000,%MD000,%LD000,%KD000,%CD000,%TD000,%FD000,%DD0
00,%SD000,%ID0.0.0,%QD0.0.0,%MD0,%RD0,%WD0,etc 

Long 
word*Note 4) 

L(4Ch) 
%PL000,%ML000,%LL000,%KL000,%CL000,%TL000,%FL000,%DL000,
%SL000,%IL0.0.0,%QL0.0.0,%ML0,%RL0,%WL0,etc 

 
 
 

Notes  

Note 1) Bit continuous read is not allowed in the case of continuous read. 
Note 2) Bit continuous write is not allowed in the case of continuous write. 
Note 3) Double word: When converting into byte, 1 double word is 4 bytes.  
Note 4)Long word: When converting into byte, 1 long word is 8 bytes.  
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(3) Available device area 

CPU type Area Range Size(word) Note 

XGK 
(based on 
CPUE) 

P P0~P2047 2,048 Possible to read, write and monitor 

M M0~M2047 2,048 Possible to read, write and monitor 

K K0~ K2047 2,048 Possible to read, write and monitor 

F F0~ F2047 2,048 
Possible to read and monitor 
(write: possible from 1025 words)  

T T0~T2047 2,048 Possible to read, write and monitor 

C C0~2047 2,048 Possible to read, write and monitor 

L L0~L11263 11,264 Possible to read, write and monitor 

N N0~N21503 21,504 Possible to read, write and monitor 

D D0~D19999 20,000 Possible to read, write and monitor 

R R0~R32767 32,768 Possible to read, write and monitor 

ZR ZR0~ZR65535 65,536 
Possible to read, write and monitor  
(Provided only for XGK-CPUH) 

XGI 
(based on 
CPUH) 

I IW0.0.0~IW127.15.3 8,192 Possible to read, write and monitor 

Q QW0.0.0~QW127.15.3 8,192 Possible to read, write and monitor 

M MW0~MW131071 131,072 Possible to read, write and monitor 

R RW0~RW32767 32,768 Possible to read, write and monitor 

W WW0~WW65535 65,536 Possible to read, write and monitor 

XGR 

I IW0.0.0~IW127.15.3 8,192 Possible to read, write and monitor 

Q QW0.0.0~QW127.15.3 8,192 Possible to read, write and monitor 

M MW0~MW131071 131,072 Possible to read, write and monitor 

R RW0~RW32767 32,768 Possible to read, write and monitor 

W WW0~WW65535 65,536 Possible to read, write and monitor 

Common U U0~U4095 4,096 Possible to monitor 

 
 

Notes  
 

(1) ZR device is provided only in XGK-CPUH. 

(2) W” should be used in by to use ZR device for XGT communication frame as XGK CPU.  

Example) When requesting the word size from ZR0,“% WW000” should be requested. 

 (3) The bit monitoring address in the U device is a hexadecimal (Hex) value and the monitoring area 

in the word area is a decimal value. 
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7.2.3 Write direct variable individually (W(w)SS) 
 
This function is used to directly specify the PLC device memory to be used and write it according 
to the memory data type. 

 
(1) Example of the XGT client's request frame for write individually 

Classifi
cation 

Header 
Station 

No 
Command 

Command 
type 

Number 
of block 

Variable 
size 

Variable 
name 

Data ... Tail 
Frame 
check 

Frame ENQ 20 W(w) SS 01 06 
%MW10

0 
00E2 ... EOT BCC 

Hex h05 h3230 h57(77) h5353 h3031 h3036 
h254D57
313030 

h30304532 ... h04  

 
(2) Example of XGT server's response frame 

(a) In case the ACK responds 

Classific
ation 

Header Station No Command 
Command 

type 
Tail Frame check 

Frame ACK 20 W(w) SS ETX BCC 

Hex h06 h3230 h57(77) h5353 h03  

 
(b) In case the NAK responds 

Classific
ation 

Header Station No Command 
Command 

type 

Error 
code(2 
bytes) 

Tail 
Frame 
check 

Frame NAK 20 W(w) SS 4252 ETX BCC 

Hex h15 h3230 h57(77) h5353 h34323532 h03  

 
(c) Contents of each item 

Classification Contents 

Number of 
blocks 

▶ The number of blocks consisting of variable size + variable name 
- Maximum setting:16 blocks  
- Setting range:01(Hex values:3031) ~ 10(Hex values:3130)   

Variable size 

▶ Number of characters in the variable name 
- Maximum setting:16    
- Setting range:01(Hex values:3031) ~ 10(Hex values:3130)   

Example) If the variable name is %MW0, the variable size is h04 since the number of 
characters is 4. If the variable name is %MW000, the variable size is h06 since the 
number of characters is 6. 

Variable 
name 

▶ Address of write device  
- Setting range: enter within 12 characters  
- Caution: Not allowed except for digits, upper case/lower case,  and ‘%’  

Data 

▶If the value you want to write in the %MW100 area is h A, the format of the data should be 
h000A.  

- Example) 
If the data type you want to write is word, and the data to be written is h1234, its ASCII 
code conversion value is 31323334, and this content should be contained in the data 
area. In other words, the most significant value is transmitted first, and the least 
significant value is transmitted later. 

Frame check 

▶If the command is lowercase frame, for example, w, the BCC value will be added, and if 
the command is uppercase frame, for example, W, the BCC value will not be added. 

▶If the command is lowercase frame, the value from ENQ to EOT is converted into a Hex 
value, and only lower 1 byte value in the result value of adding one byte each is added to 
BCC and judged whether the frame is normal or not. 
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Notes  
(1) The device data type of each block should be same. 

(2) If the data type is a bit, the data to be written should be represented by 1 byte in 

hexadecimal.  

       In other word, h00(3030) should be set if the bit value is 0, and h01(3031) should be set if 

the bit value is 1. 

 
(3) Example 

 
This example supposes that ‘ hFF’ is written in M0230 of station No. 1 

 
(a) XGT client's write individually request frame 

Classification Header 
Station 

No 
Command 

Command 
type 

Number of 
block 

Variable 
size 

Variable 
name 

Data Tail 
Frame 
check 

Frame ENQ 01 W(w) SS 01 06 %MW230 00FF EOT BCC 

Hex h05 h3031 h57(77) h5353 h3031 h3036 
h254D57
323330 

h30304646 h04  

 
(b) Response frame of the XGT server 

1) In case the ACK responds 

Classification Header Station No Command Command type Tail Frame check 

Frame ACK 01 W(w) SS ETX BCC 

Hex h06 h3031 h57(77) h5353 h03  

 
2) In case the NAK responds 

Classification Header Station No Command 
Command 

type 
Error code Tail Frame check 

Frame NAK 01 W(w) SS 
Error code 

(2 Byte) 
ETX BCC 

Hex h15 h3031 h57(77) h5353 
Error code 

(4 Byte) 
h03  
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7.2.4 Read direct variable individually (R(r)SS) 
 

This is the function to specify and read the PLC device according to the data type. 16 independent 
device memories can be read at a time. 

 
(1) Example of XGT client's read individually request frame 

Classific
ation 

Header 
Station 

No 
Command 

Command 
type 

Number 
of blocks 

Variable 
size 

Variable name ㆍㆍㆍ Tail 
Frame 
check 

Frame ENQ 20 R(r) SS 01 06 %MW100 ㆍㆍㆍ EOT BCC 

Hex h05 h3230 h52(72) h5353 h3031 h3036 h254D57313030 ㆍㆍㆍ h04  

 
(2) Example of XGT server's response frame 

(a) In case the ACK responds 

Classific
ation 

Header 
Station 

No 
Command 

Command 
type 

Number 
of 

blocks 

The 
number 
of data 

Data ..... Tail 
Frame 
check 

Frame ACK 20 R(r) SS 01 02 A9F3  ETX BCC 

Hex h06 h3230 h52(72) h5353 h3031 h3032 h41394633  h03  

 
(b) In case the NAK responds 

Classifi
cation 

Header Station No Command 
Command 

type 
Error code 

(2 Byte) 
Tail 

Frame 
check 

Frame NAK 20 R(r) SS 1132 ETX BCC 

Hex h15 h3230 h52(72) h5353 h31313332 h03 - 

 
(3) Contents of each item 

Classification Contents 

Number of 
blocks 

▶ The number of blocks consisting of variable size + variable name 
Maximum setting : 16 
▷ Setting range: 01(ASCII code:3031) ~ 10(ASCII code:3130)  

Variable size 

▶ The number of characters in the variable name. 
▷Maximum setting :16    

▷Setting range:01(ASCII code:3031) ~ 10(ASCII code:3130)   

▷Ex) If the name of the variable is %MW0, the number of characters is 4, so the size of 
the variable is h04, and if the name of the variable is %MW000, the number of 
characters is 6, so the size of the variable is h06. 
       

Variable name 

▶It is the address of the read device. 

▷ Setting range: Enter within 12 characters 

▷Caution: Not allowed except for digits, upper case/lower case, and ‘%’ 
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Classification Contents 

The number of 
data 

▶It means the number of bytes of Hex type and is converted into ASCII.  

▶ The number is determined by the data type(X,B,W,D,L) contained in the direct 
variable name of the external communication device request format 
▷ The number of data according to the type of variable is as follows. 

 
 
 
 
 
 

Data type Available direct variable 
The number of 

data 

Bit(X) %(P,M,L,K,F,T,C,I,Q,W,R)X 1 

Byte(B) %(P,M,L,K,F,T,C,I,Q,W,R)B 1 

Word(w) %(P,M,L,K,F,T,C,I,Q,W,R)W 2 

Double word(D) %(P,M,L,K,F,T,C,I,Q,W,R)D 4 

Long word(L) %(P,M,L,K,F,T,C,I,Q,W,R)L 8 

Data 

▶ The value obtained by converting the data of area hexadecimal into ASCII code is 
stored 
▷ Example 1) 

If the number of data is h04 (ASCII code: H3034), it is indicated that 4 bytes hex 
data exists in Data. In Data, 4 bytes hex data is saved after being converted into 
ASCII code. 

 
▷ Example 2) 

If the number of data is h04 and the value is h12345678, this value will be‘31 32 33 
34 35 36 37 38’ when it is converted into ASCII code, so‘31 32 33 34 35 36 37 38’ 
will be entered on the data area. In other words, the most significant value comes 
first, and the least significant value comes later. 

 
 
 

Notes  

• If the data type is a bit, the read data is displayed in the form of a byte. In other words, if the bit 

value is 0, h00 will be displayed, and if the bit value is 1, h01 will be displayed. 
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(4) Example 

 
This example supposes that 1 word is read from M0001 and M0020 of station No. 1, 
(At this time, assume that h1234 is in M0020 and h5678 data is in P0001.) 

 
(a) XGT client's read individually request frame 

Classifi
cation 

Header 
Station 

No 
Comma

nd 
Command 

type 
Number 
of blocks 

Variable 
size 

Variable 
name 

Variable 
size 

Variable 
name 

Tail 
Frame 
check 

Frame ENQ 01 R(r) SS 02 06 %MW020 06 %PW001 EOT BCC 

Hex h05 h3031  h52(72) h5353 h3032 h3036 
h254D57
303230 

h3036 
h2550573
0303031 

h04  

 
(b) Response frame of the XGT server 

1) In case the ACK responds 

Classif
ication 

Header 
Station 

No 
Command 

Command 
type 

Number 
of 

blocks 

The 
number 
of data 

Data 
The 

number 
of data 

Data Tail 
Frame 
check 

Frame ACK 01 R(r) SS 02 02 1234 02 5678 ETX BCC 

Hex h06 h3031 h52(72) h5353 h3032 h3032 h31323334 h3032 h35363738 h03  

 
2) In case the NAK responds 

Classification Header 
Station 

No 
Command Command type Error code Tail Frame check 

Frame NAK 01 R(r) SS Error code(2 bytes) ETX BCC 

Hex h15 h3031 h52(72) h5353 Error code(4 bytes) h03  
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7.2.5 Write direct variable continuously (W(w)SB) 
 

This is the function to write continuously as much data as the specified size, starting from the 
specified address of the device. 

 
(1) Example of XGT client's write continuously request frame 

Classification Header 
Station 

No 
Command 

Command 
type 

Variable 
size 

Variable 
name 

The number 
of data 

Data Tail 
Frame 
check 

Frame ENQ 10 W(w) SB 06 %MW100 02 11112222 EOT BCC 

Hex h05 h3130 h57(77) h5342 h3036 
h254D57
313030 

h3034 
h31313131
32323232 

h04  

 
(2) Example of XGT server response frame 

(a) In case the ACK responds 

Classification Header 
Station 

No 
Command Command type Tail Frame check 

Frame ACK 10 W(w) SB ETX BCC 

Hex h06 h3130 h57(77) h5342 h03  

 
(b) In case the NAK responds 

Classification Header 
Station 

No 
Command Command type 

Error code 
(Hex 2 bytes) 

Tail 
Frame 
check 

Frame ENQ 10 W(w) SB 1132 ETX BCC 

Hex h05 h3130 h57(77) h5342 h31313332 h03  

 
(3) Contents of each item 

Classification Contents 

Variable name 
It indicates the start address of the device where write continuously will be carried 
out.  

The number of 
data 

Specify the number of data according to the type of direct variable for Number of 
data. 
In other words, if the data type of the device is word and the number of data is 5, it 
indicates Write 5 words. The maximum number of data is 120 bytes in hex value, and 
it is 240 bytes when converted into ASCII value. 
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(4) Example 

 
This example supposes that 2 bytes of hAA15 is written in M000 of station No. 1. 

 
(a) XGT client's continuous writing request frame 

Classification Header 
Station 

No 
Command 

Command 
type 

Variable 
size 

Variable 
name 

Data  
Quantity 

Data Tail 
Frame 
Check 

Frame ENQ 01 W(w) SB 06 %DW000 01 AA15 EOT BCC 

Hex h05 h3031 h57(77) h5342 h3036 
h254457
303030 

h3031 h41413135 h04  

 
(b) Response frame of the XGT server 

1) In case the ACK responds 

Format 
name 

Header Station No Command Command type Tail 
Frame 
check 

Frame ACK 01 W(w) SB ETX BCC 

Hex h06 h3031 h57(77) h5342 h03  

 
2) In case the NAK responds 

Format 
name 

Header Station No Command 
Command 

type 
Error code Tail 

Frame 
check 

Frame NAK 01 W(w) SB Error code(2) ETX BCC 

Hex h15 h3031 h57(77) h5342 Error code(4) h03  

 
  



 

 
Chapter 7 XGT Communication 

 

7-13 

 

 

 

 

7.2.6 Read direct variable continuously  (R(r)SB) 
 

This is the function to read continuously as much data as the specified quantity, starting from the 
specified address of the PLC device. 

 
(1) Example of XGT client's read continuously request frame 

Classification Header 
Station 

No 
Command 

Command 
type 

Variable 
size 

Variable name 
Data Count 

(Max. 240 bytes) 
Tail 

Frame 
check 

Frame ENQ 10 R(r) SB 06 %MW100 05 EOT BCC 

Hex h05 h3130 h52(72) h5342 h3036 h254D57313030 h3035 h04  

 
(2) Example of XGT server response frame 

(a) In case the ACK responds 

Classification Header 
Station 

No 
Command 

Command 
type 

Number of 
blocks 

The number 
of data 

Data Tail 
Frame 
check 

Frame ACK 10 R(r) SB 01 02 1122 ETX BCC 

Hex h06 h3130 h52(72) h5342 h3031 h3032 h31313232 h03  

 
(b) In case the NAK responds 

Classification Header 
Station 

No 
Command 

Command 
type 

Error code 
(Hex 2 bytes) 

Tail Frame check 

Frame NAK 10 R(r) SB 1132 ETX BCC 

Hex h15 h3130 h52(72) h5342 h31313332 h03  

 
(3) Contents of each item 

Classification Contents 

The number of 
data 

▶It means the number of bytes of Hex type and is converted to ASCII.  

▶The number indicates the number of bytes. 

Data type Available direct variable 
The number of 

data 

Bit(X) %(P,M,L,K,F,T,C,I,Q,W,R)X 1 

Byte(B) %(P,M,L,K,F,T,C,I,Q,W,R)B 1 

Word(w) %(P,M,L,K,F,T,C,I,Q,W,R)W 2 

Double word(D) %(P,M,L,K,F,T,C,I,Q,W,R)D 4 

Long word(L) %(P,M,L,K,F,T,C,I,Q,W,R)L 8 
 

Data 

 

▶The data area contains the value obtained by converting Hex data to ASCII code 
▷ Example 1) 
If the memory type included in the name of the direct variable in the format 
requested by PC is W (word) and the number of data is 03, the number of data 
which PLC provides ACK response after the command is executed is h06 (2*03 = 
06 bytes) bytes, and 3036 which is this value converted into ASCII code will be 
entered in the data area. 
▷ Example 2) 
If the contents of data in Example 1 are 1234, 5678 and 9ABC in order, 31323334, 
35363738 and 39414243 that are these values converted into ASCII code are 
entered in the data area. 
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(4) Example 

 
This example supposes that 2 words is read from M000 of station No. 10(h0A). 
(Assume that the following data is in M000 and M001.) 

M000  = h1234  
M001  = h5678 

 
(a) XGT client's read continuously request frame 

Classification Header 
Station 

No 
Command 

Command 
type 

Variable 
size 

Variable name 
The number 

of data 
Tail 

Frame 
check 

Frame ENQ 0A R(r) SB 06 %MW000 02 EOT BCC 

Hex h05 h3041 h52(72) h5342 h3036 h254D303030 h3032 h04  

 
(b) Response frame of the XGT server 

1) In case the ACK responds 

Classification Header 
Station 

No 
Command Command type 

The number 
of data 

Data Tail 
Frame 
check 

Frame ACK 0A R(r) SB 04 12345678  ETX BCC 

Hex h06 h3041 h52(72) h5342 h3034 
h313233343

5363738 
03  

 
2) In case the NAK responds 

Classification Header 
Station 

No 
Command Command type Error code Tail BCC 

Frame NAK 0A R(r) SB Error code(2 bytes) ETX BCC 

Hex h15 h3041 h52(72) h5342 Error code(4 bytes) h03  
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7.2.7 Registration and execution monitor variables 
 

(1) Registering the monitor variable (X##) 
Up to 32 monitor variables (from No. 0 to No. 31) can be registered individually in combination with 

actual read variable command, and when the variables are registered, the registered contents can 
be executed using the monitor command. 

 
(a) Example of XGT client's monitor Variable setting frame 

Structure Header 
Station 

No 
Command 

Registration 
number 

Registration format Tail 
Frame 
check 

Frame ENQ 01 X(x) 09 
Refer to the 

registration format. 
EOT BCC 

Hex h05 h3031 h58(78) h3039 *Note 1) h04  

 
(b) Example of XGT server's monitor Variable response frame 

1) In case the ACK responds 

Structure Header 
Station 

No 
Command 

Registration 
number 

Tail Frame check 

Frame ACK 01 X(x) 09 ETX BCC 

Hex h06 h3031 h58(78) h3039 h03  

 
2) In case the NAK responds 

Structure Header 
Station 

No 
Command 

Registration 
No. 

Error code 
(Hex 2 bytes) 

Tail Frame check 

Frame NAK 01 X(x) 09 h1132 ETX BCC 

Hex h15 h3031 h58(78) h3039 h31313332 h03  

 
(c) Contents of each item 

Classification Contents 

Registration 
number 

Up to 32 numbers can be registered (0~31 , h00~h1F). If an already registered 
number is registered again, the number that is executed currently will remain 
registered. 

Registration 
format 

It is used in the commands including read device individually and read 
continuously format until EOT. 

 
 
 

Notes  

Note1) Please be sure to select one of the following registration formats for request formats. 
 

▶ Read device individually 

RSS 
Number of block 

(2 byte) 
Variable size 

(2 bytes) 
Variable name 

(16 bytes) 
... 

 
1 block(Max. 16 blocks) 

▶ Read device continuously 

RSB Variable size(2 bytes) Variable name(16 bytes)) The number of data 
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(d) Example 
This example supposes that the device M0000 of station No. 1 is registered as No. 01. 

 
1) XGT client's monitor variable registration frame 

Classification Header 
Station 

No 
Command 

Registration 
number 

Registration format Tail 
Frame 
check 

Command 
Type 

Number 
of blocks 

Variable 
size 

Variable 
name 

  

Frame ENQ 01 X(x) 01 RSS 01 06 %MW000 EOT BCC 

Hex h05 h3031 h58(78) h3031 h525353 h3031 h3036 
h25545730

3030 
h04  

 
2) Monitor Variable response frame of XGT server 

a) In case the ACK responds 

Classification Header Station No Command 
Registration 

number 
Tail Frame check 

Frame ACK 01 X(x) 01 ETX BCC 

Hex h06 h3031 h58(78) h3031 h03  

 
b) In case the NAK responds 

Classification Header Station No Command 
Registration 

number 
Error code Tail Frame check 

Frame NAK 01 X(x) 01 Error code(2) ETX BCC 

Hex h15 h3031 h58(78) h3031 Error code(4) h03  

 
(2) Monitor execution(Y##) 

Monitor execution is the function to execute reading a device that is registered as the monitor. For 
monitor execution, specify the registered number and execute Read registered device with such 
number. 

 
(a) Example of XGT client's monitor execution frame 

Classification Header Station No Command 
Registration 

number 
Tail 

Frame 
check 

Frame ENQ 10 Y(y) 09 EOT BCC 

Hex h05 h3130 h59(79) h3039 h03  

 
(b) Example of XGT server's monitor execution response frame 

1) In case the ACK responds 
a) If the registered format of the registration number is read device individually 

Classification Header 
Station 

No 
Command 

Registration 
number 

Number 
of blocks 

The number 
of data 

Data Tail 
Frame 
check 

Frame ACK 10 Y(y) 09 01 02 9183 ETX BCC 

Hex h06 h3130 h59(79) h3039 h3031 h3032 h39313833 h03  
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b) If the registered format of the registration number is read direct variable continuously 

Classification Header 
Station 

No 
Command 

Registration 
number 

The number 
of data 

Data Tail 
Frame 
check 

Frame ACK 10 Y(y) 09 04 9183AABB ETX BCC 

Hex h06 h3130 h59(79) h3039 h3034 
h39313833
41414242 

h03  

 
2) In case the NAK responds 

Classification Header Station No Command 
Registration 

number 
Error code 

(Hex 2 bytes) 
Tail 

Frame 
check 

Frame NAK 10 Y(y) 09 1132 ETX BCC 

Hex h15 h3130 h59(79) h3039 h31313332 h03  

 
(c) Example 

This example supposes that the reading of device registered as registration No. 1 in station No.1. 
Assume that one block is registered as device M000. 

 
1) Monitor execution frame of XGT client 

Classification Header Station No Command 
Registration 

number 
Tail Frame check 

Frame ENQ 01 Y(y) 01 EOT BCC 

Hex h05 h3031 h59(79) h3031 h04  

 
2) Monitor execution response frame of XGT server 

a) In case the ACK responds 

Classification Header 
Station 

No 
Command 

Registration 
number 

Number 
of blocks 

The number 
of data 

Data Tail 
Frame 
check 

Frame ACK 01 Y(y) 01 01 02 2342 ETX BCC 

Hex h06 h3031 h59(79) h3031 h3031 h3032 h32333432 h03  

 
b) In case the NAK responds 

Classification Header Station No Command 
Registration 

number 
Error code Tail 

Frame 
check 

Frame NAK 01 Y(y) 01 
Error 

code(2) 
ETX BCC 

Hex h15 h3031 h59(79) h3031 
Error 

code(4) 
h03  

 
  



 

 
Chapter 7 XGT Communication 

 

7-18 

 

 

 

 

7.2.8 Error Code 
 

When the XGT client transmits the request frame to the server, the server analyzes the 
received request frame, and if the frame is normal, the server transmits the ACK response 
frame, and if the frame is abnormal, the server transmits the NAK frame with the error code 
attached. At this time, the error code included in the NAK response is as follows. The error 
code is Hex 2 bytes and it indicates the error. The error which occurred can be checked 
through the frame monitor, and you can see the contents displayed as ASCII code as shown in 
the table below. 
 

Error code Type of error Contents and cause of error 
Example of frame with an 

error 

0003 
Block number 
excess error 

If the number of blocks is larger than 16 
when read/write individually is requested 

01rSS1105%MW10… 

0004 Variable size error 
If the variable size is higher than 12 
which is the maximum size 

01rSS010D%MW100000000
00.. 

0007 Data type error 
If the data type other than X, B, W, D 
and L has been received 

01rSS0105%MK10 

0011 Data error 

If data size area information is incorrect 01rSB05%MW10%4 

If not starting with % 01rSS0105$MW10 

If the area value of the variable is 
incorrect 

01rSS0105%MW^& 

In the case of bit writing, 00 or 01 should 
be written, but other values are written 

01wSS0105%MX1011 

0090 
Monitor execution 
error 

If the execution of a monitor which is not 
registered is requested 

 

0190 
Monitor execution 
error 

If the range of the registration numbers 
has been exceeded 

 

0290 
Monitor registration 
error 

If the range of the registration numbers 
has been exceeded 

 

1132 
Device memory 
error 

If a device which is not a device in use 
is entered 

 

1232 Data size error 
Up to 60 words can be read or written at 
a time, but in case more than 60 words 
are requested 

01wSB05%MW1040AA5512,
.. 

1234 Spare frame error If unnecessary additional content exists. 01rSS0105%MW10000 

1332 
Data type 
mismatch error 

In the case of read/write individually, the 
same data type should be requested for 
all blocks, but in case a different data 
type is requested 

01rSS0205%MW1005%MB1
0 

1432 Data value error 
 If the data value cannot be converted 
to Hex value 

01wSS0105%MW10AA%5 

7132 
Variable request 
area excess error 

It is required beyond the area supported 
by each device. 

01rSS0108%MWFFFFF 
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7.3 XGT Communication Function 
 

7.3.1 Overview 
 

 The XGT communication operates as either XGT server or P2P service depending on what is set 
for the operation mode of the Cnet I/F module. XG5000 is set for each mode. 

 
(1) XGT server 

(a) It allows you to read or write PLC information or data from/to PC or peripheral equipment without 
writing a separate program in PLC. 

(b) XGT client responds to the request frame. 
 

(2) P2P service 
(a) This service makes the Cnet I/F module operate as the client in the network. 
(b) If a predefined event occurs, it is possible to read or write the memory of the destination station. 
(c) Up to 64 P2P blocks that operate independently can be defined for each P2P service. 

 
(3) Loader service 

You can monitor PLC at a remote distance or download the program using the remote 1-stage or 2-
stage connection. 
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7.3.2 Setting parameters in case of using as the XGT server 
 

(1) Connection setting 
(a) Select [Online]→[Connection setting]. 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 
 

(3) Standard settings 
(a) Open the [Basic setting] window by double clicking the relevant Cnet I/F module, and set the 

communication type, communication speed, modem type, data bit, stop bit and station address 
from the connection setting menu. 

(b) The modem can be initialized only when the modem type is the dial-up modem. It cannot be 
applied in case of null modem. 

(c) The delay time can be set only when the communication type is RS422 or RS485, and the 
response waiting time can be set only when the communication type is RS422 or RS485 and the 
operation mode is P2P. 

(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 
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(4) Select operation mode 

Select XGT server. 
 

(5) Writing parameter 
(a) Select [Online]→[Write]. 
(b) Put a check mark on the module whose basic setting is completed from [Standard setting] and click 

[OK]. 
(c) Reset the module. 

 

 
 
 

(6) Check operation 
(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) Click [Frame monitor] or [Status by service] and check operation status. 
(d) For detailed contents regarding the status by service, refer to '2.1 Diagnosis function of XG5000. 
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7.3.3 Setting parameters in case of using as the XGT client 
 

(1) P2P parameter configuration 
In order to use the P2P service, necessary contents for operation should be set in the P2P 
parameter window. As shown in the figure below, the P2P parameter consists of three pieces of 
information. 
 

 
 

 
(a) P2P channel 

1) Define a communication protocol for carrying out the P2P service. 
2) XGT client, Modbus ASCII client, Modbus RTU client, LS bus client, user frame definition 

communication 
3) Set the parameter for each channel independently. (It applies only when ’Use P2P’ is selected 

for the operation mode in the [Standard setting] window) 
 

(b) P2P block 
Set 64 P2P blocks that operate independently. 

 
(c) User frame definition 

Register a parameter for the user frame definition communication. 
 

(2) P2P channel setting 
The Cnet I/F module provides two communication channels that operate independently, and the 

driver type for carrying out the P2P service can be defined for each channel. However, in order for 
the P2P channel to operate as the client,’ Use P2P‘ should be selected for the operation mode in 
the [Standard setting] window. The P2P channel setting according to the operation mode is as 
follows. 
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(a) Operation mode 

 
 

     
 

The drivers that can be selected when’ Use P2P‘ is selected for the operation mode are 
as follows. 

Driver Usage 

User frame definition 
It is used when it sends/receives the desired user frame 
definition. 

XGT client It is used for reading or writing XGT CPU memory. 

LS bus client 
It is used for the dedicated communication with the LS 
inverter. 

Modbus ASCII client 
It is used for operating as the Modbus client and used as the 
ASCII mode. 

Modbus RTU client 
It is used for operating as the Modbus client and used as the 
RTU mode. 

 
 

When the XGT or Modbus is selected for the P2P driver, the user defined frame cannot be used. 
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(3) P2P block setting 

When the P2P block of the relevant parameter is selected in the [P2P Channel setting] window, the 
[P2P block setting] window will be displayed. The block setting window for all protocols is as shown 
in the figure below, and a different area which is enabled according to the protocol selected from 
P2P channel is displayed. 
 

P2P driver P2P block setting 

 
 

 
 

 
 

 
 

  

 
(4) Parameter setting method 

The XGT client is classified into the operation to read data from any area of the opposing device 
using the Read command and the operation to write data on any area of the opposing device using 
the Write command. The setting method is as follows. 

 
(a) Setting the basic parameter 

1) Connection setting 
a) Select [Online]→[Connection setting]. 
b) Set connection options for your environment and click Connect. 

 

 
 

2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and 
read the information from the module currently installed on the base. 
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3) Standard settings 
a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, 

and set the communication type, communication speed, modem type, data bit, stop bit 
and station address from the connection setting menu. 

b) The modem can be initialized only when the modem type is the dial-up modem. It cannot 
be applied in case of null modem. 

c) The delay time can be set only when the communication type is RS422 or RS485, and 
the response waiting time can be set only when the communication type is RS422 or 
RS485 and the operation mode is P2P. 

d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F 
module. 
 

   
 

4) Operation mode 
 ‘Select’ Use P2P'. 

 
a) Setting the P2P parameter 
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No. Type Block type Content 

1 Channel 

 

The name of the setting driver changes according to the driver 
set in the P2P driver. 

2 
P2P 

function 
 

1.Read: It is used for reading any data from the destination 
station. 
2.Write: It is used for writing any data on the destination station. 

3 
Start 

condition  

1.Enter special flag or bit contact to select the time when data is 
transmitted and received 

2.Example in case of XGK type: F90 (Operates in 20ms 
intervals), M01  
3.Example in case of XGI type: _T 20MS (Operates in 20ms 
intervals), % MX01 

4 
Command 

type 
 

1.Individual: It is used for reading or writing data up to 4 memory 
areas. (Ex: M01, M10, M20, M30) 

2.Continuous: It is used for reading or writing data 
continuously.(Example : M01~M10) 

5 Data type 

 

1. If individual is selected for the type: Data types are divided into 
five types: bit, 1 byte, 2 byte, 4 byte and 8 byte. 

2. If continuous is selected for the type: Data types are divided 
into four types: 1 byte, 2 byte, 4 byte and 8 byte 

6 
No. of 

variables 

 

1. This function is enabled only when the individual mode is 
selected, and the number of data to be transmitted and 
received is selected. However, the maximum number of 
permitted data is 4. 

2. If continuous mode is selected, it is fixed to 1. 

7 Data size 
 

This function is enabled only when Continuous is selected for 
Type, and up to 120 bytes can be set based on 1 byte for the 
data type. 

8 
Destination 

station  

1. If checked: Specifies as the destination station. 
2. If not checked :The P2P SN command is specified as the 

destination station of the P2P SN specified previously.  

9 
Destination 

station 
number  

It means the station address of the destination station, and the 
setting range is 0 to 31 stations, and up to 32 stations 

10 Setting 

 

1. If the P2P function is Read 
(1) Read area: Device area where data of the destination station 
(server) is saved 

(2) Storage area: Device area of the self-station (client) where 

data read from the destination station will be saved 
If the 2.P2P function is Write 
(1) Read area: Device area where data of the self-station is 
saved 
(2) Storage area: Device area of the destination station where 

data of the self-station will be saved 

 
(b) Writing parameter 

1) Select [Online]→[Write]. 
2) Put a check mark on basic setting and P2P (✓) for the module set as the XGT client and click 

the [OK] button. 
3) Click the [OK] button, and after writing the parameter, reset the relevant module. 
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(c) Link enable 
1) Select [Online]→[Communication module setting and Diagnosis]→[Link enable]. 
2) Put a check mark on the P2P block you wish to use and click[Write]. 

 

 
 

(d) Check operation 
1) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
2) Click the relevant module and click the right mouse button.  
3) Click [Frame monitor] or [Status by service] and check operation status. 
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7.3.4 Frame Monitor 
 

When you use the frame monitoring function provided by the XG5000, you can check a frame 
which is actually exchanged by the client and the server. 

 
(1) Check operation 

(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the screen as shown below appears, click [Frame monitor]. 

 

 
 

(2) Frame monitor 
(a) Select a channel you wish to monitor. 
(b) Select View as ASCII since the XGT protocol is ASCII communication. 
(c) Click [Start] to check the sending / receiving frame. 
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7.3.5 Parameter Setting Case 
 

(1) Setting example in case of using as the XGT client 
This is an example that data in the P0200 address of the XGT server is read and the frame where 1 

word is saved on the M200 address of the self-station PLC as the P2P parameter of XG5000 when the 
M00001 contact point becomes On. You can check using the XG5000 whether data has been 
transmitted normally or not. 
 Analyze and check the response frame on the server side through the frame monitor of the XG5000. 
 Execute [monitor] → [device monitor] and check if data is saved on the area which is set to save data. 

 
(a) Parameter setting detail 

 

 
 

(b) Variable setting detail 
 

 
 

(c) Frame monitor result 

 
 

(d) Device monitor 
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7.4 Remote Connection 
 

7.4.1 Overview 
 

If the PLC is remote, you can carry out program download, upload, program debugging and 
monitoring remotely by using the remote connection function of the Cnet I/F module. You can 
access PLC wherever it is by using the Cnet I/F module and the XG5000 effectively. The remote 
connection function can be used in a system where PLCs are connected using the Cnet I/F 
module and a system where the XG5000 and PLC are connected through the modem. For the 
remote connection through the modem, refer to‘7.5 Modem communication’. 

 

7.4.2 Restrictions in case of remote connection between Cnet I/F modules 
 
There are several restrictions if the remote connection function is used in a system where PLCs 
are connected using the Cnet I/F module as shown in the figure below. 

 
(1) RS-232C and RS-422 should be set for the communication type.Note 1)  
(2) The maximum number of stages in case of remote connection is 2 stages. 
(3) The basic setting between the Cnet I/F modules that use the remote connection should be the same. 
(4) In case of XGR, the remote connection is available only when the station address of the extension 

driver module is set between No. 1 and No. 15. 
(5) Two channels of the Cnet I/F module cannot be used as remote connection channels at the same time. 

 

 
 

 

Notes  

Note 1) The remote connection between the Cnet I/F modules can be used only when the O/S version of 

the Cnet I/F module is V2.5 or higher. The characteristics related to the remote connection are as 

follows. 

(1) Only RS-232C and RS-422 types are supported for the communication type. However, if the 

remote connection using RS-485 is carried out, it is possible only when a check mark from P2P 

enable in [Online]→[Communication module setting and Diagnosis]→[Enable Link/Services] menu 

of the XG5000 is removed. 

(2) The remote connection is supported regardless of operation mode.  

(3) The remote connection during communication is affected by the transmission and reception cycle 

and the amount of data. If the transmission and reception cycle is short, or the amount of data is 

excessive, disconnection may occur. 
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7.4.3 Remote 1-stage connection 
 

Remote 1-stage connection refer to the connection to PLC2 station in case of a system configured 
as shown in the figure in Paragraph 7.4.2, and the connection method is as follows. 

 
(1) Click Connection setting and select Remote 1-stage for the connection stage. 

 

 
 

(2) General 
(a) Timeout time in case communication failed: It indicates the time taken until the timeout process 

when there is no response from the PLC even though the connection to PLC has been attempted. 
(b) Retry count in case communication failed: It indicates the number of communication attempts when 

communication fails. 
 

(3) Connection option setting 
(a) When you click [View], the following screen will be displayed.  
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(b) Click [Setting] and set the detailed information of the RS-232C and the remote 1-stage. 
 

       
 

(c) Detail setting of RS-232C 
1) Communication port: Indicates the communication port of the computer where XG5000 is 

installed. 
2) Communication speed: 38,400 bps and 115,200 bps are supported for the communication speed. 

 
(d) Detail setting of remote 1-stage 

1) Network type: Indicates the communication means remote connection and select Cnet.  
2) Local communication module: Select the installation position of the Cnet I/F module operating as 

local and the channel to be used. 
3) Remote 1-stage communication module: Select the station address of the Cnet I/F module that 

carries out the remote connection. 
 

(4) When you set detailed items and click [Connect], connection to the PLC 2 station will be made. 
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7.4.4 Remote 2-stage connection 
 
Remote 2-stage connection refers to the connection to PLC3 station in case of a system 
configured as shown in the figure in Paragraph 7.4.2, and the connection method is as follows. 

 
(1) Click Connection setting and select Remote 2-stage for the connection stage. 

 

 
 

(2)  When you click [View], the following screen will be displayed. 

 

(3) Click [Setting] and set the detailed information of the remote 1-stage and remote 2-stage. 
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(a) Detail setting of remote 1-stage 

1) Network type: Indicates the communication module for remote connection. Select XGT Cnet.  
2) Local communication module: Select the installation position of the Cnet I/F module operating as 

local and the channel to be used. 
3) Remote 1-stage communication module: Select the station address of the Cnet I/F module that 

carries out the remote connection. 
 

(b) Detail setting of remote 2-stage 
1) Network type: Indicates the communication module for remote connection and select Cnet.  
2) Remote 1-stage communication module: Select the installation position of the Cnet I/F module 

set as the remote 1-stage and the channel to be used. 
3) Remote 2-stage communication module: Select the station address of the Cnet I/F module that 

carries out the remote connection. 
 

(4) When you set detailed items and click [Connect], connection to the PLC 3 station will be made. 
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7.5 Modem communication 
 

7.5.1 Overview of Modem communication 
 

The Cnet I/F module has a restriction in the transmission distance according to each 
communication type. (RS-232C: 15m, RS 422/485: A type 500m, B type 1,200m).  However, you 
can control a PLC at great distance by using the modem. 

 

7.5. 2 Remote connection through the modem 
 

The following figure shows a case of the remote connection system where the XG5000 and 
the PLC are connected through the modem. This is the configuration necessary for connecting 
the computer where XG5000 is installed and the PLC using the telephone line, dedicated line 
modem or wireless modem. In case of using in this way, the Cnet I/F module should be 
connected through the modem and the modem should be set for the connection method in the 
connection option.  

There are two connection methods using the modem, including the dedicated modem 
connection that uses the dedicated line, and the dial-up modem connection using the public 
network. 

 
(1) Connection method through the modem 

The following figure shows the case of configuration using the dial-up modem. The dial-up 
modem connection is the connection method to connect the PC and the Cnet I/F module by 
connecting them to the dial-up modem, and the dialing function and hang up functions are 
supported. This method establishes remote connecting using the dialing function of the XG5000, 
and the modem connected to the PC uses the external or internal dial-up modem and the 
modem connected to the Cnet I/F module uses the external modem. 

 

 
 
 

 
  



 

 
Chapter 7 XGT Communication 

 

7-36 

 

 

 

 
The connection method using the modem is as follows. 

 
(a) Set XGT server for the operation mode of the RS-232C channel in the Cnet I/F module. 

 

       
 

1) Modem type 
a) Dial-up modem : It is selected if the public telephone network is used. 
b) Dedicated modem: It is selected in case of 1:1 connection to the modem using the dedicated 

line. 
 

2) Modem initialization 
Enter the command to initialize the modem. The modem initialization command varies by 
manufacturer. Enter it by referring to the relevant user's manual. 

 
(b) Set dial-up modem for RS-232C channel operation and enter the modem initialization command.  
(c) Executing XG5000 and select [Online] → [Connection setting]. Here, set modem for 

[Type ]→[Depth]. 
 

 
 
  



 

 
Chapter 7 XGT Communication 

 

7-37 

 

 

 

(d) Select the [Setting] button and set the modem-related detailed information. 
 

       
 

1) Modem 
a) Dial up: It is selected if the public telephone network is used. 
b) Dedicated: It is selected in case of 1:1 connection to the modem using the dedicated line. 

 
2) Modem setting 

a) Port number: It indicates the communication port of the modem that is used. 
b) Transmission speed: It indicates the transmission speed of the modem. 
c) Telephone No.: The telephone number of the modem connected to the Cnet I/F module is 

entered, and in the case of moving from the local to the outside using an extension, the 
extension number and‘,’ symbol can be used. 

Example) If the extension number is‘9’: Set 9, 0343-398-xxxx 
 

Notes  

• In the case where the modem connected to the Cnet I/F module which is specified as the 

destination station is via local exchange, communication is impossible. In other words, if 

there is a separate extension number on the reception station, the dial-up modem 

communication cannot be used. 

 
d) Station address: It indicates the station address of the destination station. 

e) If the remote 2-stage is selected for the connection step, select the base and slot number of 
the remote 1-stage communication module from the detailed items as shown in the figure 
below, and set the communication module station address of remote 2-stage. For the station 
address, enter the station address set for the Cnet I/F module. In case of Cnet channel, 
select the communication channel of remote 2-stage. 
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[Modem remote 2-stage setting screen] 

 
f) When you select the connection from Online after setting the connection option, the modem 

initialization dialog box will be displayed, initializing the modem. 
 

 
[Telephone connect screen] 

 
g) If the port number of the modem is set incorrectly, or the connection to the modem is not 

made correctly, the following error message will be displayed. At this time, check the port 
number or modem connection. 
 

 
[Screen for telephone connection error] 

 
h) When dialing is completed, the XG5000 attempts remote connection automatically. When the 

remote connection is made, Write program and Run Stop icon menu will be enabled. 
i) The remote 1-stage connection is made, becoming the status just as removing and 

connecting the RS-232C cable. Now, all functions of the online menu can be used. 
j) When you terminate the remote connection status, select Disconnect from the online menu. 
k) When the connection is terminated, the XG5000 hangs up the phone automatically, 

terminating the telephone connection. 
l)  When hanging up is completed normally, the local modem and remote modem will return to 

the initial state. Therefore, you can establish remote connection by dialing. 
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Notes  
(1) The transmission speed set from the connection option is not the communication speed of the 

modem, but the communication speed between the PC and the modem. The communication 

speed of the modem refers to the communication speed between modems, and it is set 

automatically according to the call quality of the public network line and the speed of the 

destination station modem. 

(2) When you establish remote connection using the XG5000, you need to use the RS-232C 

channel, so use the channel after setting‘RS-232C dial-up modem’ from the standard settings 

f the XG5000, writing it on Cnet I/F module and resetting the module.  

(3) When the remote connection is made, the XG5000 operates in the same way with the local 

connection, so all online functions including download/upload program and monitor can be 

used. The system that controls the PLC using the modem is significantly affected by the 

modem performance and telephone line status, so if the telephone line status is poor, the 

connection may be terminated. At this time, do no attempt reconnection immediately, wait 30 

seconds and carry out the procedure again from the beginning. 
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7.5. 3 Communication procedure between PLC and dial-up modem 
 
The Communication procedure between the PLC (PC) and the dial-up modem is as shown in the 
figure below. 
 

 
 

 

Notes  
      

• Dial up modem initialization command may vary by modem manufacturer. Check the relevant 

user's manual. 
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7.6 Communication commands 
 

7.6.1 XGK commands 
 

(1) P2PSN 

Command 

Available area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons
tant 

U N D R 
Error 

(F110) 
Zero 

(F111) 
Carry 
(F112) 

P2PSN 

N1 O - O O O - O - - O O O O O 

4~6 O - - N2 O - O O O - O - - O O O O O 

N3 O - O O O - O - - O O O O O 

 
(a) Area setting 

Operand Description Data size 

N1 P2P number ( 1 ~ 8 ) WORD 

N2 Block number ( 0 ~ 63 ) WORD 

N3 Station No.( 0 ~ 63 ) WORD 

 
(b) Flag Set 

Flag Content 
Device 
number 

Error  If the value of N1, N2 and N3 goes outside the relevant range F110 

 
(c) Function 

1) You can change the station address of the P2P opponent during run using the P2PSN command. 
2) Change No. N2 block remote station address of No. N1 P2P to N3. 
3) Relevant communication module: FDEnet, Cnet 

 
(d) Error  

If the value of N1(1~8), N2(0~63) and N3(0~63) goes outside the relevant range, set the 
error flag (F110). 

 
(e) Program example 

 

P00000

P2PSN   P1000   P1100   P1200

 
  

 

 
 

  P2PSN
COMMAND

P2PSN N1 N3N2
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(2) P2PWRD 

Command 

Available area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Const

ant 
U N D R 

Error 
(F110) 

Zero 
(F111) 

Carry 
(F112) 

P2PWRD 

N1 O - O O O - O - - O O O O O 

4~6 O - - 

N2 O - O O O - O - - O O O O O 

N3 O - O O O - O - - O O O O O 

N4 O - O O O - O - - O O O O O 

N5 O - O O O - O - - - O O O O 

 
(a) Area setting 

Operand Description Data size 

N1 P2P number ( 1 ~ 8 ) WORD 

N2 Block number ( 0 ~ 63 ) WORD 

N3 Variable number ( 1 ~ 4 ) WORD 

N4 Variable size [n byte]( 0 ~ 1400 ) WORD 

N5 Device WORD 

 
(b) Flag Set 

Flag Content 
Device 
number 

Error  If the value of N1, N2, N3 and N4 goes outside the relevant range F110 

 
(c) Function 

1) P2PWRD command changes the variable size and word READ device area of the relevant 
P2P parameter block. 

2) Specify the relevant P2P parameter, block and variable using N1, N2 and N3, and change 
the variable size and device to N4 and N5 respectively. 

3) Relevant communication module: FEnet, FDEnet, Cnet  
 

(d) Error  
 If the value of N1(1~8), N2(0~63), N3(1~4) and N4(0~1400) goes outside the relevant 
range, set the error flag (F110). 

 
(e) Program example 

P00000

P2PWRD   P1000   P1100   P1200   P1300   P1400

 
 
 
 

Notes  
(1) In case of separate command, a value between 1 and 4 is used for the variable number (N3) 

and the size of valuable (N4) does not apply. 
(2) In case of continuous command, 1 is always used for the variable number (N3) and the size of 

variable (N4) applies. 
(3) The size of variable (N4) is used in byte. 

 
  

 

 
 

N1 N3N2 N4P2PWRD  P2PWRD
COMMAND

N5
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(3) P2PWWR 

Command 

Available area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Const

ant 
U N D R 

Error 
(F110) 

Zero 
(F111) 

Carry 
(F112) 

P2PWWR 

N1 O - O O O - O - - O O O O O 

4~6 O - - 

N2 O - O O O - O - - O O O O O 

N3 O - O O O - O - - O O O O O 

N4 O - O O O - O - - O O O O O 

N5 O - O O O - O - -  O O O O 

 
(a) Area setting 

Operand Description Data size 

N1 P2P number ( 1 ~ 8 ) WORD 

N2 Block number ( 0 ~ 63 ) WORD 

N3 Variable number ( 1 ~ 4 ) WORD 

N4 Variable size ( 0 ~ 1400 ) WORD 

N5 Device WORD 

 
(b) Flag Set 

Flag Content 
Device 
number 

Error  If the value of N1, N2, N3 and N4 goes outside the relevant range F110 

 
(c) Function 

1) P2PWWR command changes the variable size and word WRITE device area of the 
relevant P2P parameter block. 

2) Specify the relevant P2P parameter, block and variable using N1, N2 and N3, and change 
the variable size and device to N4 and N5 respectively. 

3) Relevant communication module: FEnet, FDEnet, Cnet  
 

(d) Error  
If the value of N1(1~8), N2(0~63), N3(1~4) and N4(0~1400) goes outside the relevant 
range, set the error flag (F110). 

 
(e) Program example 

P00000

P2PWWR  P1000   P1100   P1200   P1300   P1400

 
 

 

Notes  
(1) In case of separate command, a value between 1 and 4 is used for the variable number (N3) 

and the size of valuable (N4) does not apply. 
(2) In case of continuous command, 1 is always used for the variable number (N3) and the size of 

variable (N4) applies. 
(3) The size of variable (N4) is used in byte. 

 

  

 

 
 

N1 N3N2 N4P2PWWR  P2PWWR
COMMAND

N5
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(4) P2PBRD 

Command 

Available area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Const

ant 
U N D R 

Error 
(F110) 

Zero 
(F111) 

Carry 
(F112) 

P2PBRD 

N1 O - O O O - O - - O O O O O 

4~6 O - - 

N2 O - O O O - O - - O O O O O 

N3 O - O O O - O - - O O O O O 

N4 O - O O O - O - - O O O O O 

N5 O - O O O - - O O - O - - - 

 
(a) Area setting 

Operand Description Data size 

N1 P2P number ( 1 ~ 8 ) WORD 

N2 Block number ( 0 ~ 63 ) WORD 

N3 Variable number ( 1 ~ 4 ) WORD 

N4 Variable size ( 0 ~ 2000 ) WORD 

N5 Device WORD 

 
(b) Flag Set 

Flag Content 
Device 
number 

Error  If the value of N1, N2, N3 and N4 goes outside the relevant range F110 

 
(c) Function 

1) P2PBRD command changes the variable size and bit READ device area of the relevant P2P 
parameter block. 

2) Specify the relevant P2P parameter, block and variable using N1, N2 and N3, and change 
the variable size and device to N4 and N5 respectively. 

3) Relevant communication module: FEnet, FDEnet, Cnet  
 

(d) Error  
If the value of N1(1~8), N2(0~63), N3(1~4) and N4(0~1400) goes outside the relevant range, 
set the error flag (F110). 
 

(e) Program example 

P00000

P2PBRD  P1000   P1100   P1200   P1300   P1400

 
 
 

Notes  
(1) In case of separate command, a value between 1 and 4 is used for the variable number (N3) 

and the size of valuable (N4) does not apply. 
(2) In case of continuous command, 1 is always used for the variable number (N3) and the size of 

variable (N4) applies. 
(3) The size of variable (N4) is used in byte. 

 
  

 

 
 

N1 N3N2 N4P2PBRD  P2PBRD
COMMAND

N5
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(5) P2PBWR 

Command 

Available area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Const

ant 
U N D R 

Error 
(F110) 

Zero 
(F111) 

Carry 
(F112) 

P2PBWR 

N1 O - O O O - O - - O O O O O 

4~6 O - - 

N2 O - O O O - O - - O O O O O 

N3 O - O O O - O - - O O O O O 

N4 O - O O O - O - - O O O O O 

N5 O - O O O - - O O - O - - - 

 
(a) Area setting 

Operand Description Data size 

N1 P2P number ( 1 ~ 8 ) WORD 

N2 Block number ( 0 ~ 63 ) WORD 

N3 Variable number ( 1 ~ 4 ) WORD 

N4 Variable size ( 0 ~ 2000 ) WORD 

N5 Device WORD 

 
(b) Flag Set 

Flag Content 
Device 
number 

Error  If the value of N1, N2, N3 and N4 goes outside the relevant range F110 

 
(c) Function 

1) P2PBWR command changes the variable size and bit WRITE device area of the relevant P2P 
parameter block. 

2) Specify the relevant P2P parameter, block and variable using N1, N2 and N3, and change the 
variable size and device to N4 and N5 respectively. 

3) Relevant communication module: FEnet, FDEnet, Cnet  
 

(d) Error  
If the value of N1(1~8), N2(0~63), N3(1~4) and N4(0~1400) goes outside the relevant 
range, set the error flag (F110). 

 
(e) Program example 

P00000

P2PBWR  P1000   P1100   P1200   P1300   P1400

 
 
 

Notes  
(1) In case of separate command, a value between 1 and 4 is used for the variable number (N3) 

and the size of valuable (N4) does not apply. 

(2) In case of continuous command, 1 is always used for the variable number (N3) and the size of 

variable (N4) applies. 

(3) The size of variable (N4) is used in byte. 

 

  

 

 
 

N1 N3N2 N4P2PBWR  P2PBWR
COMMAND

N5
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7.6.2 XGI commands 
 

(1) P2PSN 

 Function block Description 

P2PSN

STAT

BL_NUM

P_NUM

DONEREQ

NUMUSINT

USINT

USINT

BOOL

BOOL

BOOL

 

 
Input    REQ       : Request the execution of 
function block 

P_NUM     : P2P No. 
BL_NUM    : Block No. 
NUM       : Station No. 

 
Output    DONE      : Maintain 1(on) after initial 
operation 

 STAT      : Complete and ERR information 
 

 
(a) Function 

1) You can change the station address of the P2P opponent during run using the P2PSN command. 
2) Change the remote station address of No. BL_NUM block in No. P_NUM P2P to NUM. 
3) Relevant communication module: FDEnet, Cnet. 

 
(b) Error   

It indicates the relevant error number on STAT when an error occurs. 

STAT_NUM Contents Detailed description 

1 P2P number setting 
It occurs when a value other than 
P_NUM(1~8) is set 

2 Block number setting 
It occurs when a value other than 
BL_NUM(0~63) is set 

4 Slot does not exist. - 

5 Module mismatch It is not the communication module. 

6 Module mismatch 
Communication module which cannot 
be used for the relevant command 

7 
Station number setting 
error 

It occurs when a value other than 
NUM(0~63) is set. 
However, (0~31) in the case of Cnet. 
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(2) P2PRD 

Function block Description 

P2PRD

STAT

BL_NUM

P_NUM

DONEREQ

VAL_NUMUSINT

USINT

USINT

BOOL

USINT

BOOL

VAL_SIZE

DEV

USINT

ANY_BIT

 

 
 
Input    REQ        : Request the execution of  

function block 
         P_NUM     : P2P No. 
        BL_NUM    : Block No. 
   VAL_NUM   : Variable number 
       VAL_SIZE   : Variable size 
        DEV        : Device(Only a direct valuable  

can be entered) 
   
Output  DONE       : Maintain 1(on) after initial  

operation 
    STAT        : Complete and ERR information 

  

 

ANY type  
Description 

of variable 

Variable 
name B

O
O

L
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Y

T
E
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O

R
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R
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S
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D
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DEV ○ ○ ○ ○ ○                

 
(a) Function 

1) P2PRD command changes the variable size and READ device area of the relevant P2P 
parameter block. (Both individual and continuous read can be changed.) 

2) Specify the relevant P2P parameter, block and variable Using the P_NUM, BL_NUM and 
VAL_NUM and change the variable size and device to VAL_SIZE (In case of continuous, 
VAL_SIZE means variable size and it is the size by variable type in case of individual) and DEV 
respectively. Here, only variable can be entered for DEV. (Ex, %MW100)  

3) Relevant communication module: FEnet, FDEnet, Cnet. 
 

(b) Error 
 If contents that out of the permissible range of the P2P parameters set from the XG5000 are 
set, the relevant error number appears. 

STAT_NUM Contents Detailed description 

1 
P2P number setting 
error  

It occurs when a value other than P_NUM(1~8) is set 

2 
Block number 
setting error 

It occurs when a value other than BL_NUM(0~63) is 
set 

3 
Variable number 
setting error 

It occurs when a variable number which is not 
permitted in the P2P parameters set in XG5000 is 
entered. 

4 Slot does not exist - 

5 Module mismatch It is not the communication module. 

6 Module mismatch Communication module which cannot be used for the 
relevant command 

10 
Modbus setting 
error 

The Modbus offset cannot be entered (example, 
0x10000) because only a direct variable can be 
entered for DEV. 

11 
Variable size setting 
error 

It occurs when the size of a variable which is not 
permitted for the P2P parameter set in XG5000 is 
entered. 

12 
Data type setting 
error 

It occurs when a variable type which is not permitted in 
the P2P parameter set in XG5000 is entered. 
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(3) P2PWR 

Function block Description 

P2PWR

STAT

BL_NUM

P_NUM

DONEREQ

VAL_NUMUSINT

USINT

USINT

BOOL

USINT

BOOL

VAL_SIZE

DEV

USINT

ANY_BIT

 

 
Input    REQ       : Request the execution of 

function block 
         P_NUM    : P2P No. 
        BL_NUM   : Block No. 
   VAL_NUM  : Variable number 
       VAL_SIZE  : Variable size 
        DEV       : Device(Only a direct valuable 
                     can be entered) 
   
Output   DONE     : Maintain 1(on) after initial  

operation 
STAT     : Complete and ERR information 

  

 

ANY type  
Descripti
on of 
variable 

Variabl
e 

name B
O

O
L
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Y

T
E

 

W
O

R
D
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DEV ○ ○ ○ ○ ○                

 
(a) Function 

1) The P2PRD command changes the variable size and WRITE device area of the relevant P2P 
parameter block. (Both read individually/continuously can be changed.) 

2) The P_NUM, BL_NUM and VAL_NUM are used to specify the P2P parameters, blocks and 
variables and change the variable size and device to VAL_SIZE(In the case of continuous 
writing, VAL_SIZE means variable size, and it is the size of variable type in the case of 
individual writing) and DEV, respectively. Here, only variable can be entered for DEV. 
(Ex, %MW100) 

3) Relevant communication module: FEnet, FDEnet, Cnet. 
 

(b) Error 
 If contents that out of the permissible range of the P2P parameters set from the XG5000 are 
set, the relevant error number appears. 

STAT_NUM Contents Detailed description 

1 
P2P number 
setting error  

It occurs when a value other than P_NUM(1~8) is set 

2 
Block number 
setting error 

It occurs when a value other than BL_NUM(0~63) is set 

3 
Variable number 

setting error 

It occurs when a variable number which is not permitted in 
the P2P parameters set in XG5000 is entered. 

4 Slot does not 
exist 

- 

5 Module 
mismatch 

It is not the communication module. 

6 Module 
mismatch 

Communication module which cannot be used for the 
relevant command 

10 
Modbus setting 
error 

The Modbus offset cannot be entered(Example: 0x10000) 
because only a direct variable can be entered for DEV. 

11 
Variable size 
setting error 

It occurs when the size of a variable which is not permitted 
for the P2P parameter set in XG5000 is entered. 

12 
Data type 
setting error 

It occurs when a variable type which is not permitted in the 
P2P parameter set in XG5000 is entered. 
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Chapter 8 LS Bus Protocol 
 

8.1 LS bus protocol 
 

LS Bus protocol communication is a protocol that is applied when communicating with the inverter of its 
company. The PLC and inverter manufactured by LS ELECTRIC can be connected easily using the data read 
and write function in various internal device areas and the monitoring function without special settings. 

 
The LS bus protocol functions provided in the Cnet I/F module are as follows. 

• Device continuous read 

• Device continuous write  
 

8.1.1 Frame Structure 
 
(1) Basic structure 

(a) Request frame (external communication device → Cnet) 

Head 
(ENQ) 

Station 
No. 

Command Structured data area 
Frame 
check(BCC) 

Tail 
(EOT) 

 
(b) ACK response frame (Cnet → external communication device, when data is received normally) 

Head 
(ACK) 

Station 
No. 

Command Structured data area 
Frame 
check(BCC) 

Tail 
(EOT) 

 
(c) NAK response frame (Cnet → external communication device, when data is not received normally) 

Head 
(NAK) 

Station 
No. 

Command Error code(ASCII 4 Byte) 
Frame 
check(BCC) 

Tail 
(EOT) 

 

Notes  
(1) In case of numeric data of all frames, a Hex value is expressed in ASCII code, unless 

specified otherwise. Items expressed as a Hex value are as follows. 

        • Station No. 

        • R (read) and W (write) are supported for the command type. 

• Whole content of data 

(2) For hex data, ‘H’ is attached in front of number in the frame such as H01, H12345, H34, H12 

and H89AB, indicating that this data is hex data. 

(3) Up to 256 bytes can be used for the frame. 

(4) The contents of a control code used are as follows. 
 

Code 
Hex 

values 
Name Contents of control 

ENQ H05 Enquire Start code of request frame 

ACK H06 Acknowledge 
Start code of the ACK response 
frame 

NAK H15 Not Acknowledge 
Start code of the NAK response 
frame 

EOT H04 End of text End ASCII code of requested frame 
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(2) Command frame sequence 

 
▪ Sequence of command request frame 

ENQ 
Station 
No. 

Com
mand 

Formatted 
data 

BCC EOT 

ACK 
Station 
No. 

Com
mand 

Formatted 
data 

BCC EOT 

 
 

NAK 
Station 
No. 

Com
mand 

Formatted 
data 

BCC EOT 

 
 

8.1.2 List of commands 
 

The type of command used in the LS bus protocol is as follows. 

                               
 
  

Item 

Command 

Contents of process Command type 

Symbol 
ASCII 
code 

Read 
continuously 

R H52 Word type inverter variables are read in word units. 

Write continuously W H57 Writes word type inverter variable in word unit. 

 
  

Classification 

(Inverter ACK response) 

(Inverter NAK response) 
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8.2 Details of Command 
 

8.2.1 Write inverter continuously(W) 
 

This is the command to specify an address to the inverter address directly and write data in word units. 
(1) Request format of LS bus client 

Format 
name 

Header 
Station 

No. 
Command 

Inverter 
address 

Data 
size 

Data  … 
Frame 
check 

Tail 

Frame(Ex) ENQ H20 W 0100 H6 H00E2  BCC EOT 

ASCII 
values 

H05 H3230 H57 H30313030 H36 H30304532  ` H04 

 

Classification Description 

BCC 
Only one low-order byte of the value obtained by adding one byte each to the ASCII 
value excluding the values of ENQ and EOT is converted into ASCII and added to 
BCC. 

Data size 
Specify the number of words to write. When converted to ASCII, it ranges from 
H01(ASCII value:3031)to H08(ASCII value:3038).   

Inverter address 
The inverter address to be read is entered. It should be up to 4-digit ASCII value, 
and characters other than  numbers are not permitted. 

Data 
If the value to be written in the inverter address 0100 area is H’A, the data format 
should be H000A.  

 

• Example 
If the data type you wish to use is words and the value is H1234, this value will be 31323334 when it is 
converted into ASCII code, so 31323334 will be saved on the data area. In other words, the most 
significant value is transmitted first, and the least significant value is transmitted later. 

 

Notes  

• Only words are supported for the device data type. 
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(2) Inverter response format (when the ACK responds) 

Format name Header 
Station 

No. 
Command Data … Frame check Tail 

Frame(Ex) ACK H20 W H00E2  BCC EOT 

ASCII values H06 H3230 H57 H30304532   H04 

 

Classification Description 

BCC 
Only one low-order byte of the value obtained by adding one byte each to the ASCII 
value excluding the values of ENQ and EOT is converted into ASCII and added to BCC. 

 
(3)  Inverter response format (when the NAK responds) 

Format 
name 

Header Station No. Command 
Error Code 

(ASCll Byte) 
Frame 
check 

Tail 

Frame(Ex) NAK H20 W H12 BCC EOT 

ACSII 
values 

H15 H3230 H57 H3132  H04 

 

Classification Description 

BCC 
Only one lower byte of the value obtained by adding the ASCII value excluding ENQ and 
EOT values by one byte is converted into ASCII and added to BCC. 

Error code 
This is the content of 1 byte (2 bytes in ASCII code) in Hex and it indicates the type of 
error. For detailed contents, refer to the error code of the relevant inverter. 

 
(4) Example 

 This example supposes that “H00FF” is written in 1230 of inverter station No. 1. 
 

(a) Requested format by Cnet (Cnet → inverter) 

Format 
name 

Heade
r 

Station 
No. 

Comman
d 

Data size 
Inverter 
address 

Data Frame check Tail 

Frame(Ex) ENQ H01 W H1 1230 H00FF BCC EOT 

ASCII 
values 

H05 H3031 H57 H3031 H31323330 H30304646  H04 

 
(b) When the ACK responds after the command is executed (Cnet ← inverter) 

Format name Header Station No. Command Data Frame check Tail 

Frame(Ex) ACK H01 W H00FF BCC EOT 

ASCII values H06 H3031 H57 H30304646  H04 

 
(c) When the NAK responds after the command is executed (Cnet ← inverter) 

Format 
name 

Header Station No. Command Error code Frame check Tail 

Frame(Ex) NAK H01 W H12 BCC EOT 

ASCII values H15 H3031 H57 Error code(2 bytes)  H04 
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8.2.2 Read inverter continuously(R) 

This is the function to read continuously as much data as the specified quantity, starting from the 
specified address of the device. 
 

(1) Format requested by PLC 

Format 
name 

Header 
Station 

No. 
Comman

d 
Inverter address 

The number 
of data 

Frame 
check 

Tail 

Frame 
Example) 

ENQ H10 R 0100 H5 BCC EOT 

ASCII 
values 

H05 H3130 H52 H30313030 H35  H04 

 

Classification Description 

BCC 
Only one lower byte of the value obtained by adding the ASCII value excluding ENQ 
and EOT values by one byte is converted into ASCII and added to BCC. 

Data size 
Specify the number of words to write. When converted to ASCII, it ranges from 
H01(ASCII value:3031)to H08(ASCII value:3038).   

Inverter 
Address 

The inverter address to be read is entered. It should be up to 4-digit ASCII value, and 
characters other than  numbers are not permitted. 

 

Notes  

• Only words are supported for the device data type. 

 
(2) Inverter response format (when the ACK responds) 

Format name 
Heade

r 
Station 

No. 
Comma

nd 
Data … 

Frame 
check 

Tail 

Frame(Ex) ACK H20 R H00E2 … BCC EOT 

ASCII values H06 H3230 H52 H30304532 …  H04 

 

Classification Description 

BCC 
Converts only one lower byte of the value obtained by adding one byte of ASCII value 
excluding ENQ and EOT values into ASCII. 

 
(3)  Inverter response format (when the NAK responds) 

Format 
name 

Header Station No. Command 
Error code 

(ASC 2 Byte) 
Frame 
check 

Tail 

Frame(Ex) NAK H20 R H12 BCC EOT 

ACSII 
values 

H15 H3230 H52 H3132  H04 

 
 

Classification Description 

BCC 
Only one lower byte of the value obtained by adding the ASCII value excluding ENQ and 
EOT values by one byte is converted into ASCII and added to BCC. 

Error code 
 The types of errors are indicated by the contents of 1Byte in Hex(2 Byte in ASCII code). 
For detailed contents, refer to the error code of the relevant inverter. 
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(4) Example 

 The following is an example to read 1 word data of address 1230 of inverter station number 1. 
 

(a) Requested format by Cnet (Cnet → inverter) 

Format 
name 

Header 
Station 

No. 
Command Inverter address Data size Frame check Tail 

Frame(Ex) ENQ H01 R 1230 H1 BCC EOT 

ASCII 
values 

H05 H3031 H52 H31323330 H31  H04 

 
(b) When the ACK responds after the command is executed (Cnet ← inverter) 

Format name Header Station No. Command Data Frame check Tail 

Frame(Ex) ACK H01 R H1234 BCC EOT 

ASCII values H06 H3031 H52 H31323334  H04 

 
(c) When the NAK responds after the command is executed (Cnet ← inverter) 

Format 
name 

Header Station No. Command Error code Frame check Tail 

Frame(Ex) NAK H01 R H12 BCC EOT 

ASCII values H15 H3031 H52 H3132  H04 
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Chapter 9 Modbus Communication 
 

9.1 Overview 
 

The Modbus protocol is the open type protocol used when the client and the server communicate with 
each other. It functions to read or write data according to the function code. The inter-device 
communication using the Modbus protocol uses client-server function that is processed by only one client 
 
The sequence to transmit and receive data using the Modbus communication is as follows. 
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9.2 Modbus Protocol 
 

9.2.1 Protocol type 
 

There are two Modbus communication modes including ASCII and RTU. 
 

 
  

Characteristics ASCII mode RTU mode 

Code system ASCII code 8 bit binary code 

Number of 
data per 
character 

Start bit 1 1 

Data bit 7 8 

Parity bit Even, Odd, None Even, Odd, None 

Stop bit 1 or 2 1 or 2 

Error check 
LRC (Longitudinal Redundancy 

Check) 
CRC (Cyclical Redundancy Check)  

Frame start Colon(:) 3.5 Character non-response time 



 

 
Chapter 9 Modbus Communication 

 

9-3 

 

 

 

 

9.2.2 Protocol structure 
 

The Modbus protocol consists of the PDU which consists of the function code and data, and the 
ADU where the destination station address and error check are added to the PDU. 

 

 
 

If the Modbus communication is normal, the server operates as follows. 

 
 

If the Modbus communication is abnormal, the server transmits the response, including the error 
code, to the client, as shown in the figure below. 

 
 

When an abnormal frame is received, the server transmits the error code and the exception 
code to the client. The error code is the value of the function code plus 80(Hex) value, and the 
exception code indicates the error details. The contents of each code are as follows. 

 

Code Name Contents 

01 Function code error If the function code does not match 

02 Address error If the address has exceeded the permissible range 

03 Data setting error If a data value which is not permitted has been set 

04 
Server station 
abnormality error 

If an abnormality has occurred in the server (slave) station 

05 
Server station retry 
request 

When the server requests the client to make a request again later 
as processing is not currently available 

06 
Server station 
processing time delay 

This is the case when it takes time for the server station to 
process the request, and the master should repeat the request. 
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9.3 Frame Structure 
 

9.3.1 Frame structure in case of ASCII mode 
 

The frame structure in case of Modbus ASCII mode is as follows. 
 

Classification Start  Station No. 
Function 

code 
Data Error check End 

Size(byte) 1  2 2 N 2 2 

 
(1) Characteristics 

(a) The start of the frame is a colon (:) which is 1 byte ASCII code and the end of the frame is ‘CRLF’. 
(b) Up to a 1 second interval is permitted between characters. 
(c) The frame decides whether an error exists or not using the LRC (Longitudinal Redundancy Check). 

 
(2) Address area 

(a) It is configured in 2 bytes. 
(b) A station address from 0 to 31 can be set. 
(c) Station 0 is used as the client station address. 
(d) The server responds by including its own address in the response frame so that the client will know. 

 
(3) Data area 

(a) Data is transmitted using ASCII data; the data structure varies according to each function code. 
(b) When a normal frame is received, response data will be transmitted. 
(c) When an abnormal frame is received, an error code will be transmitted. 

 
(4) Error check area 

Decides whether an error exists or not using LRC. 
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9.3.2 Frame structure in case of RTU mode 
 

The frame structure in case of Modbus RTU mode is as follows. 
 

Classification Start Station No. 
Function 

code 
Data Error check End 

Size(byte) Idle time 1 1 N 2 Idle time 

 
(1) Characteristics 

(a) Communicates using a Hex number. 
(b) The start of the frame is the station address and the end of the frame is CRC error check. 
(c) The start and end of the frame are distinguished by adding 1 bit idle time to the start and end of the 

frame. 
(d) At least a 3.5 character time interval exists between frames, and when more than 1.5 character 

time has passed between characters, it is recognized as an independent frame. 
 

(2) Address area 
(a) It is configured in 1 bytes.  
(b) A station address from 0 to 31 can be set. 
(c) Station 0 is used as the client station address. 
(d) The server responds by including its own address in the response frame so that the client will know. 

 
(3) Data area 

(a) Data is transmitted using Hex data and the data structure varies according to each function code. 
(b) When a normal frame is received, response data will be transmitted. 
(c) When an abnormal frame is received, an error code will be transmitted. 

 
(4) Error check area 

The frame decides whether an error exists or not using the CRC (Cyclical Redundancy Check). 
 

(5) Modbus address rule 
An address in data begins from 0 and it is the same as the value of Modbus memory subtracted by 1. 
In other words, Modbus address 2 is same as address 1 in the data. 
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9.3. 3 Data and address expression method 
 

The method to express data and the address of Modbus protocol is as follows. 
 

(1) Hex data is used as the default type. 
(2) In ASCII mode, hex data is used after it is converted into ASCII code. 
(3) In RTU mode, hex data is used. 
(4) The type of function code is as follows. 

 

Code(hex) Usage Available area Address Max. response data 

01 
Read bit 

individually/continuously 
Output bit 0XXXX 2000 bit 

02 
Read bit 

individually/continuously 
Input bit 1XXXX 2000 bit 

03 
Read word 

individually/continuously 
Output word 4XXXX 125 words 

04 
Read word 

individually/continuously 
Input word 3XXXX 125 words 

05 Write bit individually Output bit 0XXXX 1 bit 

06 Write word individually Output word 4XXXX 1 words 

0F Write bit continuously Output bit 0XXXX 1968 bit 

10 Write word continuously Output word 4XXXX 123 words 
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9.3.4 Read bit data from bit output area (01) 
 

(1) Reading bit of output area(function code: 01)  
The frame structure in the case of reading bit data from the bit output area is as follows. 
Tail of the frame only applies in the case of ASCII mode. 

 
(a) Request frame 

 

Frame 
Station 

No. 
 Function 

code(01) 
Address 

Data 
size 

Frame error 
check 

Tail 
(CRLF) 

Size(byte) 1  1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Frame 
Station 

No. 
Function 
code(01) 

Number of 
bytes 

Data 
Frame error 

check 
Tail 

(CRLF) 

Size(byte) 1 1 1 N 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Frame Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame detail 

(a) Station address: It indicates the station address of the relevant server.  
(b) Function code: ‘01’ which indicates read bit data from the bit output area continuously/individually 
(c) Address: It represents the starting address of the data to be read from the server and consists of 2 

bytes. At start address time, the Modbus address rule applies for the start address.  
(d) Data size: It represents the size of data to be read and consists of 2 bytes. 
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Data: Transmit data in byte units with the address of the request frame as the start address. 
(i) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of reading bit data in the bit output area, 81 (Hex) will be transmitted. 
(j) Exception code: It represents detailed error details and consists of 1 byte. 
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(3) Example of frame 

This is an example in the case of reading bit data from 20 to 38 from No. 1 server that operates in 
Modbus RTU mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 

code 

Address Data size Error 
check Upper byte Lower byte Upper byte Lower byte 

Frame 01 01 00 13 00 13 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 

code 
Number 
of bytes 

Data Error check 

Frame 01 01 03 12 31 05 CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 81 02 CRC 
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9.3.5 Read bit data from bit Input area (02) 
 

(1) Read bit from the input area 
The frame structure in the case of reading bit data from the bit input area is as follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 
code(02) 

Address Data size 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(02) 

Number of 
bytes 

Data 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 1 N 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame detail 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘02’ which indicates read bit data from the bit input area continuously/individually. 
(c) Address: It represents the starting address of the data to be read from the server and consists of 2 

bytes. At this time, the Modbus address rule applies for the start address.  
(d) Data size: It represents the size of data to be read and consists of 2 bytes. 
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Data: Transmit data in byte units with the address of the request frame as the start address. 
(i) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of reading bit data in the bit input area, 82 (Hex) will be transmitted. 
(j) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 

This is an example of reading bits from 20 to 39 in server station No. 1 that operates in Modbus 
RTU mode. 

 
(a) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Data size 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 02 00 13 00 13 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classifi
cation 

Station 
No. 

Function 
code 

Number of 
bytes 

Data Error check 

Frame 01 02 03 12 31 05 CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 82 02 CRC 
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9.3.6 Read word data from word output area (03) 
 

(1) Read words from the output area 
The frame structure in the case of reading word data from the word output area is as follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 
code(03) 

Address Data size 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(03) 

Number of 
bytes 

Data 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 1 N*2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame detail 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘03’ which indicates read word data from the word output area 

continuously/individually 
(c) Address: It represents the starting address of the data to be read from the server and consists of 2 

bytes At this time, the Modbus address rule applies for the start address.  
(d) Data size: It is the size of data to read and consists of 2 bytes. 
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Data: Transmit data in byte units with the address of the request frame as the start address. At this 

time, data is word type, so it is same as the size of doubling the number of bytes. 
(i) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of reading word data in the word output area, 83(Hex) will be transmitted. 
(j) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 

This is an example in the case of reading word data from 108 to 110 from No. 1 server station that 
operates in Modbus RTU mode. 

 
(a) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Data size 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 03 00 6B 00 03 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classifi
cation 

Station 
No. 

Function 
code 

Number of 
bytes 

Data Error check 

Frame 01 03 06 13 12 3D 12 40 4F CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 83 04 CRC 
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9.3.7 Read word data from word Input area (04) 
 

(1) Read words from the input area 
The frame structure in the case of reading word data from the word input area is as follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 
code(04) 

Address Data size 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(04) 

Number of 
bytes 

Data 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 1 N*2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame details 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘04’ which indicates read word data from the input area continuously/individually 
(c) Address: It indicates the start address of data to be read from the relevant server. It consists of 2 

bytes. At this time, the Modbus address rule applies for the start address.  
(d) Data size: It is the size of data to read and consists of 2 bytes. 
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Data: Transmit data in byte units with the address of the request frame as the start address. At this 

time, data is word type, so it is same as the size of doubling the number of bytes. 
(i) Error code: It is represented by adding 80 (Hex) values to the function code and transmitted in 

84(Hex) for the bit reading of output area. 
(j) Exception code: It means the detailed error description and consists of 1 byte. 

 
(3) Example of frame 

This is an example in the case of reading word data saved to Input area No. 9 from No. 1 server 
that operates in Modbus RTU mode. 
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(a) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Data size 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 04 00 08 00 01 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classifi
cation 

Station 
No. 

Function 
code 

Number of 
bytes 

Data Error check 

Frame 01 04 02 00 0A CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 84 04 CRC 
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9.3.8 Write bit data on bit output area individually (05) 
 

(1) Write bit on the output area individually 
The frame structure in case of writing bit data on the bit output area individually is as follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Stati
on 
No. 

Function 
code(05) 

Address 
Output 
value 

Frame error 
check 

Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(05) 

Address 
Output 
value 

Frame error 
check 

Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame details 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘05’ which indicates write bit data on the bit output area individually 
(c) Address: It indicates the start address of data to write on the relevant server. It consists of 2 bytes. 

At this time, the Modbus address rule applies for the start address.  
(d) Output value: It is the bit value of address set in the address operates On, it is indicated by 

FF00(Hex), whereas if it operates Off, it is indicated by 0000(Hex). 
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of writing bit data on the bit output area, 85 (Hex) will be transmitted. 
(i) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 
This is an example of turning the 9th bit of the output area On in server station No. 1 that operates 
Modbus RTU mode. 

 
(a) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Output value 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 05 00 08 FF 00 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Output value 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 05 00 08 FF 00 CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 85 04 CRC 
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9.3.9 Write word data on word output area individually (06) 
 

(1) Write word on the output area individually 
The frame structure in the case of writing word data on the word output area individually is as 
follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 
code(06) 

Address 
Output 
value 

Frame error 
check 

Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(06) 

Address 
Output 
value 

Frame error 
check 

Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame details 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘06’ which indicates write word data on the word output area individually 
(c) Address: It indicates the start address of data to write on the relevant server. It consists of 2 bytes. 

At this time, the Modbus address rule applies for the start address.  
(d) Output value: It means the data value to be written in address set in the address.  
(e) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(f) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(g) Number of bytes: It means the number of bytes of data that responds. 
(h) Error code: It is represented by adding 80 (Hex) values to the function code and transmitted in 

86(Hex) for the bit reading of output area. 
(i) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 

This is an example of writing 0003(hex) in the 9th output area of word type in server station No. 1 
that operates in Modbus RTU mode. 

 
(a) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Output value 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 06 00 08 00 03 CRC 

 
(b) Response frame (When a normal frame is received) 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address Output value 
Error check 

Upper byte Lower byte Upper byte Lower byte 

Frame 01 06 00 08 00 03 CRC 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Function code Exception code Error check 

Frame 01 86 02 CRC 
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9.3.10 Write bit data on bit output area continuously (0F) 
 

(1) Write bit on the output area continuously 
The frame structure in the case of writing bit data on the bit output area continuously is as follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 

Function 
code 
(0F) 

Address 
Number 
of output 

Data 
Size 

Output 
value 

Frame 
Error 
check 

Tail 
(CRLF) 

Size(byte) 1 1 2 2 1 N 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(0F) 

Address 
Number 
of output 

Frame error 
check 

Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame details 

(a) Station address: It indicates the station address of the relevant server.  
(b) Function code: ‘0F’ which indicates write bit data on the bit output area continuously 
(c) Address: It indicates the start address of data to write on the relevant server. It consists of 2 bytes. 

At this time, the Modbus address rule applies for the start address. 
(d) Number of output: It means the number of data to be written and consist of 2 bytes. Example) If the 

address  writes 10 data continuously from No. 20, the number of outputs is 00A (Hex). 
(e) Data size: It indicates the number of output in byte value. In other words, if the data size is 1, the 

number of data for continuously write is 8. Example) In case of writing 10 bits of data continuously, 
the data size will be 2.  

(f) Output value: It means the data value to be written in address set in the address.  
(g) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(h) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(i) Number of bytes: It means the number of bytes of data that responds. 
(j) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of continuous writing bit data on the bit output area, 8F (Hex) will be transmitted. 
(k) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 

This is an example in the case of writing 10 bit values continuously, beginning with 20th address in 
No. 1 server that operates in Modbus RTU mode. 

 
(a) Data value to write continuously 

 

Bit value 1 1 0 0 1 1 0 1 0 0 0 0 0 0 0 1 

Hex C D 0 1 

Address 27 26 25 24 23 22 21 20 - - - - - - 29 28 

 
(b) Request frame 

 

Classific
ation 

Station 
No. 

Function 
code 

Address Number of output 
Data 
size 

Output value 
Error 
check 

Upper 
byte 

Lower 
byte 

Upper 
byte 

Lower 
byte 

Upper 
byte 

Lower 
byte 

Frame 01 0F 00 13 00 0A 02 CD 01 CRC 

 
(c) Response frame (When a normal frame is received) 

 

Classific
ation 

Station 
No. 

Function code 
Address Number of output Error 

check Upper byte Lower byte Upper byte Lower byte 

Frame 01 0F 00 13 00 0A CRC 

 
(d) Response frame (When an abnormal frame is received) 

 

Classific
ation 

Station No. Function code Exception code Error check 

Frame 01 8F 01 CRC 
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9.3.11 Write word data on word output area continuously (10) 
 

(1) Write word on output area continuously 
The frame structure in the case of writing word data on the word output area continuously is as 
follows. 
The tail of the frame is applied only in the case of ASCII mode. 

 
(a) Request frame 

 

Classification 
Station 

No. 
Function 
code(10) 

Address 
Number 
of output 

Data 
size 

Output 
value 

Frame 
error 
check 

Tail 
(CRLF) 

Size(byte) 1 1 2 2 1 N*2 2 2 

 
(b) Response frame (When a normal frame is received) 

 

Classification 
Station 

No. 
Function 
code(10) 

Address 
Number of 

output 
Frame error 

check 
Tail (CRLF) 

Size(byte) 1 1 2 2 2 2 

 
(c) Response frame (When an abnormal frame is received) 

 

Classification Station No. Error code 
Exception 

code 
Tail (CRLF) 

Size(byte) 1 1 1 2 

 
(2) Frame details 

(a) Station address: It indicates the station address of the relevant server. 
(b) Function code: ‘10’ which indicates write word data on the word output area continuously 
(c) Address: It indicates the start address of data to write on the relevant server. It consists of 2 bytes. 

At this time, the Modbus address rule applies for the start address. 
(d) Number of output: It means the number of data to be written and consist of 2 bytes. Example) If the 

address writes 10 data continuously from No. 20, the number of outputs is 00A (Hex). 
(e) Data size: It indicates the number of output in byte value. Since the data format is word type, in 

case of writing 1 word of data, the data size will be 2.  
(f) Output value: It means the data value to be written in address set in the address.  
(g) Frame error check: In ASCII mode, it uses LRC, in RTU mode, it uses CRC and consists of 2 bytes. 
(h) Tail: It applies only in the case of the ASCII mode, and CRLF is added after LRC. 
(i) Number of bytes: It means the number of bytes of data that responds. 
(j) Error code: The error code is expressed as the function code plus 80 (Hex) value, and in the case 

of  continuous writing word data on the word output area continuously, 90(Hex) will be transmitted. 
(k) Exception code: It means the detailed error description and consists of 1 byte. 
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(3) Example of frame 

This is an example in the case of writing 2 words continuously, beginning with 20th address in No. 1 
server that operates in Modbus RTU mode. 

 
(a) Data value to write continuously 

 

Hex C D 0 1 0 0 0 A 

Address 20 21 

 
(b) Request frame 

 

Classifi
cation 

Station 
No. 

Function 
code 

Address 
Number of 

output Data 
size 

Output value 
Error 
check Upper 

byte 
Lower 
byte 

Upper 
byte 

Lower 
byte 

Frame 01 10 00 13 00 02 04 CD 01 00 0A CRC 

 
(c) Response frame (When a normal frame is received) 

 

Classific
ation 

Station 
No. 

Function 
code 

Address Number of output Error 
check Upper byte Lower byte Upper byte Lower byte 

Frame 01 10 00 13 00 02 CRC 

 
(d) Response frame (When an abnormal frame is received) 

 

Classific
ation 

Station No. Function code Exception code Error check 

Frame 01 90 01 CRC 
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9.4 Modbus server 
 

It is used when the destination device you wish to communicate with operates as the Modbus client. Both 
the ASCII mode and RTU mode of Modbus are supported, and each operation mode can be set from the 
[Basic setting] window. 
 

9.4.1 How to use the Modbus ASCII server in the XGK system 
 

(1) Connection setting 
(a) Select [Online]→[Connection setting]. 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 

 
(3) Standard settings 

(a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, and set the 
communication type, communication speed modem type, data bit, stop bit and station address 
from the connection setting menu. At this time, 7 should be set for the data bit. 

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only 

when P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 

 

       
 
 
 

(4) Selecting the operation mode 
Select Modbus ASCII server. 
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(5) Modbus setting 

(a)  When you select Modbus ASCII server for the operation mode, [Modbus setting] will be 
enabled. 

(b) Start address of read bit area: Indicates the start address of the bit read area and consists of 5 
digits. The first four digits represent the word value, and the remaining digits represent the bit 
value. 

Ex) M00000: It is in the case where the 0th bit of the 0th word in the M device area is set as 
the start address of the read bit area. 

(c) Start address of write bit area: Indicates the start address of the bit write area and consists of 5 
digits. At this time, the first 4 digits indicate the word value and the last digit indicates the bit 
value. 

Ex) M00100: It is in the case where the 0th bit of the 0th word in the M device area is set as 
the start address of the read bit area. 

(d) Word read area start address: It indicates the start address of the word read area and consists 
of 4 digits. 
Ex) M00200: It is in the case where the 200th word in the M device area is set as the start 

address of the read word area.  
(e) Start address of write word area: It is the start address of the word write area and consists of 4 

digits. 
Ex) M00300: It is the case that the 300th word of the M device area is set as the start address of 

the word write area. 
 

 
 

(6) Writing parameter 
(a) Select [Online]→[Write]. 
(b) Put a check mark on the module whose basic setting is completed from standard settings and 

click[OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 
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(7) Check operation 

(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the following screen is displayed, click [Frame monitor] or [Status by service] and check the 

operation status. 
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9.4.2 How to use the Modbus ASCII server in the XGI/XGR system 
 

(1) Connection setting 

(a) Select [Online]→[Connection setting]. 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 

 
(3) Standard settings 

(a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, and set the 
communication type, modem type, data bit, stop bit and station address from the connection setting 
menu. At this time, 7 should be set for the data bit. 

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only when 

P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 
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(4) Selecting the operation mode 
Select Modbus ASCII server. 

 
(5) Modbus setting 

(a) When you select Modbus ASCII server for the operation mode, [Modbus setting] will be enabled. 
(b) Start address of read bit area: It indicates the start address of the read bit area. 

Ex) %MX100: It is in the case where the 100th bit in the M device area is set as the start address 
of the read bit area. 

(c) Start address of write bit area: It indicates the start address of the write bit area. 
Ex) %MX200: It is in the case where the 200th bit in the M device area is set as the start address 

of the read bit area. 
(d) Word read area start address: It indicates the start address of  the read word area. 

Ex) %MW300: It is in the case where the 300th word in the M device area is set as the start 
address of the read word area. 

(e) Word read area start address: It indicates the start address of the write word area. 
Ex) %MW400: It is the case that the 400th word of the M device area is set as the start address 

of the word write area. 
 

 
 

(6) Writing parameter 
(a) Select [Online]→[Write]. 
(b) Put a check mark on the module whose basic setting is completed from standard settings and 

click[OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 
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(7) Check operation 

(a) Click [Online] → [Communication module setting and Diagnosis] → [System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the following screen is displayed, click [Frame monitor] or [Status by service] and check the 

operation status. 
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9.4.3 How to use the Modbus RTU server in the XGK system 
 

(1) Connection setting 
(a) Select [Online]→[Connection setting]. 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 

 
(3) Standard settings 

(a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, and set the 
communication type, communication speed modem type, data bit, stop bit and station address from 
the connection setting menu. At this time, 8 should be set for the data bit. 

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only when 

P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 
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(4) Select operation mode 

Select Modbus RTU server. 
 

(5) Modbus setting 
(a) When you select Modbus RTU server for the operation mode, [Modbus setting] will be enabled. 
(b) Start address of read bit area: Indicates the start address of the bit read area and consists of 5 

digits. The first four digits represent the word , and the remaining digits represent the bit value. 
Ex) M00000: It is in the case where the 0th bit of the 0th word in the M device area is set as the 

start address of the read bit area. 
(c) Start address of write bit area: Indicates the start address of the bit write area and consists of 5 

digits. At this point, first four digits represent the word , and the remaining digits represent the bit 
value. 

Ex) M00100: It is in the case where the 0th bit of the 10th word in the M device area is set as the 
start address of the read bit area. 

(d) Word read area start address: Indicates the start address of the word read area and consists of 4 
digits. 

Ex) M00200: It is in the case where the 200th word in the M device area is set as the start 
address of the read word area. 

(e) Start address of write word area: Indicates the start address of the word write area and consists of 
4 digits. 

Ex) M00300: It is the case that the 300th word of the M device area is set as the start address of 
the word write area. 

 

 
 

 
(6) Writing parameter 

(a) Select [Online]→[Write]. 
(b) Click the module whose standard settings is completed from Basic setting and click[OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 
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(7) Check operation 

(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the following screen is displayed, click [Frame monitor] or [Status by service] and check the 

operation status. 
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9.4.4 How to use the Modbus RTU server in the XGI/XGR system 
 

(1) Connection setting 
(a) Select [Online]→[Connection setting]. 
(b) Set the connection option that fits the user environment and click [Connect]. 

 

 
 

(2) Reading I/O information 
Click [I/O Sync] from the [Online] → [System Diagnostics] → [I/O information] window and read the 
information from the module currently installed on the base. 

 
(3) Standard settings 

(a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, and set the 
communication type, communication speed, modem type, data bit, stop bit and station address 
from the connection setting menu. At this time, 8 should be set for the data bit. 

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only when 

P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 

 

      
     

 
(4) Selecting the operation mode 

Select Modbus RTU server. 
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(5) Modbus setting 
(a)  When you select Modbus RTU server for the operation mode, [Modbus setting] will be enabled. 
(b) Start address of read bit area: It indicates the start address of the read bit area. 
(c) Ex) %MX100: It is in the case where the 100th bit in the M device area is set as the start address of 

the read bit area. 
(d) Start address of write bit area: It indicates the start address of the write bit area. 

Ex) %MX200: It is in the case where the 200th bit in the M device area is set as the start address 
of the write bit area. 

(e) Word read area start address: It indicates the start address of  the read word area. 
Ex) %MW300: It is in the case where the 300th word in the M device area is set as the start 

address of the read word area. 
(f) Word read area start address: It indicates the start address of the write word area. 

Ex) %MW400: It is the case that the 400th word of the M device area is set as the start address 
of the word write area. 

 

 
 

(6) Writing parameter 
(a) Select [Online]→[Write]. 
(b) Put a check mark on the module whose basic setting is completed from standard settings and 

click[OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 
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(7) Check operation 

(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the following screen is displayed, click [Frame monitor] or [Status by service] and check the 

operation status. 
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9.5 Modbus RTU/ASCII client 
 

9.5.1 Standard settings 
 

(1) Connection setting 
(a) Select [Online]→[Connection setting]  
(b) Set the connection option that fits the user environment and click 'Connect'. 

 

 
 

(2) Reading I/O information 
Click [I/O synchronization] from the [Online]→[System Diagnosis]→[I/O information] window and 
read the information on the module currently installed on the base. 

 
(3) Standard settings 

(a) Open the [Standard settings] window by double clicking the relevant Cnet I/F module, and set the 
communication type, communication speed, modem type, data bit, stop bit and station address 
from the connection setting menu. Set 7 for the data bit in the case of operating in the ASCII mode.   

(b) The modem can be initialized only when the modem type is the dial-up modem. 
(c) The delay time can be set only for RS-422/485 and the response waiting time can be set only when 

P2P is used as the operation mode for RS-422/485 communication. 
(d) The terminating resistance setting and repeater mode can be used in the B type Cnet I/F module. 

 

       
 

(4) Selecting the operation mode 
When using as a client, be sure to select 'Use P2P'. 

 



 

 
Chapter 9 Modbus Communication 

 

9-36 

 

 

 

(5) P2P channel setting 
(a) Double click the P2P channel and select the protocol for each channel. 
(b) User frame definition, XGT client, LS bus client and Modbus RTU/ASCII client are supported for 

the P2P driver. 
 

 
 
  



 

 
Chapter 9 Modbus Communication 

 

9-37 

 

 

 

 

9.5.2 P2P Parameter setting 
 

The Modbus RTU/ASCII client provides the Read command which is used for reading the data of the 
destination station, and the Write command which is used for writing data on the destination station. The 
parameter setting methods for the Modbus RTU client and Modbus ASCII client are the same. 

 
 

No. Type Block type Contents 

1 Channel 

 

The name of the setting driver changes according to the driver set 
in the P2P driver. 

2 
P2P 
function 

 

(1)Read: It is used for reading the data of the destination station. 
(2)Write: It is used for writing data on the destination station. 

3 
Start 
condition 

 

(1) Enter special flag or bit contact to select the time when data is 
transmitted and received 

(2) Example In case of XGI type :F90 (Operates in 20ms intervals), 
M01  
(3) Example In case of XGI type : _T20MS (operates in 20ms 

intervals),%MX01  

4 
Command 
type 

 

(1)Individual: It is used when reading or writing up to 4 data. 
(example: M01, M10, M20, M30) 

(2)Continuous: It is used for reading or writing data 
continuously.(Example : M01~M10) 

5 
Data 
Type 

 

Bit and word can be selected for the data type. 

6 
Data 
Size 

 

It indicates the size of transmission and reception data and it is 
enabled only in case of the continuous method. 
(1) If the P2P function is Read 

(a) Modbus RTU client 
1)Bit type:1~2000  
2)Word type:1~125  

(b) Modbus ASCII client 
1)Bit type:1~976  
2)Word type:1~61  

(3) If the P2P function is Write 
(a) Modbus RTU client 

1)Bit type:1~1968  
2)Word type:1~120  

(b) Modbus ASCII client 
1)Bit type:1~944  
2)Word type:1~59  
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No. Type Block type Contents 

7 
Destination 
station 

 

It is checked automatically. If you click it one more 
time to remove the check mark, the relevant block 
will not operate. 

8 
Destination 
station 
number  

It indicates the station address of the destination 
station. The setting range is 0 to 31 stations; the 
station address can be set for up to 32 stations. 

9 Setting  

▶ If the P2P function is Read  
(1) Read area: It indicates the start address of data 

area in the destination station (server). 
(a)Bit: Bit input(0x10000), Bit output(0x00000) 
(b)Word: Word input(0x30000), word 

output(0x40000) 
(2) Storage area: It indicates the area to save data 

in the self station (client). 

 

▶ If the P2P function is Write  
(1) Read area: It indicates the data area of the self-

station. 
(2) Storage area: It indicates the start address of 

data save area in the destination station. 
(a)Bit: Bit input(0x10000), Bit output(0x00000) 
(b)Word: Word input(0x30000), word 

output(0x40000) 
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9.5.3 Write Parameter 
 

(1) Writing parameter 
(a) Select [Online]→[Write]. 
(b) Click the module and P2P whose basic setting and P2P parameter setting are completed, and 

click[OK]. 
(c) Click the [OK] button, and after writing the parameter, reset each relevant module. 

 

 
 

(2) Link enable 

(a) Select [Online]→[Communication module setting and Diagnosis]→[Enable Link/Services]. 

(b) Put a check mark on the set P2P block set and click Write. 
 

(3) Check operation 
(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b) Click the relevant module and click the right mouse button. 
(c) When the following screen is displayed, click [Frame monitor] or [Status by service] and check the 

operation status. 
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9.6 Frame Monitor 
 

When you use the frame monitor function of the XG5000, you can check a frame which has actually 
been exchanged by the client and the server. 

 
(1) Check operation 

(a) Select [Online]→[Communication module setting and Diagnosis]→[System diagnosis]. 
(b)  Click the relevant module and click the right mouse button.  

 

 
(c) When the screen as shown in the figure above appears, click [Frame monitor]. 

(2) Frame monitor 
(a) Select the channel you want to monitor. 
(b) Select View as ASCII if the protocol is Modbus ASCII mode. 
(c) Select View as HEX if the protocol is Modbus RTU mode. 
(d) Click [Start] to check the sending / receiving frame. 
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Chapter 10 User Frame Definition Communication 
 

10.1 Overview 
 

Since there are various types of communication protocol, it is impossible to load all protocols on 
one communication module. Therefore, the Cnet I/F module provides the user frame definition 
communication function for solving such problems. By using this function, the user can write a 
protocol that fits his/her purpose for communication when connecting to another device that does 
not use the XGT protocol or Modbus protocol. At this time, the user can transmit or receive data only 
when writing the same transmission frame and the receive frame as the protocol of the destination 
device. 

 

 
 

  
When using the user frame definition communication, please follow the sequence shown below. 
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10.2 Frame configuration 
 

The frame used in the user frame definition communication is divided into Head, which indicates 
the beginning of the frame, Tail, which indicates the end, and Body, which is the data area. Head, 
Tail and bodies consist of each segment. One frame should be less than 1024 bytes. 

 
 

(1) Header 
The input type of segments composing Head is divided into the numerical constant and the string 

constant. The numerical constant indicates a Hex number and the string constant indicates an ASCII 
character. The number of segments that can be configured in Head is limited to 16 or less. 
 

(2) Tail 
The input types of the segments that consist of the tail include numerical constants, string 

constants and BCC to check frame errors. The numerical constant and the string constant are the 
same as the contents mentioned for Head above. BCC is the segment used for testing an error in 
transmitted and received frames, and only one BCC can be set for Tail. The number of segments 
that can be configured in Tail is limited to 16 or less. 

 
(a) BCC error check 

When BCC is used, the transmitted or received frame is operated. If it is different from the 
operation result, the relevant frame will be ignored, so the communication quality can be improved. 
The contents related to each error detection method are as follows. 

Classification BCC method Contents 

Universal 
communication 
error detection 
method 

Byte SUM 
Use the lower byte value of the result where data in the specified area 
is added in 1 byte 

Word SUM 
Use the lower word value of the result where data in the specified 
area is added in 1 word 

Byte XOR 
Use lower byte of the exclusive OR operation result of data in a 
specified area by byte 

7 bit SUM 
Uses the value excluding the most significant bit of the byte SUM 
result value 

7 bit XOR 
Uses the value excluding the most significant bit of the byte XOR 
result value 

Byte SUM 2’S COMP Takes two's complement of byte SUM result 

Byte SUM 1’S COMP Take 1’s complement with respect to the byte SUM result 

CRC 16 16-bit CRC error detection method 

CRC 16 IBM 16-bit IBM CRC error detection method 

CRC 16 CCITT 16-bit CCITT CRC error detection method 

Dedicated 
Communication 
error detection 
method 

LSIS CRC Error detection method used in LS ELECTRIC PLC 

DLE AB Allen Bradley's DF1 Protocol error detection method 

DLE SIEMENS Error detection method used for the Siemens 3964R communication 
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If BCC is classified as the dedicated communication method when setting it, it is not necessary to 
set the BCC setting range and display method, but if it is classified as universal communication, the 
BCC setting range and display method should be set. 

Item Content 

Start 
position 

Area Specify among head/body/tail where BCC calculation will begin 

Segment 
Specify the position of segment in head/body/tail where BCC calculation will begin  
0 is included in BCC calculation from the beginning of the frame. 

End 
position 

Before 
BCC 

Includes the range from the start position to before BCC in the calculation 

End of 
area 

Includes the range from the start position to the end of the specified area in the 
calculation 

Setting 
Include the range from the start position to the position of segment in the specified 
area in the calculation 

ASCII conversion Converts the result value into ASCI and the size will double. 

Initial value 0 The initial value of BCC calculation is 0. 

 
(3) Body 

The input type of segment that configures body varies according to the transmission and receive. 
The transmission is classified into numerical constant, string constant and variable-sized variable, the 
contents related to the numerical constant and string constant are the same as in the explanation 
given for Head. The number of segments that can be configured in Body is limited to 100 or less. 

 
(a) Variable-sized variable (in case of receive frame)  

The part of the frame that changes in size and content is defined as a variable size parameter 
segment. A variable-sized variable can be set only for body. In addition, unlike other segments, the 
additional segment cannot be set after the variable size parameter segment. When the variable size 
segment is used, there should be head or tail. If a frame is registered only using a variable-sized 
variable without head or tail, an error may occur when the frame is received. In order to improve the 
communication quality, at least one among Head and Tail should be set. Even if a variable-sized 
variable is used in the transmission frame, the size of variable-sized variable is specified in the P2P 
block setting, so the function and characteristics are the same as those of a fixed sized variable of 
the receive frame. 

(b) Fixed-sized variable (In the case of a receive frame) 
The size in the middle of the frame is fixed, but the part that changes when the data contents are 

received is defined as a fixed-sized variable segment. This can be set only for body. Up to four 
fixed-sized variables can be set for one body. 
 

(4) The specification of transmission and reception frame supported in the user frame definition 
communication is as follows. 

Group Frame Segment Contents 

Send  
Frame 

HEAD 
Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

TAIL 

Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

BCC Only one BCC can be applied. 

BODY 

Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

Variable-sized variable Up to 4 variables are available. 

Receive  
Frame 

HEAD 
Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

TAIL 

Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

BCC Only one BCC can be applied. 

BODY 

Numerical constant Up to 10 bytes 

String constant Up to 10 bytes 

Fix sized variable 
Up to 4 variables can be set. 
Fixed-size 3, variable-size 1 available. 

Variable-sized variable 
Only one variable-sized variable can be set. 
A segment cannot be added at the back of 
the variable-sized variable. 
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10.3 Writing Frame 
 

10.3.1 Standard settings 
 

In order to carry out the user frame definition communication,’ Use P2P‘ should be set for the 
operation mode just as operating as the client. 

  

Sequ
ence 

Setting 
process 

Setting method 

1 

Connect
ion 

setting 

 
1. Select [Online]→[Connection setting]. 
2. Set the connection option suitable for user’s environment and click the Connect. 

2 

Read 
I/O 

informati
on 

Select [I/O Sync] from [Online] → [System Diagnostics] → [I/O information] window and read 
the information from the module currently installed on the base. 

3 
 

Adds 
P2P 

commun
ication 

 

1. In the project window, click Cnet I/F module with the right mouse button and select [Add item]→[P2P 
communication]. 

1.Set the 2.P2P number.  
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Seque
nce 

Setting 
process 

Setting method 

4 

Standard 
setting 

     
1. Open the [Standard settings] window by double clicking the relevant Cnet I/F module. 
2. Set the communication type, communication speed, modem type, data bit, stop bit and station address 
from the basic setting menu. 
3. Model initialization is only possible when the modem type is a dial-up modem. 
4. The delay time can be set only for RS-422/485 and the response waiting time can be set only when P2P 

is used as the operation mode for RS-422/485 communication. 
5. Terminating resistance setting and the repeater mode can be used when the OS version of the Cnet I/F 
module is V5.0 or higher. 

5 
Select 

operation 
mode 

Use P2P should be selected. 

6 

P2P 
channel 
setting 

 

1. Double click the P2P channel and select protocols for each channel. 
Select the user frame definition for the 2.P2P driver. 

  



 

 
Chapter 10 User Frame Definition Communication 

 

10-6 

 

 

 

 

10.3.2 Writing Send Frame 
 

The method to write a send frame is as follows. 
Sequ
ence 

Initial setting content Setting method 

1 

Create a user frame 

 
1. Select user frame definition. 
2. Click the right mouse button and select [Add item] → [Add a group]. 

2 

Edit group 

 
1. The group name is the name of the frame a user wants to create. 
2. Select send as a frame type because the send frame needs to be created at present. 

3 

Add frame 

 
1. Check if the frame has been created. 
2. Select the frame name and click the right mouse button. 
3. Click [Add frame]. 
4. Edit group: It is used for changing the frame name.  
5. Delete group: It is used for deleting a frame.  

4 

Edit frame 

 

1.Click Add Frame and then select the type of frame to be created. 
2. Types: HEAD, TAIL, BODY 
3. Select HEAD. 
4. Repeat the above process (No.3) to create tail and body. 
5. The name of the frame editing window is enabled only when the type is BODY. 
6.  A number of BODY's can be created by using a different name 
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Sequ
ence 

Setting content Setting method 

5 

Register HEAD 

 
1. Double click HEAD to create an editor screen. 
2. Select type 

(1) Numerical constant 
(a) Define the fixed part of the frame as a constant 
(b) The value of data item is Hex 

(2) String constant 
(a) Register string constant in frame 
(b) The value of data item is ASCII 

3. Enter the value on Data. 
Example) Type: Numerical constant, data: 5(ENQ)     

* By clicking the right mouse button on the created segment, you can edit, delete, insert and copy the segment. 

6 Register TAIL 
1. Double click TAIL to create an editor screen. 
2. The setting method is the same as that in the above process (No. 5). 

7 

Register BODY 

 

1. Double click BODY to enable the editor screen and select the data type. 
(1) The meaning of numerical and string constants is the same as that in the header registration. 
(2) Variable-sized variable 

(a) It is used for changing the size of frame. 
(b) Up to 4 parameters can be set in one body 
(c) Memory specification is automatically checked 
(3) Control in byte 

(3) Conversion 
▶Hex To ASCII: Convert the data read from the PLC memory into ASCII to configure the send frame 

▶ASCII To Hex: Convert the data read from the PLC memory into Hex to configure the send frame 
(4) Swap  

 ▶2 byte swap: 2-byte swap of data value(Example:0x1234->0x3412)  

▶4 byte swap: 4-byte swap of data value(Example:0x12345678->0x78563412)  

▶8 byte swap: 8-byte swap of data value 
* Only XGL-C22B, XGL-CH2B and XGL-C42B support the swap function. 
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10.3.3 Writing a receive frame 
 

The method to write a receive frame is as follows. 

Seq
uen
ce 

Setting content Setting method 

1 

Create a user frame 

 
1. Select user frame definition. 
2. Click the right mouse button and select [Add item] → [Add a group]. 

2 

Edit group 

 
1. The group name is the name of the frame a user wants to create. 
2. Select receive as a frame type because the receive frame needs to be created at present. 

3 

Add frame 

 
1. Check if the frame has been created. 
2. Select the frame name and click the right mouse button. 
3. Click Add frame. 
4.Edit group: It is used for changing the frame name. 
5. Delete group: It is used for deleting a frame. 

4 

Edit frame 

 
1.Click Add Frame and then select the type of frame to be created. 
2. Type: HEAD, TAIL, BODY 
3. Select HEAD. 
4. Repeat the above process (No.3) to create tail and body. 
5. The name of the frame editing window is enabled only when the type is BODY. 
6. A number of BODY's can be created by using a different name 
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Seq
uenc

e 
Setting content Setting method 

5 

Register HEAD 

 
1. Double click HEAD to create an editor screen. 
2. Double click the editor screen or click the right mouse button to select Add Segment. 
3. Select the shape (The contents by type are the same as the explanation given in the paragraph above). 
4. Enter the value on Data.  

6 Register TAIL 
1. Double click TAIL to create an editor screen. 
2. The setting method is the same as that in the above process (No. 5). 

7 

Register BODY 

 
1. Double click BODY to enable the editor screen and select the data type. 

(1) The meaning of numerical and string constants is the same as that in the header registration. 
(2) Variable-sized variable: It is used when changing the frame size. 

(a) One variable size parameter can be set, and segment cannot be added 
(b) When you put a check on [Memory setting], it is possible to save to PLC memory (control by byte unit) 

(3) Fix sized variable: It is used when fixing the frame size to a certain size. 
(a) Up to 4 parameters can be set in one body 
(b) When you put a check on [Memory setting], it is possible to save to PLC memory. 

4) Specify Memory: Checked when the device area to be saved in PLC is set. 
(5) Conversion 

▶Hex To ASCII: Configure the receive frame by converting received data into ASCII 

▶ASCII To Hex: Configure the receive frame by converting received data into Hex 
(6) Swap  

 ▶4 byte swap: Swap upper and lower data values in 2 bytes (Example: 0x1234->0x3412) 

▶4 byte swap: Swap upper and lower data values in 4 bytes (Example: 0x12345678->0x78563412) 

▶8 byte swap: Swap upper and lower data values in 8 bytes 
* Only XGL-C22B, XGL-CH2B and XGL-C42B support the swap function. 
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10.3.4 Setting Parameters 
 

Parameters should be set through the P2P block in order to transmit or receive data using the 
frame written using the XG5000. The setting method is shown below. 
 

 

No. Type Block type Contents 

1 Channel 

 

The name of the setting driver changes according to the driver set in the 
P2P driver. 

2 
P2P 

function 

 

 Receive: It is used for receiving data using a frame written according to 
the destination station's protocol. 
 Send: It is used for sending data using a frame written according to the 
destination station's protocol. 

3 
Start 

condition 
 

 Enter special flag or bit contact and select the point of time 
when data is transmitted and received. 
 In the user frame definition, it is enabled only when the P2P 
function is  send. 
 Example In case of XGK type) F90 (Operates in 20ms intervals), M01 
 Example in case of XGI type) _T20MS (operates in 20ms 
intervals),%MX01 

4 Frame  

If [Send] is selected in the P2P function, select the body of the send 
frame created in the user frame. 

 

If [RECEIVE] is selected in the P2P function, select the body of the 
receive frame created in the user frame. 

5 Setting 

 

 The setting in the P2P block of the user frame definition can be 
done only when Specify Memory of the fixed size parameter and 
variable size parameter created by a user is checked. 
 Save area: Indicates the head address of the areas where data 

received from the destination station will be saved. 
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10.3.5 Write Parameters 
 

Sequ
ence 

Setting 
process 

Setting method 

1 

Write 
paramete

r 

 

1. Select [Online] → [Write].  
2.Click the module and P2P whose basic setting and P2P parameter setting are completed, and click 'OK'. 
3. Click the [OK] button, and when the parameter writing finishes, reset each module. 

2 

Check 
operation 

 

1. Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis]. 
2. Select the relevant module and click the right mouse button 
3. Click [Frame Monitor] or [Status by Service] to check the operation status. 
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10.4 Frame Monitor 

 
When you use the frame monitor function of the XG5000, you can check a frame which has actually 

been exchanged by the client and the server. 
 

Seq
uen
ce 

Setting 
process 

Setting method 

1 

Check 
operation 

 
1. Select [Online] → [Communication Module Settings and Diagnosis] → [System Diagnosis]. 
2. Click the module, press the right mouse button. 

3. When the screen as shown in the figure above appears, click [Frame monitor]. 

2 

Frame 
monitor 

 

1. Select the channel you want to monitor. 
2. When the protocol is in Modbus ASCII mode, select View as ASCII. 
3. When the protocol is in Modbus RTU mode. Select Hex View  
4. Click [Start] to check the sending / receiving frame. 
5. You can save and utilize the frame monitor result to a text file by clicking [Save to file]. 
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10.5 UDATA Commands 

 

10.5.1 XGI Commands 
 

(1) SEND_UDATA  
 

SEND_UDATA Availability Flags 

User defined data send XGI, XGR - 

Function Block Description 

 

 

Input  REQ: requires to execute the function block 

      BASE : base number 

       SLOT: slot number 

  CH: channel(1 or 2) 

      DATA: data area to send 

SIZE: data size to send 

 

Output  DONE: maintains 1 after operation 

    STAT: completion and ERR info 

  

 

 

 
(a) Function 

1) This command is used to transmit user-defined data (hereafter referred to as UDATA). 
2) Enter the base number and the slot number where the Cnet I/F module is installed currently 

on BASE and SLOT respectively. 
3) CH means the channel number and only 1 or 2 should be set. 
4) DATA should be declared as ARRAY OF BYTE type. 
5) The size of array declared as SIZE is 1~1024.(Unit:  Byte) 
6) Saves data as many as SIZE, starting from DATA[0], to the transmission buffer. (The data 

size that can be transmitted at one time is limited to 1024) 
7) When it is executed normally, 1 will be outputted on DONE and STAT, and if an error 

occurs, the status information will be displayed on STAT. 
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(b) Error 

STAT Status Information Contents 

0 Initial status Status before a command is executed 

1 No error Normal operation 

2 Module setting error 
If the module is not installed on the relevant base slot or it is not the 
Cnet I/F module  

3 Channel setting error If the input range (1, 2) has been exceeded 

4 Array size error  If the size of transmitted data exceeds 1024  

5 
Communication 
parameter setting 
error 

If the user frame definition is not set for the communication parameter 
of the Cnet I/F module or link enable is not set 

6 
Command timeout 
error 

If there is no response from the module or the maximum scan time (10 
scans) has exceeded  

7 
Version compatibility 
error 

If the XGI CPU version is below V3.9, if the XGR CPU version is below 
V2.6 or if the Cnet version is below V3.2  

 
 
 

(c) Example of program 

 
 

Command that transmits up to 1024 bytes using the Cnet I/F module installed on BASE and SLOT 
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(2) RCV_UDATA 

 

RCV_UDATA Availability Flags 

User defined data receive XGI, XGR - 

Function Block Description 

 

 

Input    REQ: requires to execute the function block 

        BASE : base number 

         SLOT: slot number 

    CH: channel(1 or 2) 

        DATA: data area to save 

 

Output   DONE: maintains 1 after operation 

     STAT: completion and ERR info 

     SIZE: received data size 

  

 

 
(a) Function 

1) This command saves data of the relevant frame received through the Cnet I/F module. 
2) Enter the base number and the slot number where the Cnet I/F module is installed currently on 

BASE and SLOT respectively. 
3) CH means the channel number and only 1 or 2 should be set. 
4) DATA should be declared as ARRAY OF BYTE type. 
5) The size of array declared as SIZE is 1~1024.(Unit:  Byte) 
6) Size indicates the size of received data. 
7) When it is executed normally, 1 will be outputted on DONE and STAT, and if an error occurs, 

the status information will be displayed on STAT. 

 
(b) Error 

STAT Status Information Contents 

0 Initial status Status before a command is executed 

1 No error Normal operation 

2 Module setting error 
If the module is not installed on the relevant base slot or it is not the 
Cnet I/F module  

3 Channel setting error If the input range (1, 2) has been exceeded 

4 
There is no received 
data 

If no data has been received  

5 
Communication 
parameter setting 
error 

If the user definition is not set for the communication parameter of the 
Cnet I/F module or link enable is not set 

6 
Command timeout 
error 

If there is no response from the module or the maximum scan time 
(10 scans) has exceeded  

7 
Version compatibility 
error 

If the XGI CPU version is below V3.9, if the XGR CPU version is 
below V2.6 or if the Cnet version is below V3.2  
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(3) SEND_DTR 
 

SEND_DTR Availability Flags 

DTR signal send XGI, XGR - 

Function Block Description 

 

 

Input  REQ: requires to execute the function block 

      BASE : base number 

       SLOT: slot number 

  CH: channel(1 or 2) 

      DTR: 0 or 1 

             

Output  DONE: maintains 1 after operation 

    STAT: completion and ERR info 

  

 
(a) Function  

1) This command sends the DTR (Data Terminal Ready) signal indicating that the preparation for 
communication is completed. 

2) When it is executed normally, 1 will be outputted on DONE and STAT, and if an error occurs, 
the status information will be displayed on STAT. 

 
(b) Error 

STAT Status Information Contents 

0 Initial status Status before a command is executed 

1 No error Normal operation 

2 Module setting error 
If the module is not installed on the relevant base slot or it is not the Cnet 
I/F module 

3 Channel setting error If the input range (1, 2) has been exceeded 

4 DTR setting error If the input range (0, 1) has been exceeded 

5 
Communication 
parameter setting 
error 

If the user definition is not set for the communication parameter of the 
Cnet I/F module or link enable is not set 

6 
Command timeout 
error 

If there is no response from the module or the maximum scan time (10 
scans) has exceeded  

7 
Version compatibility 
error 

If the XGI CPU version is below V3.9, if the XGR CPU version is below 
V2.6 or if the Cnet version is below V3.2  

 
 
 
 

Notes  

 

 7 is outputted for State during a certain period of time in which the module initialization is completed. 
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(4) SEND_RTS 

 

SEND_RTS Availability Flags 

RTS signal send XGI, XGR - 

Function Block Description 

 

 

Input  REQ: requires to execute the function block 

      BASE : base number 

       SLOT: slot number 

  CH: channel(1 or 2) 

      RTS: 0 or 1 

            

Output  DONE: maintains 1 after operation 

    STAT: completion and ERR info 

  

 

 
(a) Function 

1) This command sends RTS (Request To Send) which is a signal that indicates its own receive 
buffer status 

2) When it is executed normally, 1 will be output and the occurs, the status information will be 
displayed on STAT. 

 
(b) Error 

STAT Status Information Contents 

0 Initial status Status before a command is executed 

1 No error Normal operation 

2 Module setting error 
If the module is not installed on the relevant base slot or it is not the Cnet 
I/F module 

3 Channel setting error If the input range (1, 2) has been exceeded 

4 RTS setting error If the input range (0, 1) has been exceeded 

5 
Communication 
parameter setting 
error 

If the user definition is not set for the communication parameter of the 
Cnet I/F module or link enable is not set 

6 
Command timeout 
error 

If there is no response from the module or the maximum scan time (10 
scans) has exceeded 

7 
Version compatibility 
error 

If the XGI CPU version is below V3.9, if the XGR CPU version is below 
V2.6 or if the Cnet version is below V3.2 

 
Notes  

 

 7 is outputted for State during a certain period of time in which the module initialization is 

completed. 
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10.5.2 XGK Commands 
 

(1) SNDUDATA 

Command 

Applicable area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons
tant 

U N D R 
Error 

(F110) 
Zero 

(F111) 
Carry 
(F112) 

SNDUDATA 

sl - - - - - - - - - O - - - - 

4~7 O - - 

S1 O - O - - - O - - O O O O O 

S2 O - O - - - O - - - O O O O 

S3 O - O - - - O - - - O O O O 

D O - O - - - O - - - O O O O 

 
 

 
 

 
[Area setting] 

Operand Description Data type 

sl Base number and slot number where the Cnet I/F module is installed WORD 

S1 Channel information (1 or 2) WORD 

S2 Start device number where data to be sent is saved WORD 

S3 Size of data to be sent (up to 1024 bytes) WORD 

D Temporary device number to be used internally in the command WORD 

 
[Flag Set] 

Flag Contents 
Device 
number 

Error 
If sl value does not match with base number and slot number where the 
Cnet I/ F module is installed 

F110 

 
(a) Function 

1) This command send the user definition data (UDATA). 
2) Enter the base number and the slot number where the Cnet I/F module is installed currently 

on sl. 
3) S1 indicates the channel number and only 1 or 2 should be set. 
4) S2 indicates the address of start area where UDATA is saved. 
5) S3 indicates the size of UDATA to be sent and data as many as S3, starting from the area 

specified as S2, is transmitted. Up to 1024 data can be transmitted the unit is byte. 
6) D is the temporary area to save command information, and a value to be saved is as follows. 

All initial values are 0, and if the user modifies the data value arbitrarily, the command may 
malfunction. 

CPU area Data size Stratus type 

D WORD Status code 

D+1 WORD Reserved area (Usage 
prohibited) 

D+2 WORD Reserved area (Usage 
prohibited) 

D+3 WORD Reserved area (Usage 
prohibited) 

 
  

SNDUDATA 

COMMAND 
SNDUDAT

A 
S2 S3 sl S1 D 



 

 
Chapter 10 User Frame Definition Communication 

 

10-19 

 

 

 

 
(b) Error 

If sl value does not match with base number and slot number where the Cnet I/ F module is 
installed, the error flag (F110) will be set. 

 
(c) Status Information 

Status code Status Information Contents 

00 Initial status Status before a command is executed 

01 Complete If the command has been executed normally 

02 Module setting error 
If sl value is set for the base or slot where the Cnet I/F module 
is not installed 

03 Channel setting error If the S1 channel information value is not 1 or 2 

04 
Transmitted data size 
setting error 

If the transmitted data size is less than 0 or exceeds 1024 

05 
Communication 
parameter setting 
error 

If the user definition is not set for the communication 
parameter of the Cnet I/F module or link enable is not set 

06 Timeout error 
If there is no response to the command due to Cnet I/F module 
error 

07 
Version compatibility 
error 

If the Cnet version is below V3.2 and the relevant command is 
not supported (If the CPU version is below V4.2, program 
download will not be available.) 

 
(d) Program example 

This command transmits data as many as SIZE, starting from the service area defined as 
DATA to CH slot when REQ which is the status of the input signal is changed from Off to On 
(positive edge). 

 

 
 
 

Notes  

Device D+1~D+3 specified to D is the space where various information used in the 
command is saved. Therefore, the user should not change the value of the relevant area 
arbitrarily. If the value of the relevant area is changed arbitrarily, the command will not 
operate normally. 
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(2) RCVUDATA 

Command 

Applicable area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons
tant 

U N D R 
Error 

(F110) 
Zero 

(F111) 
Carry 
(F112) 

RCVUDATA 

sl - - - - - - - - - O - - - - 

4~7 O - - 

S1 O - O - - - O - - O O O O O 

D1 O - O - - - O - - - O O O O 

D2 O - O - - - O - - - O O O O 

D3 O - O - - - O - - - O O O O 

 

 

 
 

 
[Area setting] 

Operand Description Data type 

sl Base number and slot number where the Cnet I/ F module is installed WORD 

S1 Channel information (1 or 2) WORD 

D1 Start device number where data to be sent is saved WORD 

D2 Size of data to be sent (up to 1024 bytes) WORD 

D3 Temporary device number to be used internally in the command WORD 

 
     [Flag Set] 

Flag Contents 
Device 
number 

Error 
If sl value does not match with base number or slot number where the 
CNET module is installed 

F110 

 
(a) Function 

1) This command receives the user definition data (UDATA). 
2) Enter the base number and the slot number where the Cnet I/F module is installed for sl. 
3) S1 indicates the channel number and only 1 or 2 should be set. 
4) D1 indicates the address of the start area where received UDATA will be saved. 
5) D2 indicates the size of received UDATA and the unit is byte. 
6) D3 is the temporary area to save command information, and a value to be saved is as follows. 

All initial values are 0, and if the user modifies the data value arbitrarily, the command may 
malfunction. 

CPU area Data size Stratus type 

D3 WORD Status code 

D3+1 WORD 
Reserved area  

(Usage prohibited) 

D3+2 WORD 
Reserved area  

(Usage prohibited) 

D3+3 WORD 
Reserved area  

(Usage prohibited) 

 
(b) Error 

If sl value does not match with base number and slot number where the Cnet I/F module is 
installed, the error flag (F110) will be set. 
  

RCVUDATA 

COMMAND 
RCVUDAT

A 
D1 D2 sl S1 D3 



 

 
Chapter 10 User Frame Definition Communication 

 

10-21 

 

 

 

 
(c) Status Information 

Status 
code 

Status Information Contents 

00 Initial status Status before a command is executed 

01 Complete If the command has been executed normally 

02 Module setting error 
If sl value is set for the base or slot where the Cnet I/F module 
is not installed 

03 Channel setting error If the S1 channel information value is not 1 or 2 

04 
There is no received 
data 

If no data has been received 

05 
Communication 
parameter setting error 

If the user definition is not set for the communication parameter 
of the Cnet I/F module or link enable is not set 

06 Timeout error 
If there is no response to the command due to Cnet I/ F module 
error 

07 
Version compatibility 
error 

If the Cnet version is below V3.2 and the relevant command is 
not supported (If the CPU version is below V4.2, program 
download will not be available.) 

  
(d) Program example 

When the status of REQ, which is the input signal, is changed from Off to On (positive edge), 
save data as many as SIZE received from the device area specified as DATA on the CH slot if 
there is received data. 

 

 
 
 

Notes  

(1) device D3 +1~ D3 +3 specified to D is the space where various information used in the 
command is saved. Therefore, the user should not change the value of the relevant area 
arbitrarily. If the value of the relevant area is changed arbitrarily, the command will not operate 
normally. 

(2) The maximum size of received data is 1024 bytes and the device number set as D2 should be 
smaller than (End area of the relevant device– 1024 bytes). 
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(3) SENDDTR 

Command 

Applicable area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons
tant 

U N D R 
Error 

(F110) 
Zero 

(F111) 
Carry 
(F112) 

SENDDTR 

sl - - - - - - - - - O - - - - 

4~7 O - - 
S1 O - O - - - O - - O O O O O 

S2 O - O - - - O - - O O O O O 

D O - O - - - O - - - O O O O 

 

 

 
 

 
[Area setting] 

Operand Description Data type 

sl Base number and slot number where the CNET module is installed WORD 

S1 Channel information (1 or 2) WORD 

S2 DTR (0 or 1) WORD 

D Temporary device number to be used internally in the command WORD 

 
[Flag Set] 

Flag Contents 
Device 
number 

Error 
If sl value does not match with base number and slot number where the 
Cnet I/F module is installed 

F110 

 
(a) Function 

1) This command is a command to send DTR (Data Terminal Ready) signal to communicate that 
communication ready is completed. 

2) Enter the base number and the slot number where the Cnet I/F module is installed for sl. 
3) S1 indicates the channel number and only 1 or 2 should be set. 
4) S2 indicates the RTS value and only 0 or 1 should be set. 
5) D is the temporary area to save command information, and a value to be saved is as follows. All 

initial values are 0, and if the user modifies the data value arbitrarily, the command may 
malfunction. 

CPU area Data size Status type 

D WORD Status code 

D+1 WORD Reserved area (Usage 
prohibited) 

D+2 WORD Reserved area (Usage 
prohibited) 

D+3 WORD Reserved area (Usage 
prohibited) 

 
 

(b) Error 
If sl value does not match with base number and slot number where the Cnet I/F module is 
installed, the error flag (F110) will be set. 
 
 
 
 
 
 
 
 

SENDDTR 

COMMAND 
SENDDTR S2 sl S1 D 
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(c) Status Information 

Status 
code 

Status Information Contents 

00 Initial status Status before a command is executed 

01 DONE If the command has been executed normally 

02 Module setting error 
If sl value is set for the base or slot where the Cnet I/F 
module is not installed 

03 Channel setting error If the S1 channel information value is not 1 or 2 

04 DTR level setting error If the S2 DTR setting value is not 0 or 1 

05 
Communication 
parameter setting error 

If the user definition is not set for the communication 
parameter of the Cnet I/F module or link enable is not set 

06 Timeout error 
If there is no response to the command due to Cnet I/ F 
module error 

07 
Version compatibility 
error 

If the Cnet version is below V3.2 and the relevant command 
is not supported (If the CPU version is below V4.2, program 
download will not be available.) 

 
(d) Program example 

When you change REQ, which is the input signal, from Off to On (positive edge) a DTR (Data 
Terminal Ready) signal that indicates the preparation for communication is completed will be 
sent to the set CH slot. 

 

 
 
 

Notes  

 
 Device D+1~D+3 specified to D is the space where various information used in the 

command is saved. Therefore, the user should not change the value of the relevant area 
arbitrarily. If the value of the relevant area is changed arbitrarily, the command will not 
operate normally. 
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(4) SENDRTS 

Command 

Applicable area 

Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons

tant 
U N D R 

Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

SENDRTS 

sl - - - - - - - - - O - - - - 

4~7 O - - 
S1 O - O - - - O - - O O O O O 

S2 O - O - - - O - - O O O O O 

D O - O - - - O - - - O O O O 

 

 

 
 

 
[Area setting] 

Operand Description Data type 

sl Base number and slot number where the Cnet I/F module is installed WORD 

S1 Channel information (1 or 2) WORD 

S2 RTS setting (0 or 1) WORD 

D Temporary device number to be used internally in the command WORD 

 
[Flag Set] 

Flag Contents 
Device 
number 

Error 
If sl value does not match with base number and slot number where the 
Cnet I/F module is installed 

F110 

 
(a) Function 

1) This command sends RTS (Request To Send) which is a signal that indicates its own receive 
buffer status. 

2) Enter the base number and the slot number where the Cnet I/F module is installed for sl.  
3) S1 indicates the channel number and only 1 or 2 should be set. 
4) S2 indicates the RTS value and 0 or 1 can be set.  1 should be set if you wish to receive data 

from the modem. 
5) D is the temporary area to save command information, and a value to be saved is as follows. 

All initial values are 0, and if the user modifies the data value arbitrarily, the command may 
malfunction. 

 

CPU area Data size Stratus type 

D WORD Status code 

D+1 WORD Reserved area (Usage 
prohibited) 

D+2 WORD Reserved area (Usage 
prohibited) 

D+3 WORD Reserved area (Usage 
prohibited) 

 
(b) Error 

If sl value does not match with base number and slot number where the Cnet I/F module is 
installed, the error flag (F110) will be set. 

 
 
 

(c) Status Information 

SENDRTS 

COMMAND 
SENDRTS S2 sl S1 D 
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Status 
code 

Status Information Contents 

00 Initial status Status before a command is executed 

01 Complete If the command has been executed normally 

02 Module setting error 
If sl value is set for the base or slot where the Cnet I/F module 
is not installed 

03 Channel setting error If the S1 channel information value is not 1 or 2 

04 DTR level setting error If the S2 DTR setting value is not 0 or 1 

05 
Communication 
parameter setting error 

If the user definition is not set for the communication parameter 
of the Cnet I/F module or link enable is not set 

06 Timeout error 
If there is no response to the command due to Cnet I/ F 
module error 

07 
Version compatibility 
error 

If the Cnet version is below V3.2 and the relevant command is 
not supported (If the CPU version is below V4.2, program 
download will not be available.) 

 
(d) Program example 

When you change REQ, which is the input signal, from Off to On (positive edge), an RTS 
(Request To Send) which is the signal that indicates the own receive buffer status will be sent to 
CH slot. 

 

 
 
 

Notes  

 
 Device D+1~D+3 specified to D is the space where various information used in the 

command is saved. Therefore, the user should not change the value of the relevant area 
arbitrarily. If the value of the relevant area is changed arbitrarily, the command will not 
operate normally. 
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Chapter 11 Example program 
 

11.1 Setting method for each operation mode 
 

The operation mode of the Cnet I/F module is classified into the P2P service and the server function. 
 
▶ P2P service: It operates as a client (master) and makes a request to read/write data from the 

destination station. 
▷ XGT client 
▷ LS bus client 

▷ Modbus RTU/ASCII client 

▷ User frame definition communication 
 

▶ Server function: It operates as a server (slave) and responds according to the protocol type when 
requested by the client. 

▷ XGT server 

▷ Modbus RTU server 
▷ Modbus ASCII server  
 

The setting method for each operation mode is as follows. 
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11.1.1 When Operating as the server 
 

Sequ
ence 

Setting 
process 

Setting method 

1 

Connection 
setting 

 

1. Select [Online] ->[Connection Settings] or click the icon ( ). 
2. Set the connection option suitable for user’s environment and click the [Connect]. 

2 
Read I/O 

Information 

Click the [I/O Sync] button from the [Online]→[System Diagnostics]→[I/O information] 
menu, read the information of the module currently installed on the base and add it to 
the project. It operates only when the CPU module is in stop mode. 

3 

Standard 
settings 

      

1. Open the [Standard settings] window by double clicking the Cnet I/F module, and set the 
communication type, communication speed, modem type, data bit, stop bit and station address 
from the setting menu. 

2. Model initialization is only possible when the modem type is a dial-up modem. 
3. Response waiting time: This is the time to wait until a frame is received after transmitting it. 

(1) Operation setting: It can be set when the operation mode is in P2P use during the RS-422/485 
communication. 

(2) Response waiting time = Basic response waiting time + (response waiting time setting value X 
100ms) + inter-character waiting time setting value 

4. Delay time setting: It is used for transmitting a frame after the time delay set by the user. 
(1) Operation setting: It can be set when the communication type is RS-422/485. 
(2) Server operation setting: You can set the server to transmit a frame after a set time delay. (It can 

be used in the B type Cnet I/F module) 
5. Inter-character waiting time: A number of characters received within a set time are processed as 

one frame. It means the interval between characters in one frame, and it can be set regardless of 
operation mode. 

6. Terminating resistance setting, repeater mode and smart server function can be used in the B type 
Cnet I/F module. 

* In the case of using as the Modbus ASCII server, the data bit is 7. 
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Seque
nce 

Setting 
process 

Setting method 

4 

Selecting 
the 

operation 
mode 

1.Select the operation mode of a server to be used by a user. 
2.Cnet I/ F module supports XGT server, Modbus ASCII server and Modbus RTU 

server. 

5 

Write 
parameter 

 

 
 

1.Select [Online] ->[Write] or click the icon ( ). 
2.Put a check mark on the module whose basic setting is completed from standard settings and 
click[OK]. 
3. Click the [OK] button, and when the parameter writing finishes, reset each module. 

6 

Check 
operation 

 

 
 

1.Slect [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or click 

the icon( ). 
2. Click the module, press the right mouse button. 
3. Click [Frame Monitor] or [Status by Service] to check the operation status. 
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11.1.2 When operating as a P2P service(client) 
 

Sequence 
Setting 
process 

Setting method 

1 
Standard 
setting 

The steps 1 to 3 are the same as those in the above case. 
*When set to Modbus ASCII client, the data bit is set to 7 

2 

Operation 
mode 

  

Select Use P2P. 

3 

P2P 
setting 

 

 

1. Right-click the Cnet module in the project tree and select [Add Item] → [P2P 
Communication]. 

2.. Select P2P number(01). 

4 

P2P 
channel 
setting 

 
1.Double click the P2P channel and select protocols for each channel. 
2.User frame definition, XGT client, LS bus client and Modbus RTU/ASCII client are 

supported for the P2P driver. 

 



 

 
Chapter 11 Example program 

 

11-5 

 

 

 

 
 

Sequ
ence 

Setting 
process 

Setting method 

5 

P2P block 
setting 

 

1.P2P block setting values are enabled differently according to the type of client selected in 
the channel settings. 

2.Create the frame in the enabled cell according to the protocol type. 
*In the case of user frame definition, it is available only when the frame is created in the 

user frame definition. 

6 

Write 
parameter 

 

1.Select [Online] ->[Write] or click the icon ( ). 
2.In the Standard settings, check the standard settings and P2P that have been set up, and 
then click the [OK] button. 
3.Click the [OK] button, and when the parameter writing finishes, reset each module. 
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Sequ
ence 

Setting 
process 

Setting method 

7 

Link 
enable 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[Enable 

Link/Services] or click the icon( ). 
2.Check the P2P whose setting is completed and click [Write]. 

8 

Check 
operation 

 
1.Slect [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] 

or click the icon( ). 
2. Click the module, press the right mouse button. 
3. Click [Frame Monitor] or [Status by Services] to check the operation status. 
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11.2 XGT Communication 
 

What is the XGT communication service? 
▶ It is a protocol defied by LS ELECTRIC and is classified into XGT client and XGT server. 

▶ XGT client: requests the server to read/write data Requests read/write date to the server side. 

▶ XGT server:  Responds to the request of the client. 
 
 
The method to use the XGT dedicated communication using the XGT protocol is explained as an 
example. 
 
▶ System configuration 

 
 

▶ Install XGL-CH2A on No. 0 slot of each PLC. 

▶ Dedicated service in channel 1 

▶ Client side setting 

Type Setting content 

CPU XGK-CPUH 

Communication type RS-232C 

Communication 
speed 

38,400 

Data bit 8 

Stop bit 1 

Parity bit None 

Modem type Null modem 

Operation cycle 200ms 

Operation 
status 

Write Save 1 word from M100 address to M100 address on the server side 

Read 
Save 1 word of D100 address on the server side to M1100 address on 

the client side 

 
▶ Server side setting 

Type Setting content 

CPU XGK-CPUH 

Communication type RS-232C 

Communication 
speed 

38,400 

Data bit 8 

Stop bit 1 

Parity bit None 

Modem type Null modem 

Station No 1 
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11.2.1 Server side setting 
 

Set the server in the system shown above as follows. 

Sequ
ence 

Setting 
process 

Setting method 

1 

Connection 
setting 

 

1. Select [Online] ->[Connection Settings] or click the icon ( ). 
2. Set the connection option suitable for user’s environment and click [Connection]. 

2 
Read I/O 

Information 

Click the [I/O Sync] button from the [Online]→[System Diagnostics]→[I/O information] 
window, read the information of the module currently installed on the base and add it to 
the project. It operates only when the CPU module is in stop mode. 

3 

Standard 
setting 

     

1.Write on channel 1 according to the setting standard of the example system 
2.Operation mode is set as XGT server since it operates as a dedicated communication server. 
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Sequence 
Setting 
process 

Setting method 

4 

Write 
parameter 

 

1.Select [Online] ->[Write] or click the icon ( ). 
2.In the Standard settings, check the basic settings and P2P that have been set up, and 
then click the [OK] button. 
3.Click the [OK] button, and when the parameter writing finishes, reset each module. 
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11.2.2 Client side setting 
 

Set the client in the system shown above as follows. 

Seque
nce 

Setting 
process 

Setting method 

1 

Connection 
setting 

 

1.Select [Online] ->[Connection Settings] or click the icon ( ). 
2.Set the connection option suitable for user’s environment and click the [Connect]. 

2 
Read I/O 

Information 

Click the [I/O Sync] button from the [Online]→[System Diagnostics]→[I/O information] 
window, read the information of the module currently installed on the base and add it to 
the project. It operates only when the CPU module is in stop mode. 

3 

Standard 
settings 

     

1.Write on channel 1 according to the setting standard of the example system 
2.Set it to an arbitrary station number (0~31) since the station number setting is meaningless when 
operating as a client. 
3. Operation mode should always be set to [P2P use] when operating as a client. 
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When [Standard setting] is completed, [P2P channel] and [P2P block] should be set. The 

setting method is shown below. 

Sequ
ence 

Setting 
process 

Setting method 

1 

Communi
cation 

module 
setting 

 
 

1.In the project window, click Cnet I/F module with the right mouse button and select [Add item]→[P2P 
communication]. 

2.Select P2P number(01) and click [OK]. 

2 

P2P 
channel 
setting 

 

Double click [P2P channel] of P2P 01, set [XGT client] for the P2P driver of channel 1 and click[OK]. 

3 Double click [P2P block] in P2P 01. 

4 

Write 
operation 

setting 

 
1. Channel: Select channel 1 which is set as the XGT client in the P2P channel setting. 
2. Select WRITE to perform the write operation. 
3. Operation condition: Use special flag F92 in order to transmit a frame every 200ms. 
4. Method, data type: Select 2 bytes which means individual and word since it is write 1 word. 
5. Number of variables: Select 1 for the number of variables since there is one word. 
6. Destination station number: Select the station address of the server side. 
7. Setting: Set the read area and the save area and click[OK]. 
  1) Read area: Device address where the client side data will be saved 
  2) Save area: Device address where the server side data is saved   
* When all the settings are completed, the font color of the relevant index will change to black. 
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Sequ
ence 

Setting 
process 

Setting method 

5 

Read 
operation 

setting 

 
1.Channel, start condition, method, data type, number of variables and destination station number: It 

is the same as setting the write operation.  
2.P2P function Select READ since the reading operation is carried out. 
3.Setting: Set the read area and the save area and click[OK]. 
  1) Read area: Device address where the server side data is saved 
  2) Save area: Device address where the client side data will be saved   

6 

Write 
parameter 

 

1.Select [Online] ->[Write] or click the icon ( ). 
2.Put a check mark on basic setting and P2P for the module set as the XGT client and click the [OK] 
button. 
3.Click the [OK] button, and when the parameter writing finishes, reset each module. 
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Sequence Setting 
process 

Setting method 

7 
Link 

enable 

 

8 

1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[Enable Link/Services] or 

click the icon( ). 
2. Check the P2P whose setting is completed and click [Write]. 
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11.2.3 Checking the operation status 
 

The communication status of the Cnet I/F module can be checked through the frame 
monitoring of XG5000. The frame monitoring method is the same as follows regardless of 
protocol type. 

Sequ
ence 

Setting 
process 

Setting method 

1 

System 
diagnosis 

 
1.Slect [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or click 

the icon( ). 
2.Click the module, press the right mouse button. 
3.When the screen as shown in the figure above appears, click [Frame monitor]. 

2 

Frame 
monitor 

 

 
 

1.Select Channel 1 from Select channel and click [Start]. 
2.Since the dedicated service is ASCII communication, the frame that operates normally can be 
checked by selecting [View as ASCII]. 
* Select [View as Hex] for Modbus RTU and select [View as ASCII] for Modbus ASCII. 
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11.3 Modbus Communication 
 

The method to use the Modbus RTU mode is explained as an example. 
▶ System configuration 

 
 

▶ Install XGL-CH2A on No. 0 slot of each PLC. 

▶ Modbus communication in channel 2 of the Cnet I/F module which is installed on each PLC 
▶ Client side setting 

CPU XGK-CPUH 

Communication 
type 

RS-422 

Communication 
speed 

38,400 

Data bit 8 

Stop bit 1 

Parity bit None 

Modem type None 

Operation period 200ms 

Operation 
Status 

 

Write 

▶Save 1 word from the client side M100 address to the M1 address of server size 
write word area 
▶Save 4 words from the D0 address on the client side to the write word area from 
the M2 address to M5 address. 
▶Save the 15th bit value from the M1 address on the client side to the 2nd bit of 

the M20 address on the server size write bit area. 
▶Save the value from the 0th bit value to the 15th bit value from the M2 address 

on the client side to the bits from the 0th bit to the 15th bit of the M21 address 
on the server size write bit area. 

Read 

▶Save 1 word value of M2 in the read area on the server side in M160 on the 
client side 
▶Save 4 words from P0 of the read area on the server side in M150 to M153 on 

the client side 
▶Save the 1st bit value of the P2 address in the read bit area on the server side 

to the 1st bit of the M170 address on the client side. 
▶Save bit values from 0th bit to 15th bit of the M10 address on the server side 

write bit area to bits from the 0th bit to the 15th bit of the client side 180 
address.  

▶Server side setting 

CPU XGK-CPUH 

Communication type RS-422 

Communication speed 38,400 

Data bit 8 

Stop bit 1 

Parity bit None 

Modem type None 

Station No 1 

Start 
address 

Read bit P0 

Bit write M0 

Word read P0 

Word write M0 
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11.3.1 Server side setting 

 
Set the server in the system shown above as follows. 

Sequ
ence 

Setting 
process 

Setting method 

1 

Connection 
setting 

 

1.Select [Online] ->[Connection Settings] or click the icon ( ). 
2. Set the connection option suitable for user’s environment and click [Connection]. 

2 
Read I/O 

Information 

Click the [I/O Sync] button from the [Online]→[System Diagnostics]→[I/O 
information] window, read the information of the module currently installed 
on the base and add it to the project. It operates only when the CPU 
module is in stop mode. 

3 

Standard 
setting 

 
1.Write on channel 2 according to the setting standard of the example system. 
2.Set Modbus RTU server for the operation mode since it operates as the dedicated 
communication server. 
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Sequ
ence 

Setting 
process 

Setting method 

4 

Modbus 
setting 

 

1.Start address of bit read area: M00000    2.Start address of bit write area: M00000 
3.Start address of word read area: M00000  4.Start address of write word area: M0000 
*If the XGK CPU is used, the top 4 digits from the address on Read/Write bit area is the 
word address, and the bottom digit is the bit address.(P00110:0th bit of P11th word)  

5 

Paramete
r write 

 

1.Select [Online] ->[Write] or click the icon ( ). 
2.In the Standard settings, check the basic settings and P2P that have been set up, and 
then click the [OK] button. 
3.Click the [OK] button, and when the parameter writing finishes, reset each module. 
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11.3.2 Client side setting 
 

Set the client in the system shown above as follows. 

Sequ
ence 

Setting 
process 

Setting method 

1 

Connection 
setting 

 

1.Select [Online] ->[Connection Settings] or click the icon ( ). 
2.Set the connection option suitable for user’s environment and click the [Connect]. 

2 
Read I/O 
Information 

Click the [I/O Sync] button from the [Online]→[System Diagnostics]→[I/O 
information] window, read the information of the module currently installed 
on the base and add it to the project. It operates only when the CPU 
module is in stop mode. 

3 

Standard 
setting 

 

1.Write on channel 2 according to the setting standard of the example system. 
2.In the case of operating as the client, the station address setting becomes 

meaningless. Set any station address (0~31).  
3.Operation mode should always be set to [P2P use] when operating as a client. 
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When [Standard setting] is completed, [P2P channel] and [P2P block] should be set. The 

setting method is shown below. 

Sequ
ence 

Setting 
process 

Setting method 

1 

Communic
ation 

module 
setting 

 
1.In the project window, click Cnet I/F module with the right mouse button and select [Add item]→[P2P 

communication]. 
2.Select P2P number(01) and click [OK]. 

2 

P2P 
channel 
setting 

 
Double click [P2P channel] of P2P 01, set [Modbus RTU client] for the P2P driver of channel 1 and 
click[OK]. 

3 Double click [P2P block] in P2P 01. 

4 

Write 
operation 
settings(1) 

 
▶Save 1 word from the client side M100 address to the M1 address of server size write word area 

1. Channel: Select Channel 2 which is set as the Modbus RTU client in the P2P channel setting. 
2.P2P function: Select WRITE since the writing operation is carried out. 
2. Operation condition: Use special flag F92 in order to transmit a frame every 200ms. 
4.Method, data type: Select individual and word since it is 1 word. 
5.Destination station number: Select Station address 1 of the server side. 
6.Setting: Set the read area and the save area and then click[OK]. 

   (1) Read area: address of the device on client side where data is saved (M100) 
   (2) Storage area: Device address where the server side data is saved(0x40001:M1 address)    
* When all the settings are completed, the font color of the relevant index will change to black. 
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Sequ
ence 

Setting 
process 

Setting method 

5 

Write 
operation 
settings(2) 

 
▶Save 4 words from the D0 address on the client side to the write word area from the M2 address 
to the M5 address on the server side 
1.Channel, P2P function, start address and partner station number: The sequence is the same as 
No. 4.  
2.Method, data type: select continuous and word since it is continuous 4 word write.  
3.Size of data: enter 4 since it is 4 words.  
4.Setting: set the read area and the save area and then click[OK].  
  (1) Read area: start address of the device on client side where data is saved (D0)  
  (2) Storage area: start address of the device on server side where data will be saved(0x40002:M2 
address).     

6 

Write 
operation 
settings(3) 

 
▶ Save the 15th bit value from the M1 address on the client side to the 2nd bit of the M20 address 

on the server size write bit area. 
1.Channel, P2P function, start condition, method, and destination station number: The sequence 

is the same as No. 5.  
2.Data type: select bit  
3.Setting: set the read area and the save area and then click[OK].  

    (1) Read area: device address where the client side data is saved (M1.F: 15th bit of M1)   
    (2) Storage area: device address where the server side data will be saved (0x00142: 2nd bit of 
M20 address)    

* When M1F is entered, it will be converted to M0001F automatically in XG5000. 
* The device address which will be saved on the server side is a Hex number. 
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Sequence 
Setting 
process 

Setting method 

7 

Write operation 
settings(4) 

 

▶Save the value from the 0th bit value to the 15th bit value from the M2 address on the client 
side to the bits from the 0th bit to the 15th bit of the M21 address on the server size write bit 
area.  
1.Channel, P2P function, start condition, data type: the sequence is the same as No. 6  
2. Method: Select Continuous.  
3.Setting: set the read area and the save area and then click[OK].  

   (1) Read area: start address of the device on client side where data is saved (M2.0)  
   (2) Save area: device address where the server side data is saved(0x00150)   

8 

Read 
setting(1) 

 

▶ Save 1 word value of the M2 address in the server side write word area to the client side 
M160 

1) Channel, start condition, method, data type and destination station number: the sequence 
is the same as No. 4.  

2.P2P function: Select READ.  
3.Setting: set the read area and the save area and then click[OK].  

   (1) Read area: device address where the server side data is saved(0x40002).  
   (2) Save area: device address where the client side data is saved((M0160)    

9 

Read 
setting(2) 

 

▶ Save 4 words from P0 address on the server side read word area to the M150 address on 
the client side  

1.Channel, start condition, method, data type and destination station number: the sequence 
is the same as No. 5.   

2.P2P function: Select read.  
3.Setting: set the read area and the save area and then click[OK].  

   (1) Read area: device address where the server side data is saved(0x30000).  
   (2) Save area: device address where the client side data is saved((M0150)  
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Sequence 
Setting 
process 

Setting method 

10 

Read 
setting(3) 

 

▶Save the 1st bit value of the P2 address in the read bit area on the server side to the 
1st bit of the M170 address on the client side. 
1.Channel, start condition, method, data type and destination station number: the 

sequence is the same as No. 6.   
2.P2P function: Select read. Select READ. 
3.Setting: set the read area and the save area and then click[OK]. Set the read area 

and the save area and then click[OK]. 
   (1) Read area: device address where the server side data is saved(0x00021).  
   (2) Save area: device address where the client side data is saved((M170.1)  

11 

Read 
setting(4) 

 

Save bit values from 0th bit to 15th bit of the M10 address on the server side write bit 
area to bits from the 0th bit to the 15th bit of the client side M180 address.  
1.Channel, start condition, method, data type and destination station number: the 

sequence is the same as No. 7.   
2.P2P function: Select read.  
3.Setting: set the read area and the save area and then click[OK]. Set the read area 

and the save area and then click[OK]. 
   (1) Read area: device address where the server side data is saved(0x100A0).  
   (2) Save area: device address where the client side data is saved((M180.0)  
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Sequence 
Setting 
process 

Setting method 

12 

Parameter 
write 

 

1.Select [Online] ->[Write] or click the icon ( ). 
2. Put a check mark on basic setting and P2P for the module set as the Modbus RTU client and 

click the [OK] button. 
3.Click the [OK] button, and when the parameter writing finishes, reset each module. 

13 

Link 
enable 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[Enable Link/Services] or 

click the icon( ). 
2. Check the P2P whose setting is completed and click [write]. 
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11.4 User frame definition communication 
 

11.4. 1 In case of communicating with another company's product 
 

The communication method using the user frame definition communication is explained as an example. 
 
▶ System configuration 

 
 

 
▶ Connect the PLC and the temperature controller using the Cnet I/F module 

Device name 

CPU module XGI-CPUU 
Temperature controller of 

Hanyoung PX7*Note2 Communication 
module 

XGL-CH2A 

Operation mode Client Server 

Protocol User frame definition PC Link 

Communication 
type  

RS-485 RS-485 

Communication 
speed 

9,600 9,600 

Data bit 8 8 

Stop bit 1 1 

Parity bit None None 

Station number 0 1 

Delay time*Note 1) 100ms - 

Operation 
Read the current value and set temperature value of the temperature 
controller at 1 second intervals and save the current value to the %MB200 
address and the set temperature value to the %MB210 address 

 
Note 1) Delay time is set in RS-422/485 communication and is designed to prevent the frame 

from being broken when communicating with the other device with slow response. The 
setting value varies by the destination device and distance, and a value between 50ms 
and 100ms is generally set. 

Note 2) For the contents related to the temperature controller, refer to the user's manual of 
Hanyoung temperature controller (http://hynux.com). 

  

http://hynux.com)/
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▶ PC Link frame structure 
The frame of the temperature controller is configured with ASCII string and you can read and 
write the contents of the defined D and I registers.  
The protocol includes the STD standard protocol and SUM protocol where check sum is added 
to the standard protocol, and each protocol is selected as the parameter. The standard protocol 
is “STD”, and its structure starts with the start character STX(0x02) and ends with the 
termination character CR(0x0D) LF(0x0A). The following table shows the frame structure of the 
standard protocol and Sum protocol. 
Please refer to the PLC communication example of HANYOUNG NUX (http://hynux.com) for 
details on the command and data structure. 

 

 
[Standard protocol structure] 

 
[SUM protocol structure] 

 
▶ Writing an example frame 
This example is the case of saving the current value and set value of the temperature controller 
on the M device area of the PLC. The following table shows the frame that requests reading 
data from the continuous area and the frame that responds to the request for reading data. 

 
[Request frame] 

 
[Response frame] 

▷ DRS: It is a command to read the consecutive values of D register, and the number of data to 
be read on the frame and the start address of D register should be set. 

▷ In the example, enter 2 for the number of data and 01 for the start address of the current 
value. 
  

http://hynux.com/
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▶ Standard setting 
Carry out the basic setting according to this system by referring to 11.1.2. 
 
▶ Writing read data request frame 

The method to write a frame in XG5000 is as follows. 
 

Writing request frame (transmission frame) 

Sequence Setting method 

1 

 
1.In the project window, click Cnet I/F module with the right mouse button and select [Add 

item]→[P2P communication]. 
2.Select P2P number(01). 
3.Double click [P2P channel] and select the  [User Frame Definition]in [Channel 2]. 

2 

 
1.Click the User frame definition and press the right mouse button. 
2.Click [Add item]→[Add group], enter the frame name (DRS) you wish to write on the group 

name and select send for the frame type. 

3 

       
1.Click “Add frame" and add HEAD, TAIL and BODY.  
2. In this example, test is entered as the name of the BODY. 
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Sequence Setting method 

4 

  
1.When you double click HEAD, the setting screen for the segment called DRS.HEAD will be 

displayed. 
2.Name of segment setting screen varies by frame.(frame name. name of head/tail/body) 
3.Select [numerical constant] for the type and select Hex value [02] that indicates STX for Data in the 

segment setting window as shown in the figure above. 

5 

 

1.When you double click TAIL, the setting screen for the segment called DRS.TAIL will be displayed. 
2.Select [numerical constant] for the type and enter [0D] and [0A] which are Hex values indicating CR 

and LF for Data on the above figure and segment setting window. 

6 

  

1.When you double click BODY, the setting screen for the segment called DRS.test will be displayed. 
2.Write a frame that makes a request to read data value of two continuous areas with No. 1 station 

address as the start address.  
3.When writing a frame through the segment setting window, the size of each segment is 10 or less. 

7 

  

This is the result of writing the whole frame to request read data. 
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▶Write temperature controller response receive frame 

Writing response frame (Receive frame) 

Sequence Setting method 

1 

 

1.Write the frame in the same way as writing sequence 2 of read data request frame. 
2.The frame name is DRS_RECE. 

2 

       

1.Click 'Add frame' and add HEAD, TAIL and BODY. 
2.In this example, RECE_DRS is entered as the name of the BODY. 

3 
The method to write HEAD and TAIL is same as writing sequence No 4 and 5 of the read data request 

frame. 

4 

    
1.Since the current temperature value set for MB200 should be saved to MB210, as the description of 

operation in the system configuration above, the save area for data 1 and data 2 should be set. 
2.Since the size of data 1 and 2 is 4 byes as identified in the structure of the response frame in the 

exemplary frame creation, the type is a fixed size variable, and the size is 4 when entered in the 
segment. 

3.Check the Specify Memory to select the storage area of data. 

5 

  
This is the result of writing the whole frame of response that receives data response by the temperature 

controller. 
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▶Frame write 

Sequen
ce 

Setting method 

1 

 
1.Double click the [P2P block] of P2P 01. 
2.Enter the channel (user frame definition) selected from the P2P channel. 
3.Select SEND in the case of the transmission frame or select RECEIVE in the case of the 
reception frame for the P2P function. 
4.Start condition is enabled only when the P2P function is SEND. 
5.Use [_T1S] which indicates 1 second for the starting condition since data is read once a 
second. 
6.Click the reception frame settings to set the save area of the current temperature value and 
setting value. 

2 Download the parameter and carry out link enable.  

 
▶Checking data   
Checks if the written frame transmits and receives normally. 

Sequence Setting method 

1 

 
 

1.Slect [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the module, press the right mouse button. 
3.Click [Frame Monitor] or [Status by Service] to check the operation status. 
4.If the frame is erroneously written, the message [unknown] is displayed in the processing 

result. 

2 Check the data of device area set through the device monitoring of XG5000. 
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11.4. 2 In case of communication using P2P complete flag as the start condition 
 

▶ P2P flag? 
The P2P flag is the flag created when Use P2P is set for the operation mode and the frame 
reception according to each block of 8 P2P has been completed. Since the P2P flag remains in 
the On state when the reception is completed, it is necessary to reset the reception completed 
flag when the P2P flag is used as the starting condition. 
 
▶ Description of operation  

 
▷ PLC 1 sends the frame called "A" at 2 second intervals. 

▷ PLC 2 sends the frame called ‘B’ immediately when it receives the frame called ‘A’.  

▷ PLC 1 sends the frame called "C" immediately when it receives the frame called "B". 
 
▶ System configuration  
The system configuration and operation method used are explained using an example. 

 PLC 1 PLC 2 Note 

CPU XGK-CPUH XGK-CPUH - 

Communication 
module 

XGL-CH2A XGL-CH2A - 

Operation mode Use P2P Use P2P - 

Protocol User frame definition User frame definition - 

Communication 
type 

RS-232C RS-232C - 

Communication 
speed 

115,200 115,200 - 

Data bit 8 8 - 

Stop bit 1 1 - 

Parity bit None None - 

Station number 0 0 - 

P2P number P2P 02 P2P 03 - 

Operation 

1.PLC 1 sends the frame called "A" at 2 second intervals. 
2.PLC 2 sends the frame called ‘B’ immediately when it receives the frame called ‘A 
3.PLC 1 sends the frame called "C" immediately when it receives the frame called 
"B". 

 

TRX data 
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▶P2P flag number  

P2P 02 P2P 03 

Name of flag Device address Name of flag Device address 

_P2P2_NDR00 L10090 _P2P3_NDR00 L13930 

_P2P2_NDR01 L10150 _P2P3_NDR01 L13990 

_P2P2_NDR02 L10210 _P2P3_NDR02 L14050 

 
▶Frame structure 
The user frame definition communication is available only when the transmission frame 
and the reception frame have the same structure. 

PLC 1 PLC 2 

Name of 
frame 

Operation Data 
Name of 

frame 
Operation Data 

Send 1 Send A Rece1 Receive A 

Rece1 Receive B Send 1 Send B 

Send 1 Send C Rece1 Receive C 

 
▶Basic setting 
Carry out the basic setting according to this system by referring to 11.1.2. 
 
▶Frame write 
The method to write a frame in XG5000 is as follows. 

Sequence Setting method 

1 

 

 
 

1.In the Project window, click Cnet module with the right mouse button and select [Add 
item]→[P2P communication]. 

2.Select P2P number(02) and click [OK]. 
3.Double click [P2P channel] and select the [User Frame Definition]in [Channel 1]. 

2 

 
1.Click the User frame definition and press the right mouse button. 
2.Click [Add item]→[Add group], enter the frame names to write on the group name 

and select transmission for the frame type. 
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Seque
nce 

Setting method 

3 

 
1.Click send1[Transmission] and click the right mouse button. 
2. Click Add frame, select BODY for Type and enter the body name on Name. 

4  
1.When you double click Body, the setting screen for the segment called send1.a will be 
displayed. 
2.Name of segment setting screen varies by frame.(frame name. name of head/tail/ bodies) 
3.From the segment setting screen, select [String constant] for Type and enter [a] which is 

the data of the above frame structure on Data. 

5 

  
In the same way with NO. 2~4, enter PLC 1 side frame name, operation method and data of 
frame structure. 

6 

  
In the same way with NO. 1.5, enter PLC 2 side frame name, operation method and data of 
frame structure. 
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▶P2P block setting 

Setting from PLC 1 side 

Sequen
ce 

Setting method 

1 

 

1.Double click the [P2P block] of P2P 02. 
2.Enter the channel (user frame definition) selected from the P2P channel. 
3.Select [SEND] in the case of the send frame or select [RECEIVE] in the case of the receive frame 

for the 3.P2P function. 
4.Start condition is enabled only when the P2P function is[SEND]. 
5.Enter [F92] since the first frame (A) of PLC 1 sends data every two seconds. 
6.Select the frame by referring to the PLC 1 side frame name from the above frame structure. 
7.The starting condition of the frame called send3.c is transmitted after data called [b] is received 

from PLC 2, so enter L010150 which is the device address of the flag indicating that 1st data 
reception of P2P No. 2 is completed on the starting condition. 

Setting from PLC 2 side 

2 

 

Enter P2P block in the same way with No. 1 by referring to the above frame structure. 

3 Download the parameter and carry out link enable. 

 
▶Writing 2P flag reset program 
The P2P flag is On when the data transmission or reception is completed, so the P2P flag 
should be reset for every scan in order to transmit or receive continuously. Therefore, the 
program that resets the device address of the P2P flag set as the starting condition in the P2P 
block using the reset coil after the last reception flag is On should be inserted. 

Program 

 

1.Reset P2P flag set as the starting condition in the P2P block in order when the second block of P2P 03 
which is the P2P flag received last is On. 

2.The flag of the second block in P2P 03 is also reset, so each flag remains in the Off state when the next 
frame is transmitted or received. Therefore, positive edge (changing from 0 to 1) that occurs when the 
P2P flag is On is recognized as the starting condition and data will be transmitted or received. 
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11.5 Inverter communication with HMI through Cnet I/F module 
 

 The system that controls HMI and the inverter using the Cnet I/F module that operates as the XGT 
server and Modbus client is explained as an example. 

 
◆ In the above system,  LS ELECTRIC Co.,Ltd.'s XP50 and SV-iG5A are used for the HMI 

and inverter. 
 

 
▶ It is possible to request HMI(XP50) to monitor the status of a sub device through the Cnet I/F 

module. HMI always operates as the  client (master) and the Cnet I/F module operates as the 
server that responds to XP50's request. 

 
▶ Inverter (SV-iG5A) takes instructions through the Cnet I/F module. At this time, the Cnet I/F 

module operates as the client (master) and the inverter operates as the server. 
 
  
▶ The communication parameter values are as follows. 

 HMI 1 HMI 2 INV 

Communication type RS-232C RS-485 RS-485 

Communication 
speed 

38,400 38,400 19,200 

Data bit 8 8 8 

Stop bit 1 1 1 

Parity bit None None None 

Modem type None None None 

Station number*Note 1 1 1 1~3 

 
Note 1)If the channel of the Cnet I/F module is different, there is no effect on the system 

operation even if the station address is duplicated. 
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▶ Each device operates as follows. 

Device name Contents 

HMI 1 

Write M1 bit: inverter 1 forward 
Write M2 bit: inverter 2 forward 
Write M3 bit: inverter 3 forward 
Write M4 bit: inverter 1 reverse 
Write M5 bit: inverter 2 reverse 
Write M6 bit: inverter 3 reverse 
Write M7 bit: Inverter 1 stop 
Write M8 bit: Inverter 2 stop 
Write M9 bit: Inverter 3 stop 

HMI 2 

Write M20 bit: inverter 1 speed increase 
Write M24 bit: inverter 2 speed increase 
Write M27 bit: inverter 3 speed increase 
Write M121 bit: inverter 1 speed decrease 
Write M125 bit: inverter 2 speed decrease 
Write M128 bit: inverter 3 speed decrease 

XGL-CH2A(channel 1) Execute the command requested by HMI 1 

XGL-CH2A(channel 2) Operates as the Modbus RTU client that controls the inverter 

XGL-C42A(channel 1) Execute the command requested by HMI 2 

INV 
Operates as the Modbus RTU server that executes a command requested 
by XGL-CH2A (channel 2) 

 
▶ Set each item of the XP builder as follows. 

Seque
nce 

Setting method 

1 

 

1.Select XP50 for [XP Panel model]. 
2.Set LSIS-XGT(LINK) for the controller which operates as the communication module and 
click [Close]. 
3.For contents related to creation setting, refer to the user's manual of XP builder. 
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Sequence Setting method 

2 

 

1.Set HMI 1 as follows. 
(1) Select [Common]→[Project property]→[Device setting]. 
(2) Select RS-232C for the protocol. 
(3) Select detailed setting connection and set as shown in the screen. 

3 

 
1.Set HMI 2 as follows. 

(1) Select [Common]→[Project property]→[Device setting]. 
(2) Select RS-422 / 485 for the protocol. 
(3) Select detailed setting connection and set as shown in the screen. 

 
▶ Set the inverter as follows. 
 

Sequence Setting method 

1 
(1)Drv setting (Operation command method): No. 3 (Operate through the RS-485 
communication) 
(2)Frq setting (Frequency setting method): No. 7 (Operate through the RS-485 communication) 

2 

(1)I59 (communication protocol setting): 0 (Modbus RTU)  
(2)I60 (inverter station number setting): 1~3 stations (One station per inverter)  
(3)I61 (communication speed setting): No. 4 (19,200[BPS]) 
(4)I65 (parity/stop bit setting): 0 (no parity), stop bit (1))  

For detailed contents related to the inverter, refer to the user's manual for SV-iG5A from the download 
center of our homepage.http://www.ls-electric.com/  

 

http://www.ls-electric.com/
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▶ Set XGL-CH2A as follows. 

Sequ
ence 

Setting method 

1 

      
1.Set Channel 1 according to the operation standard of the example system. 
2.Set Channel 2 according to the operation standard of the example system. 

2 
 

Enter K1, K2 and K3 that are the starting conditions of each station for the inverter. 

3 

 

 

 
 

1.The start address of the area where control data of inverter No. 1 is M100 and the start address of the inverter 
where this data is saved is 0x40004 address. *Note 1)  

2.The start address of the area where control data of inverter No. 2 is M200 and the start address of the inverter 
where this data is saved is 0x40004 address. 

3.The start address of the area where control data of inverter No. 3 is M300 and the start address of the inverter 
where this data is saved is 0x40004 address. 

Note 1) For the contents related to the Modbus address area when controlling SV-iG5A using the 
Modbus communication, refer to Chapter 9. 
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▶ Set XGL-C42A as follows 

Sequence Setting method 

1 

      

Set Channel 1 according to the operation standard of the example system. 
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▶ The PLC program written using the XG5000 is as follows. 

Sequence Program 

1 

 

2 

 

3 

 

4 
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Sequence Program 

5 

 

6 
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11.6 SMS transmission method using the CDMA modem 
 

SMS can be transmitted using the CDMA modem by using the UDATA function of the Cnet I/F 
module. This function can be used when the OS version satisfies the following condition. 
 

 Cnet I/F module: V3.2 or higher   
 XGK CPU module: V4.3 or higher  
 XGI CPU module: V3.9 or higher 
 XGR CPU module: V2.6 or higher 
 XG5000: V3.7 or higher 
 

This example is the case of transmitting a message using the BSM-856R and RCU-890 CDMA 
modem.  
 
▶ System configuration 
 

 

 
 

▶ The Cnet I/F module controls the CDMA modem using the RS-232 communication. AT 
command is used for controlling the CDMA modem. 

 
▶ The CDMA modem receives the AT command sent by the Cnet I/F module and carries out the 

functions including modem setting, making a call, SMS send and receive and M2M modem 
connection. Since the AT command varies by modem manufacturer, refer to the user's manual 
related to the relevant product when using the modem. In case the modem uses RS-232C 
DTR/RTS, the DTR/RTS signal can be controlled using SEND_DTR and SRND_RTS among the 
UDATA commands for normal communication. 
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▶ The communication parameter values are as follows. 

Classification BSM-856R RCU-890 

Communication 
type 

RS-232C RS-232C 

Communication 
speed 

115,200 115,200 

Data bit 8 8 

Stop bit 1 1 

Parity bit None None 

Note 1) 115,200 is set as the default communication speed of the BSM-856R and RCU-890 at 
the time of shipping. Change the communication speed according to the usage. For 
detailed contents, refer to the user's manual related to the relevant modem. 

 
▶ Set XGL-C22A as follows. 

Sequence Setting method 

1 

      

1.Set the communication parameter of the channel (channel 1) connected to the CDMA 
modem. Set the communication speed (115,200), data bit (8), stop bit (1) and parity bit 
(NONE). 

2.Set P2P usage for the operation mode of the channel to be used. 

2 

      

1.Set User frame definition for the P2P driver in the P2P channel setting. 
2.Enable the relevant P2P block from Link Enable. 
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▶ Set DTR/RTS as follows. 
 Some CDMA modems use a modem signal for the RS-232 communication. Therefore, in case 
of communicating with the modem, DTR/RTS should be set. For detailed contents, refer to the 
user's manual related to the relevant CDMA modem. 

 
 

  

Sequence DTR/RTS setting 

1 
 

[XGI Instruction] 
 

 
[XGK Instruction] 

 

1.Control the DTR/RTS signal level of the modem connection port using 
SEND_DTR/SEND_RTS. 
2.If BSM-856R and RCU-890 are used, set SET(1, Maintain connection) for the signal of 

DTR and RTS. 
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▶ The program that sends SMS using the XGI command is as follows. 

Sequence Program example (BSM-856R SMS send)  

1 

 
1 Create an AT command for SMS send of BSM-856R as shown above. 
  (4098,,,,'at the back of the caller's number is the BSM-856R modem command for SMS send.) 
2.The example program is the command to send the string‘ Hello’. BSM-856R should enter the 

string to be transmitted after converting it into a hex number. A command may be added 
according to the string to be sent. 
(String Hello ➔ Hex : 48656C6C6F) 

3.30 data of SMS_SND0 and 21 data of SND1 are saved to variable CON_DATA[51] in bytes. 
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Sequence Program example (BSM-856R SMS send) 

2 

 

Transmit the created AT command through the CDMA modem connection port. 

3 

 

1.Receive‘OK’ string using RCV_UDATA.  
When the AT command is delivered to the modem successfully using SEND_UDATA, the 
modem will send ‘OK’. 

2.Execute the RCV_UDATA command again and receive the‘$006’ string. When it is received 
normally, the SMS transmission completed will be displayed.  If it is not received normally, 
the connection status of the modem to the communication network should be checked. 
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Sequence Program example (RCU-890 SMS send) 

1 

 

1.Create the AT command for RCU-890 SMS transmission just as the example program in 
Sequence 1. 
2.The example program is the command to send the string‘ TESTMSG’. Enter the string to be 

transmitted in ASCII value for RCU-890. A command may be added according to the string to 
be transmitted. 

2 

 

Transmit the created AT command through the CDMA modem connection port. 
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Sequence Program example (RCU-890 SMS send) 

3 

 

1.Receive"*SKT*PRIMO:0’ and "OK" string through RCV_UDATA. When the AT command is 
delivered to the modem normally using SEND_UDATA, the modem will send  
'*SKT*PRIMO:0’ and ‘OK’. 

2.Execute the RCV_UDATA command again and receive the "*SKT*MOACK:0,1’ string. When it 
is received normally, the SMS transmission completed will be displayed. 
‘If '*SKT*MOACK:0,0‘ is received, the connection status of the modem to the communication 

network should be checked. 
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▶ The program that sends SMS using the XGK command is as follows. 

Sequ
ence 

Program example (BSM-856R SMS send) 

1 

 

 
 

 
 

 
Check if the modem is normal. 
  “AT”+ 0x0D(ASCII character CR): 3 bytes  

2 

 

 
 

 
 

 

Set 129 which is the data mode for the modem mode. 
    “AT + CRM = 129”+0x0D(ASCII character CR): 11 bytes  

3 

 

 
 

 
 

 
 

1.Making as call: Connect to 010-9471-4031  
   “ATDT01094714031”+ 0x0D(ASCII character CR): 16 bytes 
2.If [CONNECT] character is received, it indicates that the phone connection is completed. 
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Sequenc
e 

Program example (BSM-856R SMS send) 

4 

<Send from Slot 1>  

 
 

 
 

 
 
< Receive from Slot 2> 

 
 

 
 

 
Data send and receive: send“0123456789” 10 bytes from Slot 1 and check if it is received by Slot 
2.  
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Chapter 12 Diagnosis function 
 

You can check the system and network status using the diagnosis function of the XG5000. Main 
items that can be diagnosed are as follows. 
 
▶ CPU status 

▶ Communication module Information 
▶ Frame monitor  

▶ Loop-back test  

▶ Status by service  

▶ Media Information 
▶ View Communication Module Log 
▶ Save Communication Module Log 

 

12.1 XG5000 Diagnosis Function 
 

 

Setting 
content 

Setting method 

System 
diagnosis 

 
1.Slect [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the relevant module and click the right mouse button. 
3.When the above screen is displayed, you can check the status by clicking [Frame monitor] or 

[Status by service]. 

 
▶Check CPU status  

Contents to 
check  

Detail result 

CPU 
module 

information 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the CPU module and click the right mouse button. 
3.When you click [CPU module information], you can check the status of the CPU module. 
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▶ Communication module Information 

Contents to 
check 

Detail result 

Communica
tion Module 
Information 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the Cnet I / F module and click the right mouse button. 
3.Click [Communication module information] to check the status of communication module. 

 
▶ Contents of communication module information item  

Item Contents 

Module type Type of communication module which is being diagnosed 

Base Number 
Indicate the base information of the communication module 
currently being diagnosed. 

Slot No. 
Indicate the slot number of the communication module 
currently being diagnosed. 

Station number 
of channel 1 

Station number used in the dedicated service and P2P of 
channel 1 

Channel 1 
connection 
method 

Information communication type (RS-232C, RS-422) of 
channel 1 

Station number 
of channel 2 

Station number used in the dedicated service and P2P of 
channel 2 

Channel 2 
connection 
method 

Information communication type (RS-232C, RS-422) of 
channel 2 

Hardware error 
status 

Whether the hardware of the communication module is 
normal or not 

Hardware 
version 

Hardware version of communication module 

OS Version OS version of communication module 

P2P Displays enable/disable  

Parameter 
information 

Indicates basic communication parameter error information 
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▶ Frame monitor  
Check whether a frame transmitted or received through Cnet I/F module is normal or not by using the 
frame monitor of XG5000. 

Contents to 
check 

Detail result 

Frame monitor 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the Cnet I / F module and click the right mouse button. 
3.Click [Frame Monitor] to monitor the communication status. 

 
▶ Detailed contents of frame monitor 

Item Contents 

Standard 
information 

Base No. 
Indicate the base information of the communication 
module currently being diagnosed. 

Slot No. 
Indicate the slot number of the communication 
module currently being diagnosed. 

Media 
information 

Communication 
type 

Communication type of the channel which is being 
monitored 

Communication 
speed 

Communication speed of the channel which is being 
monitored 

Select view 

View as HEX Displays frame data in Hex value 

View as ASCII Displays frame data in ASCII value 

View IFG during 
reception (connect) 

If the reception frame has been received in multiple 
parts, display the time interval between frames in 
0.1ms and view on one line 

View IFG during 
reception (Split) 

If the reception frame has been received in multiple 
parts, display the time interval between frames in 
0.1ms and view as the split frame unit. 

Monitor options Select channel Select a channel you wish to monitor 

Frame monitor 
window 

Type Indicates the transmitted and received frames 

Process result 

Indicates the protocol type 
1) XGT server 
2) XGT client 
3) Modbus server 
4) Modbus client 
5) User frame definition 
6) Unknown: Frame that cannot be processed 

Size Length of monitored frame 

Time Indicates the time of send/receive 

Frame data Indicates the data of transmitted/received frame 

File save 
Save the frame monitoring contents to an Excel file 
format 

Start Start frame monitoring 

Stop Stop monitoring  
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▶ Loop-back test  

Contents to 
check 

Detail result 

Module 
wiring 

method 
(XGL-
CH2B) 

              
1.Be sure to set the server operation mode for the module you wish to test. 
2.In case of RS-422 -422/485 communication, set RS-422 for the basic parameter. 
3.The P2P link enable of the module you wish to test should be disabled (delete the check 
mark). 
4.Wire according to each communication port as shown in the figure above. 

(1) RS-232C Communication: Connect No. 2 and No. 3 pin of the port. 
(2) RS-422 Communication: Connect the TX+ and RX+ pins and the TX- and RX- pins of the 

port. 
5.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
6.Click the Cnet I / F module and click the right mouse button.  
7. You can check the module status by clicking [Loop-back test]. 

Loop-back 
test 

 
Select a channel you wish to test and click [Reflesh]. 
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▶ Status by service 

Contents to 
check 

Detail result 

Dedicated 
service 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the Cnet I / F module and click the right mouse button. 
3.Click [Status by Services], and then click [Dedicated Service]. 
4.Click [Multiple Reading] to check the status of each service. 

P2P 
service 

 
1.Select [Online] ->[Communication Module Settings and Diagnosis] ->[System Diagnostics] or 

click the icon( ). 
2.Click the Cnet I / F module and click the right mouse button. 
3.Click [Status by Service], and then click [P2P Service]. 
4.Click [Multiple Reading] to check the status of each service. 
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▶ Detailed contents of each service 

Classification Item Contents 

Dedicated 
service 

Standard 
information 

Base No. 
Base position of the relevant module that uses the 
dedicated service 

Slot No. 
Slot position of the relevant module that uses the 
dedicated service 

Link Type 
Type of communication module which is being 
used 

Dedicated service information 
Indicates the type of driver used for each 
respective channels 

Detailed 
information 
window 

Port number Displaying the channel number 

Service count 
Displays the number of dedicated service 
communication 

Error count 
Displays the number of errors that occurred during 
dedicated service communication 

Status 
Indicates the communication status of the 
dedicated service 

P2P service 

Standard 
information 

Base No. 
Base position of the relevant module that uses the 
dedicated service 

Slot No. 
Slot position of the relevant module that uses the 
dedicated service 

Link Type 
Type of communication module which is being 
used 

P2P service 
information 

Status of P2P 
parameter 
existence 

Indicates whether the P2P parameter has been 
downloaded or not 

Driver type 
 P2P driver setting information for each port 
 XGT/ MODBUS/user frame definition available 

Detailed 
information 

Block No. 
 Available range 0 ~ 63  
 Displays only a registered block that is operating 

Port number Displaying the channel number 

Status 
Indicates the information regarding the service 
execution status by block 

Service count 
Indicates the number of executions for each block 
from the time when the P2P service is executed 

Error count 
Displays the number of errors occurring during 
service 

Multiple 
reading/Refresh 

Continuous reading 
Checks P2P service status information every 1 
second 

Refresh 
Checks the P2P service status information at the 
selected time 
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▶Error according to the status code by service 
It is used for identifying the communication status of the Cnet I/F module. 

Dedicated service P2P service 

Status Contents Status Contents 

0 Normal communication 0 Normal communication 

1 
Receive frame header error (there is no 
ACK/NAK) 

4 
Max. station set error (When set more than 31 
stations have been set) 

2 Reception frame tail error (there is no tail) 5 Time out 

3 Reception frame BCC error FFFE 
1. Modbus address error 
2. If a command other than Read/Write is used 

9 
Station number of RX frame is different 
with self-station number (Self station 
number = 0) 

- 

0A If no response is received from CPU 

0B 
If the received frame is longer than the 
maximum Modbus frame 

0C 
The received frame is not Modbus ASCII / 
Modbus RTU 

0D In case of HEX conversion error in Modbus 

 
▶Media Information 

 
 

▶View Communication Module Log 
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12.2 Error code by protocol 
 

The following contents are related to the error code according to the protocol 
 
▶XGT client/ server 

Error 
code 

Type of error Contents and cause of error 
Example of frame with an 

error 

0003 
Block number excess 
error 

If the number of blocks is larger than 16 when 
read/write individually is requested 

01rSS1105%MW10… 

0004 Variable size error 
If the variable size is higher than 16 which is the 
maximum size 

01rSS0113%MW100000
00… 

0007 Data type error 
If the data type other than X, B, W, D and L has 
been received 

01rSS0105%MK10 

0011 Data error 

If data size area information is incorrect 01rSB05%MW10%4 

If not starting with % 01rSS0105$MW10 

If the area value of the variable is incorrect 01rSS0105%MW^& 

In the case of bit writing, 00 or 01 should be 
written, but other values are written 

01wSS0105%MX1011 

0090 Monitor execution error 
If the execution of a monitor which is not 
registered is requested 

- 

0190 Monitor execution error 
If the range of the registration numbers has 
been exceeded 

- 

0290 Monitor registration error 
If the range of the registration numbers has 
been exceeded 

- 

1132 Device memory error 
If a character which is not a device in use is 
entered 

- 

1232 Data size error 
The size of data exceeds 60 words that can be 
read or written at a time 

01wSB05%MW1040AA5
512,. 

1234 Spare frame error If unnecessary additional content exists. 01rSS0105%MW10000 

1332 Data type mismatch error 
In the case of read/write individually, the same 
data type should be requested for all blocks, but 
in case a different data type is requested 

01rSS0205%MW1005%
MB10 

1432 Data value error 
If the data value cannot be converted to Hex 
value 

01wSS0105%MW10AA%
5 

7132 
Variable request area 
excess error 

It is required beyond the area supported by each 
device. 

01rSS0108%MWFFFFF 

 
 

▶ Modbus ASCII, Modbus RTU client /server 

Error 
code 

Name of error Contents 

01 Function code error If the function code does not match 

02 Address error If the address has exceeded the permissible range 

03 Data setting error If a data value which is not permitted has been set 

04 
Server station 
abnormality error 

If an abnormality has occurred in the server (slave) station 

05 
Server station retry 
request 

When the server requests the client to make a request again later 
as processing is not currently available 

06 
Server station processing 
time delay 

This is the case when it takes time for the server station to process 
the request, and the Master should repeat the request. 

 
 
 

▶Error code which occurs the PLC 

Error 
code 

Name of error Contents 

0x15 Timeout error When 5 seconds have passed after the P2P starting condition 

0x16 Address error In case of accessing an incorrect device area 
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12.3 Troubleshooting by the symptoms of an error 
 

12.3.1 In case P2P parameter setting error warning occurs when connecting to 

XG5000  

Symptom Cause Solution 

P2P setting error warning occurred 
when connecting to XG5000. 
 

 
 
 

If the Cnet I/F 
module whose P2P 
setting is completed 
is detached 

1.Check if the module has been 
detached or not after power 
off. 

2.Connect to the XG5000 and 
check the status. 

If the P2P number 
whose P2P setting 
was not carried out 
is selected when 
carrying out link 
enable of the 
XG5000. 

1.Check the P2P setting 
number in Link Enable' of 
1.XG5000, delete the check 
of the wrong selected P2P 
number, and click[Write] 

2.After disconnecting, 
reconnect and check whether 
it is normal 

 

12.3.2 If the P2P setting is completed when operating as the client but the 

communication is not available 

Symptom Cause Solution 

Communication setting is 
completed, but Tx/Rx of LED of 
Cnet I/F does not blink 

If the CPU is in stop 
mode 

Connect to XG5000. If the CPU 
mode is in stop mode, change it 
to Run mode. 

If the communication 
basic parameters do 
not match between the 
client and server 

Connect to XG5000, select 
[File]→[Open from PLC] and 
check the basic communication 
setting of the module that 
operates as the client. 

If a link enable setting 
error has occurred 

Set the P2P parameter, select 
Link enable of the relevant P2P 
and click [Write]. 

 

12.3.3 If the communication type is set to RS-485, and the response frame is 

missing when operating as a client 

Symptom Cause Solution 

Frame monitoring after 
completing the settings of 
multiple P2P parameters in P2P 
block results in missing 
response frames 

If the P2P starting 
condition is faster than 
the communication 
time 

1.Change the P2P start condition 
of P2P block setting in 
consideration of communication 
time 

2. Communication time= 
Transmission time + reception 
time  

(1)Transmission time= Start 
condition + CPU Scan time + 
communication module 
response time + Data transfer 
time  

(2)Receive time= CPU Scan time 
+ communication module 
response time + Data transfer 
time  
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If the response time of 
the communication 
module that operates 
as the server is slow 

1.Increase the delay time from the 
basic setting of the XG5000. 

- Since the response time varies 
by module that operates as the 
server, set 3~8 generally. 

 
 

12.3.4 If two response frames are processed as unknown for one request frame 

during frame monitoring 

Symptom Cause Solution 

Two response frames are processed as unknown 
during frame monitoring. 

 

 If RS-422 is 
selected for the 
communication 
type in the basic 
setting of the 
XG5000 but the 
output terminal is 
wired to RS-485 

Change the 
communication type 
to RS-485 in the 
basic setting and 
write basic setting. 

 

12.3.5 If individual reset is not available 

Symptom Cause Solution 

Automatic reset is not 
available after writing the basic 
parameters in the XG5000. 

If the O/S version of 
the Cnet I/F module is 
2.0 or lower 

Upgrade the OS of the Cnet I/F 
module to 2.0 or higher. 

 

12.3.6 If data whose frame cannot be analyzed is transmitted or received 

Symptom Cause Solution 

If data whose frame cannot 
be analyzed is sent or 
received 

If a frame is sent from a 
number of servers 

1.Check if 1 to 1 communication 
with a device which operates as 
the server is carried out properly. 

2.Apply interlock to prevent a frame 
from being send at the same 
time. 

Parity bit setting is not 
matched 

Set the same parity bit. 

size of the stop bit is not 
set correctly 

Set the same size of stop bit. 

If the communication 
speed is set incorrectly 

Set the same communication 
speed. 

 If the terminating 
resistance was not 
installed when 
configuring multi drop 

Install the terminating resistance. 

 

12.3.7 If it is unclear whether the error is caused by the client or the server 

Symptom Cause Solution 

If it is not clear whether a 
communication problem is 
attributable to the client or the 
server. 

- 

1.Check Cnet I/F module 
(1)Check the installation status of 
the module   
(2)Check the wiring status 
2. Carry out the loop-back test. 
3. Check the CPU status 
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12.3.8 If normal communication status and abnormal communication status occur 

repeatedly in turn 

Symptom Cause Solution 

Normal or abnormal 
communication repeatedly 
occurs. 

If a number of servers 
transmit a frame in case 
of multi-drop 
connection. 

1. Check if 1 to 1 communication 
with a device which operates as 
the server is carried out properly. 

2. Apply interlock to prevent a 
frame from being transmitted at 
the same time. 

If the wiring status of 
the communication line 
is faulty. 

Replace the cable or connect the 
cable firmly. 

If the timing of received 
and transmitted signals 
does not match during 
the RS-485 
communication. 

Increase the delay time of the 
device which operates as the client 
and the server. 

 1.When the next send 
is requested while the 
transmit process is 
not completed. 

2.When receive is not 
complete, it requests 
next process of 
receive. 

Make sure to use handshake when 
writing the program. 

 

12.3.9 If the error code“E000”for the status by service has occurred 

Symptom Cause Solution 

The status of P2P 
service is E000. 

 If the station addresses of 
the P2P parameter set for the 
module operating as the 
server and the module 
operating as the client are 
different. 

Check the station address of the 
module operating as the server and 
modify the station address of the 
P2P parameter. 

 

12.3.10 If the error code“E001”for the status by service has occurred 

Symptom Cause Solution 

The status of P2P 
service is E001. 

If the CRC error check value 
is different. 

Check the CRC calculation result by 
referring to the frame. 
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Chapter 13 Additional functions 
13.1 RAPIEnet+ Remote Cnet service 
 

This feature is a service that allows remote use of Cnet communication using the Ethernet extension 
driver(XGL-DBDT/F/H). To use it, please refer to the supported version information below and apply it 
to your system. 
 
(1) Supported version information 

No. Item S/W version 

1 XG5000 V4.70 or higher 

2 XGL-DBDT/F/H V1.40 or higher 

3 XGL-C22B/CH2B/C42B V6.00 or higher 

 
13.1.1 Installation and Operation 
By installing the Cnet communication module onto the extension driver, it is possible to remotely use server 
and client Cnet communication. 
 

 
<Example of using the Cnet module installed on the extension driver> 

 
(1) Server communication 

Register the Smart Extension service using the Ethernet Master module (XGL-EFMxB) connected 
to the local PLC. Click on the I/O parameters on the corresponding device for Smart Expansion. 
When you right-click on the Cnet module, Detailed Module information appears and clicking it will 
bring up the module's information window.  
(Please refer to section 11.1.1 for setting the Cnet server.) 
 
 
 
 
 

RS-232C, RS-422/485 
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Notes  

 

 Please refer to the XGT Ethernet Module User Manual for using smart extension. 

 
 

(2) Client communication 
You can use P2P client communication by using CP MSG function block. Please refer to the 
Instruction Help for the usage of CP MSG function block, and consult chapter 13.2 on 
communication module object data transmission functions for setting up P2P client. 
 
1) XGK CPU CPMSG function block 

 
 

2) XGI CPU CP_MSG function block 
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3) Extension Cnet module Diagnosis function 
By connecting to the expansion driver, you can use the diagnostic function of the XG5000 to 
check the status of the Cnet module's system and network. The key items that can be 
diagnosed include the following: (For detailed information on the diagnostic function, please 
refer to Chapter 12 - Diagnostic Function.) 
 

▶ Communication module Information 
▶ Frame monitor  

▶ Loop-back test  

▶ Status by service  
▶ Media Information 
▶ View Communication Module Log 
▶ Save Communication Module Log 
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13.2 Communication module object data send and receive function 
 

This function is to send/receive object data of communication module. In order to use it, please refer 
to the supported version information below and apply it to the system. 
 
(1) Supported S/W version information 

No. XGL-Cx2B Version Object ID Description 

1 V6.00 3 P2P 

2 V6.00 4 Diagnosis 

 

No. CPU Type CPU Version 

1 XGI-CPUUN V1.80 

2 XGK-CPUHN V1.80 

3 XGK-CPUSN V1.80 

4 XGK-CPUUN V1.80 

 
(2) Command: CP_MSG 

 

No. 
XGL-Cx2B 

Version 

XG5000 

Version 
CP_MSG Function Description 

1 V6.00 V4.61 
Communication module object read 

communication module object write. 

Communication module object write ,read. 

Access to Local 

object(SNTP, Smart 

extension, P2P) 

2 V6.00 V4.70 Read remote communication module object. 

Write remote communication module object. 

Communication module 

object access of smart 

extension slave 
 

For detailed instruction usage, refer to “XGK / XGB instruction user manual” or “XGI/XGR/XEC/XMC 

instruction user manual”. 
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13.2.1 Reading remote communication module object. 
 
(1) Remote read request 

The message structure for the “read” operation of the communication module object located in the 
remote is as follows. 

 
 

1) FC (Frame Command): 0x0116 (Remote Read) 
2) Object Count: Number of objects to be read (up to 32) 
3) REF OBJ: The reference object holds channel information for remote operations. 

Example: To access a Smart Extension Slave, you need to specify the Smart Extension 
object (Object ID: 2). 

4) Channel: Channel number managed by the reference object. 
Example: To access the object of Smart Extension Slave EB#5, you need to specify channel 
number 5. 

5) Object ID: Unique number of the object to be read (refer to the corresponding object's user 
manual). 

6) Data Type: Data type of the data to be read, supports only bytes. 
7) Offset: Offset of the data within the object to be read (refer to the corresponding object's user 

manual). 
8) Slot (0~12): Slot number used to access the communication module object installed on the 

Smart Extension Slave.  
Example: To access the communication module installed in Slot 0, set the slot field value to 0. 
To access the communication module installed in Slot 9, set the slot field value to 9. To 
access the Extension Slave, set the slot field value to 12. 

9) Length: Number of reads based on the data type.  

Note: The maximum size of the data to be read, including the header, cannot exceed 1400. 
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(2) Remote read response(positive) 

 
 

1) FC (Frame Command): 0x0126 (Remote Read Response) 
2) Status: Status value after the read operation. 0 indicates normal operation. 
3) Object Count: Number of objects read. 
4) Object ID: Unique number of the object read (refer to the corresponding object's user 

manual). 
5) Data Type: Data type, only supports bytes. Bytes: 5 
6) Offset: Offset address of the data read within the object. 
7) Slot (0~12): Slot number used to access the communication module object installed on 

the Smart Extension Slave. 
8) Length: Count based on the data type. 
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(3) Remote read response(negative) 

 
 

1) FC (Frame Command): 0x0126 (Read Response) 
2) Status: Status value after the read operation. If there is an error, it contains an error code. 

(If the code value is less than 20, refer to the command set; if it is 20 or greater, refer to 
the error code of the corresponding communication module.) 

3) Remote Read Service Status: Service status value in case of read service response error. 
4) Remote Read Status Code: Detailed status code for the read service response. 
5) Error Message (String): If an error occurs, this field provides an error message. It is 

displayed as a string (ASCII), so it can be viewed as ASCII. 
 
Example: If the first object in the read request format has an unknown object ID (100): 
- FC: 0x0126 
- Status: 0x0116 (INVALID_OBJ) 
- Error Position Offset: 8 (offset position of the first object's unique ID) 
- Error Data: 100 
- Eror Message: "Invalid Object" 
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13.2.2 Writing remote communication module object 
 

 
(1) Remote write request 

The message structure for the “write” operation of the communication module object located in 
the remote is as follows. 

 
 

1) FC (Frame Command): 0x0117 (Write Request) 
2) Object Count: Number of objects. 
3) REF OBJ: The reference object holds channel information for remote operations. 

Example: To access a Smart Extension Slave, you need to specify the Smart Extension 
object (Object ID: 2). 

4) Channel: Channel number managed by the reference object. 
5) Object ID: Unique number of the object. (Refer to the corresponding user manual for 

details) 
6) Data Type: Data type, supports only bytes. 

- Bytes: 5 
7) Offset: Offset of the data within the object. 
8) Slot (0~12): Slot number used to access the communication module object installed on 

the Smart Extension Slave. 
9) Length: Count based on the data type. 
10) Data: Data to be written to the communication module's corresponding object.  

 
Note: The maximum size of the request message cannot exceed 1400 
 

(2) Remote write response(positive) 

 
 

1) FC (Frame Command): 0x0127 (Remote Write Response) 
2) Status: Status value after the write operation. 0 indicates successful operation. 
3) Error Position Offset: 0. 
4) Error Data: 0. 
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(3) Remote write response(negative) 

 
 

1) FC (Frame Command): 0x0127 (Remote Write Response) 
2) Status: Status value. If there is an error, it contains an error code. (If the code value is 

less than 20, refer to the command set; if it is 20 or greater, refer to the error code of the 
corresponding communication module.) 

3) Error Position Offset: If an error occurs in the request format, the offset value where the 
error in the read request format occurred. If the offset cannot be determined, it is 0xFFFF. 

4) Error Data: If an error occurs in the request format, the value that caused the error in the 
read request format. 

5) Error Message (String): If an error occurs, this field provides an error message. It is 
displayed as a string (ASCII), so it can be viewed as ASCII. 
 
Example: If the first object in the request format has an unknown object ID (100): 
- FC: 0x0127 
- Status: 0x0116 (INVALID_OBJ) 
- Error Position Offset: 8 (offset position of the first object's unique ID) 
- Error Data: 100 
- Error Message: "Invalid Object" 

 
13.2.3 CP MSG common error code 
 
The error code that indicates the cause of an error encountered during the interpretation of CP 
MSG by the communication modue. 

Code (hex) Name Description 

0x0110 UNIV_ERR_INVALID_PRM Parameter error 

0x0111 UNIV_ERR_INVALID_EXT_TYPE EXT field error of FC 

0x0112 UNIV_ERR_INVALID_MSG_TYPE MSG field error of FC 

0x0113 UNIV_ERR_INVALID_PDU_TYPE PDU field error of FC 

0x0114 UNIV_ERR_INVALID_SVC_TYPE SVC field error of FC 

0x0115 UNIV_ERR_INVALID_DATA_TYPE Unsupported data type 

0x0116 UNIV_ERR_INVALID_OBJ Unknown object ID 

0x0117 UNIV_ERR_REQ_SIZE_SHORT 
The size of the request message 

is smaller than the minimum size. 

0x0118 UNIV_ERR_REQ_SIZE_LONG 
The size of the request message 

exceeds the maximum size. 

0x0119 UNIV_ERR_REQ_OFFSET 
Unsupported offset for the given 

objedt. 

0x011A UNIV_ERR_REQ_OBJ_CNT_ZERO 
Object count in the request 

message is 0. 

0x011B UNIV_ERR_REQ_OBJ_CNT_EXCEEDS 
Object count in the request 

message exceeds 64. 
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0x011C Reserved  

0x011D UNIV_ERR_REQ_OBJ_ACCESS_DENIED 

The object in the request 

message is inaccessible. (Please 

check if the object is allowed to 

be accessed by communication 

module parameters, etc.) 

0x011E UNIV_ERR_REQ_ALIGN_LEN 

The size of the request message 

or the read/write size of the 

object is not aligned to 4 bytes. 

0x011F UNIV_ERR_TIME_OUT 

Timeout occurred in the request 

message. (Occurred within the 

communication module) 

0x0120 UNIV_ERR_MEM_ALLOC_FAIL 

Insufficient internal memory in 

the communication module to 

process the request message. 

0x0121 UNIV_ERR_OBJ_RESOURCE_BUSY 

The resources of the requested 

object are currently in use, and it 

is unable to provide a response 

at the moment. 

0x0122 UNIV_ERR_NO_ITEM 

There are no items in the object 

being read, so there is no data 

available to respond with. 

0x0123 UNIV_ERR_REMOTE_TX_FAIL 

Remote transmission failed. 

Refer to the received message 

for detailed error information. 

0x0124 UNIV_ERR_RX_ERR_MSG 

Received remote error message. 

Refer to the received message 

for detailed error information. 

 

13.2.4 P2P object(Object ID: 3) 

The structure of the P2P object (Object ID: 3) in Cnet is as follows. 
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1) Sending User-Defined Frame using CP_MSG regardless of P2P parameter settings 
(Write) 
- When sending a user-defined frame on Cnet port 1, write the user-defined frame to 

offset 0x0000 of P2P object. 
- When sending a user-defined frame on Cnet port 2, write the user-defined frame to 

offset 0x0800 of P2P object. 
2) Receiving User-Defined Frame using CP_MSG regardless of P2P parameter settings 

(Read) 
- When sending a user-defined frame on Cnet port 1, read the user-defined frame from 

offset 0x0000 of P2P object. 
- When sending a user-defined frame on Cnet port 2, read the user-defined frame from 

offset 0x0800 of P2P object. 
- If no frame is received, respond with UNIV_ERR_REQ_OBJ_CNT_ZERO (0x011A). 

3) Controlling DTR of RS232 Port using CP_MSG regardless of P2P parameter settings 
(Write) 
- When sending a user-defined frame on Cnet port 1, write the control command to 

offset 0x0600 of P2P object. 
- When sending a user-defined frame on Cnet port 2, write the control command to 

offset 0x0E00 of P2P object. 
- Control commands 

Disable: 0x0D  
Enable: 0x0E 
 

4) Controlling RTS of RS232 Port using CP_MSG regardless of P2P parameter settings 
(Write) 
- When sending a user-defined frame on Cnet port 1, write the control command to 

offset 0x0604 of P2P object. 
- When sending a user-defined frame on Cnet port 2, write the control command to 

offset 0x0E04 of P2P object. 
- Control commands 

 Disable: 0x0D  
Enable: 0x0E 
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13.2.5 Diagnostic object(Object ID: 4) 

The structure of the Diagnostic Information Object (Object ID: 4) in Cnet is as follows. 

 

 

 
1) Read module information using CP_MSG (Read) 

 

 
 
 
The detail value of the module information is as follows. 
 

Member name 
Value 

Parameter Exist 

0x00: Default parameters are normal. 

0x01: Default parameters are error. 

0x02: Default parameters are nothing. 

0x04: Option information mismatch. 

0x08: Station information error 

0x10: Module type errro (It is not cnet parameter)  

Link Type 
0x40: Cnet 

Link Sub Type 

0x00: XGL-C42B 

0x01: XGL-C22B 

0x02: XGL-CH2B 

0x03: XBL-C21A 

0x04: XBL-C41A 

Reserved 
 

Port1 Station No 
Port1 station number. 

Port2 Station No 
Port2 station number. 

OS Version 
OS Version 

HW Version 
HW Version 

HW Status 
HW Status 
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Run Mode 

Currently active service list in Cnet configuration. 

(Note: Multiple data items are displayed as ‘OR’)  

0x01: P2P service configuration is avaliable. 

0x04: Remote Loader service 

0x08: Server service 

Service Mode 

Current Cnet service status 

(Note: Multiple data items are displayed as ‘OR’)  

0x01: P2P service RUN 

0x04: Remote Loader Connected 

0x08: Server Connected (This information will turn 

off if there is no communication with the client for 

10 seconds). 

Port1 server mode 

0x00: P2P 

0x02: XGT Server 

0x03: Modbus ASCII 

0x04: Modbus RTU 

0x07: Smart Server 

Port2 server mode 

0x00: P2P 

0x02: XGT Server 

0x03: Modbus ASCII 

0x04: Modbus RTU 

0x07: Smart Server 

OS Date 
OS Date 

 

- Example ladder program(XGK) 

 

 

 

- Data 
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2) Read Feature List of Cnet module 
- It responds with the Feature List supported by Cnet. The Feature List has assigned 

meanings to each bit, where a bit value of 1 indicates support and 0 indicates non-
support. 

Feature name Bit Position Feature 설명  

BPSC LARGE RAM SUPPORT b’0 
Support for large-capacity shared 

RAM for backplane. 

RAPIENET PLUS SUPPORT b’1 
Compatible with RAPIEnet+ slave 

module. 

Reserved b’2 ~ b’32  

PASS THRU SUPPORT b’33 Support for Message Pass through  

 

- Example ladder program(XGK) 

 

 

- Data 
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3) Read Media Packet information of Cnet(Read) 
(Maximum 224 byte) 

 
 
The description for each count item is as follows. 

Member name Value 

Total tx count Transmission count per port. 

Total rx count Reception count per port. 

Unkown rx count Unknown frame reception count per port. 

Char time out count Character interval timeout count per port. 

Parity error count UART parity error count per port 

Break error count UART break error count per port 

Overrun error count UART RX overrun error count per port 

Framming error count UART RX framming error count per port 

Server tx ok count tx ok count per server mode 

Server tx nak count tx nak count per server mode 

Server rx ok count rx ok count per server moce 
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Server rx fcs error count rx frame check sequence error count per server mode 

Reserved  

Clinet tx ok count tx ok count per client mode 

Client tx nak count tx nak count per client mode 

Client rx ok count rx ok count per client mode 

Client rx fcs error count rx frame check sequence error count per client mode 

Client rx time out count rx tiem out count per client mode 

 

- Example ladder program(XGK) 

 

 

- Data 

 

 
4) Reset Media Packet information of Cnet(Write) 

 
 
If you write 0x0000000C to the media packet information offset(0x0200), the media packet 
information will be initialized to 0. 
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Appendix 
 

1. Description of terms 
 

(1) Communication method 
(a) Simplex communication 

This is the communication method to transmit information in only one predefined direction. 
Information cannot be transmitted in the opposite direction. 

 
(b) Half-duplex communication 

One cable is used in this communication method, so when one side is transmitting, the other 
side can only receive. Information cannot be transmitted in both directions at the same time, but 
it is possible after an interval of time. 

 
(c) Full-duplex communication 

Two cables are used in this communication method, so information can be transmitted and 
received at the same time. 

 
(2) Transmission method 

The transmission method can be classified into two methods as follows by considering the 
speed, stability and economic feasibility when transmitting data as a binary value. 

 
(a) Serial transmission 

This is the method to transmit data by 1 bit through one cable. The transmission speed is slow, 
but the installation cost is low and software becomes simple.  

      

 

0 1 0 0 1 1 0 1

01234567

  

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Send Receive

 
RS-232C, RS-422 and RS-485 correspond to this transmission method. 
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(b) Parallel transmission 
This is the method to transmit data by 1 byte, and the transmission speed is fast and the data 

accuracy is high, but the installation cost increases significantly as the transmission distance 
increases. This method is frequently used in printers. 

 

 

0 1 0 0 1 1 0 1

01234567

Send Receive
1

0

1

1

0

0

1

0

 
      

 
(3) Asynchronous communication 

This is the method to synchronize and transmit data by a character during serial transmission. At 
this time, a sync signal (Clock, etc.) will not be transmitted. Attach the start bit in front of 1 character, 
send the character code, attach the stop bit at the end and finish. 
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※When sending 'KOREA' 
Dirction 

Start Bit Stop Bit Data Bits Parity Bit 
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(4) Protocol 
This is the communication rule that prescribes connection method, transmission and reception 

method to enable smooth exchange of information between computers or a computer and a 
terminal. 
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(5) bps (Bits per second) and cps (Characters per second) 
bps is the unit that indicates bit number transmitted in 1 second, and cps is the unit that indicates 

the number of characters transmitted in 1 second. Generally, 1 character is 1 byte (8 bit), so cps is 
the number of bytes that can be transmitted in one second.  

 
(6) Node 

This term indicates the connection joint of data in the network tree structure, and the network is 
configured with numerous nodes. It is also expressed as the station address.  

 
(7) Packet 

This is the compound word of the package which indicates small parcel and the bucket which 
indicates mass, and transmission data id divided by a predefined length and header which indicates 
the opposing address (station address, etc.). 

 
(8) Port 

This indicates a part of data processing equipment that receives or sends data in data 
communication, and in Cnet serial communication, it refers to the RS-232C or RS-422 ports. 

 
(9) RS-232C 

This is the interface for connecting a modem and a terminal, or a modem and a computer, and 
these are the specifications of serial communication  established by EIA according to the CCITT's 
recommendation. It is used also for direct connection using a null modem in addition to the modem 
connection. It has disadvantages, including that the transmission distance is short and only 1 to 1 
communication is possible. The specifications that improved such disadvantages are RS-422 and 
RS-485. 

 
(10) RS-422/RS-485 

RS-422/RS-485 is one of serial transmission specifications, and the transmission distance is 
longer than that of RS-232C, and 1 to N connection is available. However, there is a difference in 
that RS-422 carries out full-duplex communication since it uses four signal lines including TX(+), 
TX(-), RX(+) and RX(-), and RS-485 carries out half-duplex communication since it uses two signal 
lines including (+) and (-). 
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(11) Half-duplex communication 
This is the communication method in which bidirectional communication is available, but 

transmission and reception cannot be carried out at the same time. The RS-485 method falls 
under this communication method. Since transmission and reception are carried out using 
one signal line, it is frequently used for the multi-drop communication method. If a number of 
stations transmit at the same time, data may conflict, causing a data loss, so the 
transmissions should be carried out by one station at a time. The following figure shows an 
example of configuration in half-duplex communication method. The transmission and 
reception terminals of each station are connected to each other and they can communicate 
with each other through one line, so the multi server function can be used. 

 

 

 
(12) Full-duplex communication 

This is the communication method that can carry out transmission and reception in both 
directions at the same time, and RS-232C and RS-422 fall under this method. The 
transmission line and the reception line are separated so that transmission and reception can 
be carried out at the same time without data conflict. The following figure shows an example 
of configuration in the full-duplex communication method. The transmission terminal of the 
server station is connected to the client station and the reception terminal of the server 
station is connected to the transmission terminal of the client station, so the server stations 
cannot communicate with each other. Therefore, the multi server function cannot be used. 

 

 
  

TX RX 

RX RX RX RX TX TX TX TX 

Client 
station 

Server Server Server Server 

TX RX 

RX RX RX RX TX TX TX TX 

Client 

Server Server Server Server 



 

 

Appendix 

 

A-5 

 

 

(13) BCC(Block Check Character) 
In serial transmission, an incorrect signal may be delivered since the communication line is 

affected by noise, so the reception side needs a method in order to detect an error. BCC is the 
character added to allow the reception side to judge whether the received signal is normal or not. 
The reception side can calculate BCC by itself using the data received by the front terminal of BCC 
and check for an abnormality by comparing it with the received BCC. 

(14) XG5000 modem function 
This function allows PLC to carry out writing a program, reading/writing a user program, 

debugging and monitoring remotely using XG5000 in the network system connected to the Cnet I/F 
module. This function can be used conveniently for controlling a PLC which is remote using the 
modem. 

  

XGT PLC Cnet #1 Station
XGT PLC Cnet #2 Station

Dial-up modemDial-up modem

Repeater station

Public network

 

 
* XG5000: This is the programming software tool for XGT PLC. 
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2. List of flags 
 

2.1 List of system flags (F) 
Word/do

uble 
word 

Bit Variable Function Description 

F0000 

- _SYS_STATE Mode and state Display PLC mode and operation state. 

F00000 _RUN RUN RUN status. 

F00001 _STOP STOP Stop state. 

F00002 _ERROR ERROR Error status. 

F00003 _DEBUG DEBUG Debug state. 

F00004 _LOCAL_CON Local control Local control mode. 

F00005 
_MODBUS_CO
N 

Modbus mode Modbus control mode. 

F00006 
_REMOTE_CO
N 

Remote mode Remote control mode. 

F00008 
_RUN_EDIT_S
T 

Edit during RUN 
Downloading the editing program during 
RUN. 

F00009 
_RUN_EDIT_C
HK 

Edit during RUN Internal edit processing during RUN. 

F0000A 
_RUN_EDIT_D
ONE 

Edit done during RUN Edit done during RUN. 

F0000B 
_RUN_EDIT_E
ND 

Edit done during RUN Edit done during RUN. 

F0000C _CMOD_KEY Operation mode 
The operation mode has been changed by 
key. 

F0000D 
_CMOD_LPAD
T 

Operation mode Operation mode changed by local PADT. 

F0000E 
_CMOD_RPAD
T 

Operation mode Operation mode changed by remote PADT. 

F0000F _CMOD_RLINK Operation mode 
Operation mode changed by remote 
communication module. 

F00010 _FORCE_IN Forced input Forced input state. 

F00011 _FORCE_OUT Forced output Forced output state. 

F00012 _SKIP_ON I/O SKIP I / O SKIP is running. 

F00013 _EMASK_ON Error mask Error mask is running. 

F00014 _MON_ON Monitor The monitor is running. 

F00015 _USTOP_ON STOP Stopped by stop function. 

F00016 _ESTOP_ON ESTOP Stopped by EStop function. 

F00017 
_CONPILE_ 
mode 

Compiling Compiling is in progress. 

F00018 _INIT_RUN Initializing Initialization task is running. 

F0001C _PB1 Program code 1 Program code 1 is selected. 

F0001D _PB2 Program code 2 Program code 2 is selected. 

F0001E _CB1 Compile code 1 Compilation code 1 is selected. 

F0001F _CB2 Compile code 2 Compilation code 2 is selected. 
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Word/do
uble 
word 

Bit Variable Function Description 

F0002 

- _CNF_ER System error Reports the status of a system failure. 

F00020 _CPU_ER CPU error There is an error in the CPU configuration. 

F00021 _IO_TYER Module type error The module type does not match. 

F00022 _IO_DEER 
Module detachment 
error 

The module has been detached. 

F00023 _FUSE_ER Fuse error The fuse has blown. 

F00024 _IO_RWER Module I/O error A problem occurred in the module I/O. 

F00025 _IP_IFER 
Module interface 
error 

There was a problem with the special / 
communication module interface. 

F00026 _ANNUM_ER 
External device 
malfunction 

A fault has been detected in the external 
device. 

F00028 _BPRM_ER Basic parameter There is a basic parameter error. 

F00029 _IOPRM_ER IO parameter There is a I/O configuration parameter error. 

F0002A _SPPRM_ER 
Special module 
parameter 

The special module parameter is abnormal. 

F0002B _CPPRM_ER 
Communication 
module parameter 

The communication module parameter is 
abnormal. 

F0002C _PGM_ER Program error There is an error in the program. 

F0002D _CODE_ER Code error There is an error in the program code. 

F0002E _SWDT_ER System watchdog System watchdog worked. 

F0002F 
_BASE_POWER
_ER 

Power error The base power supply is error. 

F00030 _WDT_ER Scan watchdog The scan watchdog worked. 

F0004 

- _CNF_WAR System warning Reports the minor error status of the system. 

F00040 _RTC_ER RTC error RTC data error. 

F00041 _DBCK_ER Backup error There was a problem with the data backup. 

F00042 _HBCK_ER Restart error Hot restart is unavailable. 

F00043 _ABSD_ER 
Abnormal operation 
stop 

It stops due to abnormal operation. 

F00044 _TASK_ER Task conflict The task is in conflict. 

F00045 _BAT_ER Battery error Battery condition is abnormal. 

F00046 _ANNUM_WAR 
External device 
malfunction 

An external device minor error has been 
detected. 

F00047 _LOG_FULL Memory full Log memory is full. 

F00048 _HS_WAR1 High speed link 1 High speed link - parameter 1 or more 

F00049 _HS_WAR2 High speed link 2 High speed link– parameter 2 or more 

F0004A _HS_WAR3 High speed link 3 High speed link– parameter 3 or more 

F0004B _HS_WAR4 High speed link 4 High speed link– parameter 4 or more 

F0004C _HS_WAR5 High speed link 5 High speed link– parameter 5 or more 

F0004D _HS_WAR6 High speed link 6 High speed link– parameter 6 or more 

F0004E _HS_WAR7 High speed link 7 High speed link– parameter 7 or more 
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Word/do
uble 
word 

Bit Variable Function Description 

F0004 

F0004F _HS_WAR8 High speed link 8 High speed link– parameter 8 or more 

F00050 _HS_WAR9 High speed link 9 High speed link– parameter 9 or more 

F00051 _HS_WAR10 High speed link 10 High speed link - parameter 10 or more 

F00052 _HS_WAR11 High speed link 11 High speed link - parameter 11 or more 

F00053 _HS_WAR12 High speed link 12 High speed link - parameter 12 or more 

F00054 _P2P_WAR1 P2P parameter 1 P2P - parameter 1 error 

F00055 _P2P_WAR2 P2P parameter 2 P2P– parameter 2 error 

F00056 _P2P_WAR3 P2P parameter 3 P2P– parameter 3 error 

F00057 _P2P_WAR4 P2P parameter 4 P2P– parameter 4 error 

F00058 _P2P_WAR5 P2P parameter 5 P2P– parameter 5 error 

F00059 _P2P_WAR6 P2P parameter 6 P2P– parameter 6 error 

F0005A _P2P_WAR7 P2P parameter 7 P2P– parameter 7 error 

F0005B _P2P_WAR8 P2P parameter 8 P2P– parameter 8 error 

F0005C 
_CONSTANT_E
R 

Constant error Constant error 

F0009 

- _USER_F User contact point Timer that can be used by the user. 

F00090 _T20MS 20ms Clock of 20ms cycle. 

F00091 _T100MS 100ms Clock of 100ms cycle. 

F00092 _T200MS 200ms Clock of 200ms cycle. 

F00093 _T1S 1s Clock of 1s cycle. 

F00094 _T2S 2s Clock of 2s cycle. 

F00095 _T10S 10s Clock of 10s cycle. 

F00096 _T20S 20s Clock of 20s cycle. 

F00097 _T60S 60s Clock of 60s cycle. 

F00099 _ON Always On This bit is always On. 

F0009A _OFF Always Off This bit is always Off. 

F0009B _1ON 1scan On Only the first scan is On. 

F0009C _1OFF 1scan Off Bit with only first scan Off state. 

F0009D _STOG Reversal Reverses every scan. 

F0010 

- _USER_CLK User CLOCK Customizable Clock. 

F00100 _USR_CLK0 Repeat specified scan Specified scan On/Off Clock 0 

F00101 _USR_CLK1 Repeat specified scan Specified scan On/Off Clock 1 

F00102 _USR_CLK2 Repeat specified scan Specified scan On/Off Clock 2 

F00103 _USR_CLK3 Repeat specified scan Specified scan On/Off Clock 3 

F00104 _USR_CLK4 Repeat specified scan Specified scan On/Off Clock 4 

F00105 _USR_CLK5 Repeat specified scan Specified scan On/Off Clock 5 

F00106 _USR_CLK6 Repeat specified scan Specified scan On/Off Clock 6 

F00107 _USR_CLK7 Repeat specified scan Specified scan On/Off Clock 7 
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Word/do
uble 
word 

Bit Variable Function Description 

F0011 

- 
_LOGIC_RESUL
T 

Logic result Indicates the logical result. 

F00110 _LER Operation error On operation error On during 1 scan 

F00111 _ZERO Zero flag If the operation result is On. 

F00112 _CARRY Carry flag On when a carry occurs during operation 

F00113 _ALL_OFF All output OFF On when all outputs are Off 

F00115 _LER_LATCH Operation error latch Continue On when operation error occurs 

F0012 

- _CMP_RESULT Comparison result Indicates the comparison result. 

F00120 _LT LT flag If “less than” to On 

F00121 _LTE LTE flag If “less than or equal” to On 

F00122 _EQU EQU flag If “equal” to On 

F00123 _GT GT flag If “larger than” to On 

F00124 _GTE GTE flag If “If “larger than or equal” to On 

F00125 _NEQ NEQ flag If it is “not equal” to On 

F0013 - _AC_F_CNT 
Instantaneous 
interruption 

Indicates the number of instantaneous 
interruption occurrences. 

F0014 - _FALS_NUM FALS number Displays the number of FALS. 

F0015 - _PUTGET_ERR0 PUT/GET error 0 Main base PUT / GET error 

F0016 - _PUTGET_ERR1 PUT/GET error 1 Extension base 1-stage PUT/GET error 

F0017 - _PUTGET_ERR2 PUT/GET error 2 Extension base 2-stage PUT/GET error 

F0018 - _PUTGET_ERR3 PUT/GET error 3 Extension base 3-stage PUT / GET error. 

F0019 - _PUTGET_ERR4 PUT/GET error 4 Extension base 4-stage PUT/GET error 

F0020 - _PUTGET_ERR5 PUT/GET error 5 Extension base 5-stage PUT/GET error 

F0021 - _PUTGET_ERR6 PUT/GET error 6 Extension base 6-stage PUT/GET error 

F0022 - _PUTGET_ERR7 PUT/GET error 7  

F0023 - _PUTGET_NDR0 PUT/GET complete 0 Main base PUT / GET completed 

F0024 - _PUTGET_NDR1 PUT/GET complete 1 
Extension base 1-stage PUT/GET 
completion 

F0025 - _PUTGET_NDR2 PUT/GET complete 2 
Extension base 2-stage PUT/GET 
completion 

F0026 - _PUTGET_NDR3 PUT/GET complete 3 
Extension base 3-stage PUT/GET 
completion 

F0027 - _PUTGET_NDR4 PUT/GET complete 4 
Extension base 4-stage PUT/GET 
completion 

F0028 - _PUTGET_NDR5 PUT/GET complete 5 
Extention base 5-stage PUT/GET 
completion 

F0029 - _PUTGET_NDR6 PUT/GET complete 6 
Extension base 6-stage PUT/GET 
completion 

F0030 - _PUTGET_NDR7 PUT/GET complete 7  

F0044 - _CPU_TYPE CPU type It informs the CPU type information. 

F0045 - _CPU_VER CPU version Indicates CPU version. 

F0046 - _OS_VER OS version Indicates OS version. 

F0048 - _OS_DATE OS date Indicates the OS distribution date. 
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F0050 - _SCAN_MAX Maximum scan time Indicates maximum scan time. 

F0051 - _SCAN_MIN Minimum scan time Indicates minimum scan time. 

F0052 - _SCAN_CUR Current scan time Indicates current scan time. 

F0053 - _MON_YEAR Month / Year Indicates month and year data of PLC. 

F0054 - _TIME_DAY Time / Day Indicates time and day data of PLC. 

F0055 - _SEC_MIN Second / Minute Indicates second and minute data of PLC. 

F0056 - _HUND_WK 
Hundred years / 
Weekday 

Indicates hundred years and weekday data 
of PLC. 

F0057 

- _FPU_INFO FPU operation result Represents floating-point operation result. 

F00570 _FPU_LFLAG_I Incorrect error latch Latch on inaccurate error. 

F00571 _FPU_LFLAG_U Underflow latch Latch when underflow occurs. 

F00572 _FPU_LFLAG_O Overflow latch Latch when overflow occurs. 

F00573 _FPU_LFLAG_Z Zero divide latch Latch on zero divide. 

F00574 _FPU_LFLAG_V Invalid operation latch Latch on invalid operation. 

F0057A _FPU_FLAG_I Inaccurate error Reports an inaccurate error occurrence. 

F0057B _FPU_FLAG_U Underflow Reports underflow occurrences. 

F0057C _FPU_FLAG_O Overflow Reports overflow occurrences. 

F0057D _FPU_FLAG_Z Divide by zero It reports when the divide is zero. 

F0057E _FPU_FLAG_V Invalid operation Report on invalid operation. 

F0057F _FPU_FLAG_E Input of irregular value Reports when input of irregular value. 

F0058 - _ERR_STEP Error step Saves error step. 

F0060 - _REF_COUNT Refresh Increase when module Refresh. 

F0062 - _REF_OK_CNT Refresh OK Increase when module Refresh is normal. 

F0064 - _REF_NG_CNT Refresh NG Increase when module refresh is abnormal 

F0066 - _REF_LIM_CNT Refresh LIMIT 
Increase when module refresh is abnormal  
(Time Out) 

F0068 - _REF_ERR_CNT Refresh ERROR Increase when module refresh is abnormal 

F0070 - 
_MOD_RD_ERR
_CNT 

Module READ 
ERROR 

It increases when the module 1 word is 
read abnormally. 

F0072 - 
_MOD_WR_ERR
_CNT 

Module WRITE 
ERROR 

It increases when the module 1 word is 
write abnormally. 

F0074 - _CA_CNT Block service Increase in module's block data service 

F0076 - _CA_LIM_CNT Block service LIMIT Increase in block data abnormal service  

F0078 - _CA_ERR_CNT Block service ERROR Increase in block data abnormal service 

F0080 - 
_BUF_FULL_CN
T 

Buffer FULL Increase when CPU internal buffer is full. 

F0082 - _PUT_CNT PUT count It increases when performing PUT. 

F0084 - _GET_CNT GET count It increases when performing GET. 

F0086 - _KEY Current key Indicates the current state of the local key. 

F0088 - _KEY_PREV Previous key Indicates the previous state of the local key. 
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Word/d
ouble 
word 

Bit Variable Function Description 

F0090 - _IO_TYER_N Mismatch slot Module type mismatch slot number display 

F0091 - _IO_DEER_N Detached slot 
Display the slot number where the module 
has been detached 

F0092 - _FUSE_ER_N 
Fuse disconnection 
slot 

Indicates the slot number where the fuse 
blows 

F0093 - _IO_RWER_N RW error slot Module read / write error slot number display 

F0094 - _IP_IFER_N IF error slot Module interface error slot number display 

F0096 - _IO_TYER0 Module type 0 error Main base module type error. 

F0097 - _IO_TYER1 Module type 1 error Extension base 1-stage module type error 

F0098 - _IO_TYER2 Module type 2 error Extension base 2-stage module type error 

F0099 - _IO_TYER3 Module type 3 error Extension base 3-stage module type error 

F0100 - _IO_TYER4 Module type 4 error Extension base 4-stage module type error 

F0101 - _IO_TYER5 Module type 5 error Extension base 5-stage module type error 

F0102 - _IO_TYER6 Module type 6 error Extension base 6-stage module type error 

F0103 - _IO_TYER7 Module type 7 error Extension base 7-stage module type error 

F0104 - _IO_DEER0 
Module detachment 0 
error 

Main base module Detach error. 

F0105 - _IO_DEER1 
Module detachment 1 
error 

Extension base 1-stage module detach error. 

F0106 - _IO_DEER2 
Module detachment 2 
error 

Extension base 2-stage module detach error. 

F0107 - _IO_DEER3 
Module detachment 3 
error 

Extension base 3-stage module detach error. 

F0108 - _IO_DEER4 
Module detachment 4 
error 

Extension base 4-stage module detach error. 

F0109 - _IO_DEER5 
Module detachment 5 
error 

Extension base 5-stage module detach error. 

F0110 - _IO_DEER6 
Module detachment 6 
error 

Extension base 6-stage module detach error. 

F0111 - _IO_DEER7 
Module detachment 7 
error 

Extension base 7-stage module detach error. 

F0112 - _FUSE_ER0 
Fuse disconnection 0 
error 

Main base fuse disconnection error 

F0113 - _FUSE_ER1 
Fuse disconnection 1 
error 

Extension base 1-stage fuse disconnection 
error 

F0114 - _FUSE_ER2 
Fuse disconnection 2 
error 

Extension base 2-stage fuse disconnection 
error 

F0115 - _FUSE_ER3 
Fuse disconnection 3 
error 

Extension base 3-stage fuse disconnection 
error 

F0116 - _FUSE_ER4 
Fuse disconnection 4 
error 

Extension base 4-stage fuse disconnection 
error 

F0117 - _FUSE_ER5 
Fuse disconnection 5 
error 

Extension base 5-stage fuse disconnection 
error 

F0118 - _FUSE_ER6 
Fuse disconnection 6 
error 

Extension base 6-stage fuse disconnection 
error 

F0119 - _FUSE_ER7 
Fuse disconnection 7 
error 

Extension base 7-stage fuse disconnection 
error 

F0120 - _IO_RWER0 Module RW 0 error Main base module read / write error 

F0121 - _IO_RWER1 Module RW 1 error 
Expansion base 1-stage module read / write 
error 
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F0122 - _IO_RWER2 Module RW 2 error 
Extension base 2-stage module read/ write 
error. 

F0123 - _IO_RWER3 Module RW 3 error 
Extension base 3-stage module read/ write 
error. 

F0124 - _IO_RWER4 Module RW 4 error 
Extension base 4-stage module read/ write 
error. 

F0125 - _IO_RWER5 Module RW 5 error 
Extension base 5-stage module read/ write 
error. 

F0126 - _IO_RWER6 Module RW 6 error 
Extension base 6-stage module read/ write 
error. 

F0127 - _IO_RWER7 Module RW 7 error 
Extension base 7-stage module read/ write 
error. 

F0128 - _IO_IFER_0 Module IF 0 error Main base module interface error. 

F0129 - _IO_IFER_1 Module IF 1 error 
Extension base 1-stage module interface 
error. 

F0130 - _IO_IFER_2 Module IF 2 error 
Extension base 2-stage module interface 
error. 

F0131 - _IO_IFER_3 Module IF 3 error 
Extension base 3-stage module interface 
error. 

F0132 - _IO_IFER_4 Module IF 4 error 
Extension base 4-stage module interface 
error. 

F0133 - _IO_IFER_5 Module IF 5 error 
Extension base 5-stage module interface 
error. 

F0134 - _IO_IFER_6 Module IF 6 error 
Extension base 6-stage module interface 
error. 

F0135 - _IO_IFER_7 Module IF 7 error 
Extension base 7-stage module interface 
error. 

F0136 - _RTC_DATE RTC date Displays the current date . 

F0137 - _RTC_WEEK RTC weekday Displays the current day of week 

F0138 - _RTC_TOD RTC time Current time in RTC (ms unit) 

F0140 - _AC_FAIL_CNT 
Save the number of 
power off. 

Saves the number of times the power 
cutoff. 

F0142 - _ERR_HIS_CNT 
Save the number of 
error count. 

Saves the number of times an error 
occurred. 

F0144 - _MOD_HIS_CNT 
Save the number of 
mode change. 

Saves the number of times the mode 
change. 

F0146 - _SYS_HIS_CNT 
History occurrence 
count 

Saves the number of system history 
occurrences. 

F0148 - _LOG_ROTATE Log rotate Saves log locate information. 

F0150 - _BASE_INFO0 Slot information 0 Main base slot information 

F0151 - _BASE_INFO1 Slot information 1 Extension base 1-slot information 

F0152 - _BASE_INFO2 Slot information 2 Extension base 2-slot information 

F0153 - _BASE_INFO3 Slot information 3 Extension base 3-slot information 

F0154 - _BASE_INFO4 Slot information 4 Extension base 4-slot information 

F0155 - _BASE_INFO5 Slot information 5 Extension base 5-slot information 

F0156 - _BASE_INFO6 Slot information 6 Extension base 6-slot information 

F0157 - _BASE_INFO7 Slot information 7 Extension base 7-slot information 

F0158 - _RBANK_NUM Block number in use Block number which is currently being used 

F0159 - _RBLOCK_STATE Flash state Flash block state 

F0160 - 
_RBLOCK_RD_FLA
G 

Flash read ON when reading data of flash N block 
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F0162 - 
_RBLOCK_WR_FL
AG 

Write on flash On when writing flash N block data 

F0164 - 
_RBLOCK_ER_FL
AG 

Flash error 
An error occurred during flash N block 
service. 

F1024 

- _USER_WRITE_F 
Available contact 
point 

Contact point available in program. 

F10240 _RTC_WR RTC RW Writing and reading data in RTC 

F10241 _SCAN_WR Scan WR Initializing the value of scan. 

F10242 _CHK_ANC_ERR 
External critical error 
request 

Request of fatal error detection from 
external device 

F10243 _CHK_ANC_WAR 
External light error 
request 

Request of minor error detection from 
external device 

F1025 

- _USER_STAUS_F User contact point User contact point 

F10250 _INIT_DONE 
Initialization 
completed 

Indicates completion of initialization task 

F1026 - _ANC_ERR 
External critical error 
information 

Displays fatal error information of external 
devices 

F1027 - _ANC_WAR 
External light error 
warning 

Displays minor error information of 
external devices 

F1034 - _MON_YEAR_DT Month / Year Clock information data (month / year) 

F1035 - _TIME_DAY_DT Time / Day Clock information data (hour/day) 

F1036 - _SEC_MIN_DT Second / Minute Clock information data (second/minute) 

F1037 - _HUND_WK_DT 
Hundred years / 
Weekday 

Clock information data (hundred 
year/week) 
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2.2 List of communication relay (L) 
 

(1) List of communication flags according to high speed link number: High speed link number 1~12 

Number Keyword Type Content Description 

L000000 _HS1_RLINK Bit 

All stations of 
high speed link 
parameter No. 1 
operate normally. 

Indicates that all stations operate normally as 
per the parameter set from the high speed link. 
It becomes On in the following conditions. 
1. When all stations set for the parameter are in 
RUN mode and there is no error 
2. When all data blocks set for the parameter 
communicate normally 
3. When the parameter set for each station set 

for the parameter communicates normally 
When Run_link becomes On, it will be 
maintained until it is stopped using link disable. 

L000001 _HS1_LTRBL Bit 

Indicates 
abnormal state 
after _HS1RLINK 
ON 

This flag becomes On when the communication 
status between the station set for the parameter 
and the data block while _HSmRLINK flag is On. 
1. If a station set for the parameter is not in RUN 
mode 
2. If a station set for the parameter has an error 
3. If the communication status of the data block 

set for the parameter is unstable  
Link trouble becomes On when a condition 
falling under 1,2 and 3 above occurs, and it 
becomes Off when the condition returns to 
normal. 

L000020 
~ 
L00009F 

_HS1_STATE[k] 
(k=000~127) 

Bit 
Array 

Indicates the 
overall status of 
No. k block in 
high speed link 
parameter No. 1 

Indicates the overall status of communication 
information for each data block of the set 
parameter. 
HS1STATE[k]=HS1MOD[k]&_HS1TRX[k]&(~_H
SmERR[k]) 

L000100 
~ 
L00017F 

_HS1_MOD[k] 
(k=000~127) 

Bit 
Array 

Run operation 
mode of No. K 
block station in 
high speed link 
parameter No. 1 

Indicates the operation mode of the station set 
for k data block of the parameter. 

L000180 
~ 
L00025F 

_HS1_TRX[k] 
(k=000~127) 

Bit 
Array 

Display of normal 
communication 
with No. k block 
station in high 
speed link 
parameter No. 1 

Indicates whether the communication status of k 
data block in the parameter is carried out 
smoothly, as it is set, or not. 

L000260 
~ 
L00033F 

_HS1_ERR[k] 
(k=000~127) 

Bit 
Array 

Operation error 
mode of No. K 
block station in 
high speed link 
parameter No. 1 

Indicates whether an error occurred in the 
communication status of k data block in the 
parameter or not. 

L000340 
~ 
L00041F 

_HS1_SETBLO
CK 
[k=000~127] 

Bit 
Array 

Display of No. k 
block setting in 
high speed link 
parameter No. 1 

Indicates the k data block setting status in the 
parameter. 
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k is the block number and the information of 128 blocks from 000 to 127 is shown as a total of 8 words, 
including 1 word for every 16 blocks.  
For example, in case of mode information (_HS1MOD), the information of block 0 to block 15 is shown in 
L00010, and the information of block 16~31, 32~47, 48~63, 64~79, 80~95, 96~111 and 112~127 is shown in 
L00011, L00012, L00013, L00014, L00015, L00016 and L00017 respectively. Therefore, the mode 
information of block number 55 is shown in L000137. 
 

(2) Relationship between the high speed link and L device area 

High speed 
link number 

Address in L area Note 

2 L000500~L00099F Flag address of another high speed link station address can be 
calculated using the following calculation formula by comparing with 
the case of high speed link 1. 
 

Calculation formula:Address in L area = L000000 + 500 x (high 
speed link number – 1) 
 
If a high speed flag is used for the program and monitoring, use the 
flag map registered to XG5000. 

3 L001000~L00149F 

4 L001500~L00199F 

5 L002000~L00249F 

6 L002500~L00299F 

7 L003000~L00349F 

8 L003500~L00399F 

9 L004000~L00449F 

10 L004500~L00499F 

11 L005000~L00549F 

 
 

(3) List of communication flags according to P2P service setting: P2P parameter: 1~8, P2P block: 0~63 

No. Keyword Type Content Description 

L006250 _P2P1_NDR00 Bit 
P2P parameter No.1 block 

0 service normal completion 
P2P parameter No.1 block 0 service 
has been completed normally 

L006251 _P2P1_ERR00 Bit 
P2P parameter No. 1 

completed No. 00 block 
service abnormally 

P2P parameter No. 1 has not 
completed No. 0 block service 
normally. 

L00626 
_P2P1_STATUS

00 
Word 

Error code in the case 
where P2P parameter No. 1 

completed No. 00 block 
service abnormally 

Displays the error code in the case 
where P2P parameter No. 1 has not 
completed No. 0 block service 
normally. 

L00627 
_P2P1_SVCCN

T00 
Double 
word 

Number of No. 00 block 
service normal execution by 

P2P parameter No. 1 

Displays the number of No. 0 block 
service executed normally by P2P 
parameter No. 1. 

L00629 
_P2P1_ERRCN

T00 
Double 
word 

Number of No. 00 block 
service abnormal execution 

by P2P parameter No. 1 

Displays the number of No. 0 block 
service not executed normally by 
P2P parameter No. 1. 

L006310 _P2P1_NDR01 Bit 
P2P parameter No. 1 

completed No. 01 block 
service normally 

P2P parameter No. 1 has completed 
No. 1 block service normally. 

L006311 _P2P1_ERR01 Bit 
P2P parameter No. 1 

completed No. 01 block 
service abnormally 

P2P parameter No. 1 has not 
completed No. 1 block service 
normally. 

L00632 
_P2P1_STATUS

01 
Word 

Error code in the case 
where P2P parameter No. 1 

completed No. 01 block 
service abnormally 

Displays the error code in the case 
where P2P parameter No. 1 has not 
completed No. 1 block service 
normally. 

L00633 
_P2P1_SVCCN

T01 
Double 
word 

Number of No. 01 block 
service normal execution by 

P2P parameter No. 1 

Displays the number of No. 1 block 
service executed normally by P2P 
parameter No. 1. 

L00635 
_P2P1_ERRCN

T01 
Double 
word 

Number of No. 01 block 
service abnormal execution 

by P2P parameter No. 1 

Displays the number of No. 1 block 
service not executed normally by 
P2P parameter No. 1. 
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2.3 List of link devices (N) 
This device specifies the size and contents of P2P number and block number. 
P2P number: 1~8, P2P block: 0~63 

No. Keyword Type Content Description 

N00000 
_P1B00S

N 
Word 

P2P parameter No. 1 block 
No. 0 destination station 
number 

Save the destination station number Of block 
No. 0 of P2P parameter 1. 
If the destination station address is used in 
XG5000, it can be modified during Run using 
P2PSN command. 

N00001
~ 

N00004 

_P1B00R
D1 

Device 
structure 

P2P parameter No. 1 block 
No. 0 read area device 1 

Save the read area device 1 Of block No. 0 of 
P2P parameter 1. 

N00005 
_P1B00R

S1 
Word 

P2P parameter No.1 block 
No.0 read area size 1 

Saves the area size 1 to be read in block 
No.0 of P2P parameter No. 1. 

N00006
~ 

N00009 

_P1B00R
D2 

Device 
structure 

P2P parameter No.1 block 
No.0 read area device 2 

Saves the read area device 2 in block No.0 of 
P2P parameter No. 1. 

N00010 
_P1B00R

S2 
Word 

P2P parameter No.1 block 
No.0 read area size 2 

Saves the read area size 2 in block No.0 of 
P2P parameter No. 1. 

N00011
~ 

N00014 

_P1B00R
D3 

Device 
structure 

P2P parameter No.1 block 
No.0 read area device 3 

Saves the read area device 3 in block No.0 of 
P2P parameter No. 1. 

N00015 
_P1B00R

S3 
Word 

P2P parameter No.1 block 
No.0 read area size 3 

Saves the read area size 3 in block No.0 of 
P2P parameter No. 1. 

N00016
~ 

N00019 

_P1B00R
D4 

Device 
structure 

P2P parameter No.1 block 
No.0 read area device 4 

Saves the read area device 4 in block No.0 of 
P2P parameter No. 1. 

N00020 
_P1B00R

S4 
Word 

P2P parameter No.1 block 
No.0 read area size 4 

Saves the read area size 4 in block No.0 of 
P2P parameter No. 1. 

N00021
~ 

N00024 

_P1B00W
D1 

Device 
structure 

P2P parameter No.1 block 
No.0 save area device 1 

Saves the save area device 1 in block No.0 of 
P2P parameter No. 1. 

N00025 
_P1B00W

S1 
Word 

P2P parameter No.1 block 
No.0 save area size 1 

Saves the save area size 1 in block No.0 of 
P2P parameter No. 1. 

N00026
~ 

N00029 

_P1B00W
D2 

Device 
structure 

P2P parameter No.1 block 
No.0 save area device 2 

Saves the save area device 2 in block No.0 of 
P2P parameter No. 1. 

N00030 
_P1B00W

S2 
Word 

P2P parameter No.1 block 
No.0 save area size 2 

Saves the save area size 2 in block No.0 of 
P2P parameter No. 1. 

N00031
~ 

N00034 

_P1B00W
D3 

Device 
structure 

P2P parameter No.1 block 
No.0 save area device 3 

Saves the save area device 3 in block No.0 of 
P2P parameter No. 1. 

N00035 
_P1B00W

S3 
Word 

P2P parameter No.1 block 
No.0 save area size 3 

Saves the save area size 3 in block No.0 of 
P2P parameter No. 1. 

N00036
~ 

N00039 

_P1B00W
D4 

Device 
structure 

P2P parameter No.1 block 
No.0 save area device 4 

Saves the save area device 4 in block No.0 of 
P2P parameter No. 1. 

N00040 
_P1B00W

S4 
Word 

P2P parameter No.1 block 
No.0 save area size 4 

Saves the save area size 4 in block No.0 of 
P2P parameter No. 1. 

N00041 
_P1B01S

N 
Word 

P2P parameter No. 1 block 
No. 1 destination station 

number 

Save destination station number Of block No. 
1 of P2P parameter 1. 
If the destination station address is used in 
XG5000, it can be modified during Run using 
P2PSN command. 

N00042
~ 

N00045 

_P1B01R
D1 

Device 
structure 

P2P parameter No. 1 block 
No. 1 read area device 1 

Saves the read area device 1 in block No.1 of 
P2P parameter No. 1. 

N00046 
_P1B01R

S1 
Word 

P2P parameter No.1 block 
No.0 read area size 1 

Saves the read area size 1 in block No.1 of 
P2P parameter No. 1. 
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Number Keyword Type Content Description 

N00047
~ 

N00050 

_P1B01R
D2 

Device 
structure 

P2P parameter No.1 block 
No.1 read area device 2 

Save the read area device 1 Of block No. 1 of 
P2P parameter 1.  

N00051 
_P1B01R

S2 
Word 

P2P parameter No. 1 No. 
01 block area to read size 
2 

Saves the read area size 2 in block No.1 of 
P2P parameter No. 1. 

N00052
~ 

N00055 

_P1B01R
D3 

Device 
structure 

P2P parameter No.1 block 
No.1 read area device 3 

Saves the read area device 3 in block No.1 of 
P2P parameter No. 1. 

N00056 
_P1B01R

S3 
Word 

P2P parameter No. 1 No. 
01 block area to read size 
3 

Saves size 3 on No. 01 block area to read of 
P2P parameter No. 1. 

N00057
~ 

N00060 

_P1B01R
D4 

Device 
structure 

P2P parameter No. 1 No. 
01 block area to read 
device 4 

Saves device 4 on No. 01 block area to read 
of P2P parameter No. 1. 

N00061 
_P1B01R

S4 
Word 

P2P parameter No. 1 block 
No. 1 read area size 4 

Saves the read area size 4 in block No.1 of 
P2P parameter No. 1. 

N00062
~ 

N00065 

_P1B01W
D1 

Device 
structure 

P2P parameter No.1 block 
No.1 save area device 1 

Saves the save area device 1 in block No.1 of 
P2P parameter No. 1. 

N00066 
_P1B01W

S1 
Word 

P2P parameter No.1 block 
No.1 save area size 1 

Saves save area size 1 in block No.1 of P2P 
parameter No. 1. 

N00067  
N00070 

_P1B01W
D2 

Device 
structure 

P2P parameter No.1 block 
No.1 save area device 2 

Saves save area device 2 in block No.1 of 
P2P parameter No. 1. 

N00071 
_P1B01W

S2 
Word 

P2P parameter No.1 block 
No.1 save area size 1 

Saves save area size 2 in block No.1 of P2P 
parameter No. 1. 

N00072  
N00075 

_P1B01W
D3 

Device 
structure 

P2P parameter No.1 block 
No.1 save area device 3 

Saves save area device 3 in block No.1 of 
P2P parameter No. 1. 

N00076 
_P1B01W

S3 
Word 

P2P parameter No.1 block 
No.1 save area size 3 

Saves save area size 3 in block No.1 of P2P 
parameter No. 1. 

N00077
~ 

N00080 

_P1B01W
D4 

Device 
structure 

P2P parameter No.1 block 
No.1 save area device 4 

Saves area device 4 in block No.1 of P2P 
parameter No. 1. 

N00081 
_P1B01W

S4 
Word 

P2P parameter No.1 block 
No.1 save area size 4 

Saves save area size 4 in block No.1 of P2P 
parameter No. 1. 

 
 

Notes  
 

(1)  N area will be set automatically when the P2P parameters are set using the XG5000, and it can 

be edited during RUN using the P2P dedicated command. 

 

(2) In case of N area, addresses are classified according to the P2P parameter setting number and 

block index number, so an area which is not used as the P2P service can be used with the internal 

device.  
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3. External dimension 

 

 

(Dimension unit: mm) 

• XGL-C22A/C22B/CH2A/CH2B/C42A/C42B 

 

 

                                               

 

<A type Cnet I/F module> 

(H/W below V2.0) 

<A type Cnet I/F module> 

(H/W V2.0) 

<B type Cnet I/F module> 
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Warranty 
 
 
1. Warranty Period 

The product you purchased is guaranteed for 36 months from the date of manufacture. 
 
2. Scope of Warranty 

(1) The initial diagnosis of faults is basically conducted by your company. However, upon your request, our company or our service network 
 can undertake this task for a fee. If the cause of the fault lies with our company, this service will be provided free of charge. 

(2) This warranty only applies if the product is used under normal conditions according to the specifications and precautions described in the 
 handling instructions, user manuals, catalogs, and caution labels. 

(3) Even within the free warranty period, the following cases will be subject to paid repairs: 
1) Replacement of consumable and life-limited parts (e.g., relays, fuses, electrolytic capacitors, fans, LCDs, batteries, etc.) 
2) Failures or damages caused by improper storage, handling, negligence, or accidents by the customer 
3) Failures resulting from the customer's hardware or software design 
4) Failures due to modifications without our consent  

    (Repairs will be refused, even for a fee, if recognized as modified or repaired outside our company) 
    5) Failures that could have been avoided if the customer's equipment, in which our product is incorporated, had safety devices required by  

legal regulations or common industry standards 
6) Failures that could have been prevented if maintenance and replacement of consumable parts were performed normally according to  

the handling instructions or user manuals 
7) Failures and damages to the product caused by using connected equipment or inappropriate consumables 
8) Failures caused by external factors such as fire, abnormal voltage, force majeure, and natural disasters such as earthquakes, lightning, 

salt damage, wind, and flood damage 
9) Failures due to reasons that could not be predicted with the scientific and technical standards at the time of our shipment  
10) Other failures, damages, or defects recognized as the responsibility of your company 

 
 
 

 

Environmental Policy 
 
 
LS ELECTRIC Co., Ltd supports and observes the environmental policy as below.  
 
 
 
 
 
 
 
 
 
 
 
 

Environmental Management 
 
LS ELECTRIC considers the environmental 
preservation as the preferential management 
subject and every staff of LS ELECTRIC use 
the reasonable endeavors for the pleasurably 
environmental preservation of the earth.   

About Disposal 
 
LS ELECTRIC’ PLC unit is designed to protect 
the environment. For the disposal, separate 
aluminum, iron and synthetic resin (cover) from 
the product as they are reusable.   
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www.ls-electric.com 

 

■ Headquarter 
LS-ro 127(Hogye-dong) Dongan-gu, Anyang-si, Gyeonggi-Do, 14119, Korea  

■ Seoul Office 
LS Yongsan Tower, 92, Hangang-daero, Yongsan-gu, Seoul, 04386, Korea 
Tel: 82-2-2034-4033, 4888, 4703 Fax: 82-2-2034-4588 
E-mail: automation@ls-electric.com 

 
■ Overseas Subsidiaries 
• LS ELECTRIC Japan Co., Ltd. (Tokyo, Japan) 

Tel: 81-3-6268-8241 E-Mail: japan@ls-electric.com 
• LS ELECTRIC (Dalian) Co., Ltd. (Dalian, China) 

Tel: 86-411-8730-6495 E-Mail: china.dalian@lselectric.com.cn 
• LS ELECTRIC (Wuxi) Co., Ltd. (Wuxi, China) 

Tel: 86-510-6851-6666 E-Mail: china.wuxi@lselectric.com.cn 
• LS ELECTRIC Middle East FZE (Dubai, U.A.E.) 

Tel: 971-4-886-5360 E-Mail: middleeast@ls-electric.com 
• LS ELECTRIC Europe B.V. (Hoofddorp, Netherlands) 

Tel: 31-20-654-1424 E-Mail: europartner@ls-electric.com 
• LS ELECTRIC America Inc. (Chicago, USA) 

Tel: 1-800-891-2941 E-Mail: sales.us@lselectricamerica.com 
• LS ELECTRIC Turkey Co., Ltd. 

Tel: 90-212-806-1225 E-Mail: turkey@ls-electric.com 
 

■ Overseas Branches 
• LS ELECTRIC Tokyo Office (Japan) 

Tel: 81-3-6268-8241 E-Mail: tokyo@ls-electric.com 
• LS ELECTRIC Beijing Office (China) 

Tel: 86-10-5095-1631 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Shanghai Office (China) 

Tel: 86-21-5237-9977 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Guangzhou Office (China) 

Tel: 86-20-3818-2883 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Chengdu Office (China) 

Tel: 86-28-8670-3201 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Qingdao Office (China) 

Tel: 86-532-8501-2065 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Nanjing Office (China) 

Tel: 86-25-8467-0005 E-Mail: china.auto@lselectric.com.cn 
• LS ELECTRIC Bangkok Office (Thailand) 

Tel: 66-90-950-9683 E-Mail: thailand@ls-electric.com 
• LS ELECTRIC Jakarta Office (Indonesia) 

Tel: 62-21-2933-7614 E-Mail: indonesia@ls-electric.com 
• LS ELECTRIC Moscow Office (Russia) 

Tel: 7-499-682-6130 E-Mail: info@lselectric-ru.com 
• LS ELECTRIC America Western Office (Irvine, USA) 

Tel: 1-949-333-3140 E-Mail: america@ls-electric.com 

Disclaimer of Liability 
LS ELECTRIC has reviewed the information in this publication to ensure consistency with the hardware and software described. 
However, LS ELECTRIC cannot guarantee full consistency, nor be responsible for any damages or compensation, since variance 
cannot be precluded entirely. Please check again the version of this publication before you use the product. 
ⓒ LS ELECTRIC Co., Ltd 2015 All Right Reserved.                                                                                               2024.06 
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